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1 Introduction
Every instrument comes with a Quick Guide that provides you with the basic information you need to get
your instrument up and running as quickly as possible. The document you are reading at this moment is
a collection of manuals, covering principles of operation, servicing the instrument, troubleshooting, and a
short section on integration, in addition to an instrument specific section. The idea is that the Quick
Guide contains the basic information needed to get going, and only that. If you are interested in learning
more about the instruments, how they can be deployed, how to work inside them, what to do when
encountering a problem, you will find a lot of information in this document. Inevitably, these manuals will
overlap on certain points.

The Principles of Operation is divided into two parts. The first part covers the underlying principles for
obtaining current measurements. The Doppler Effect is described and the individuality and special
features of the instruments are highlighted. Some limitations and special considerations for
measurements are presented at the end. The second part focuses on waves and wave processing
methods. Special wave properties are described to explain how it is possible to measure and obtain wave
parameters, and what limitations that exist. The wave parameters of interest, both directional and non-
directional, are described, and the different processing methods for obtaining these parameters are
presented.

The Service Manual describes tests and calibration procedures that should be done ahead of a
deployment, tips and general recommendations for getting the highest quality data, and general practical
considerations regarding deployment planning. The purpose of the Service Manual is also to aid in re-
configuration tasks, and is meant to be a supplement to the existing Troubleshooting Guide and
Principles of Operation manual.

The Troubleshooting Guide contains our years-long experience in where to start looking when an
instrument is not behaving as intended.

There is a chapter called System Integrator - Light, covering how to use Nortek instruments alongside
other instruments. For a more comprehensive guide to integration, check out the System Integrator
Manual and the Vectrino Profiler-specific Integrator Manual. This manual provides the information needed
to control a Nortek product with a non-PC controller. It is aimed at system integrators and engineers with
interfacing experience. Code examples are provided in C. The document’s scope is limited to interfacing.

Instrument software help
The instrument software has been designed to aid you in the planning, execution and recovery of your
instrument deployment. The software also contains a test section, including all functions required to
operate the instrument. An on-line help system is integrated in the software, containing answers to all
questions you may have on how to use the software. Click Help > Help Topics.

Nortek online
At our website, www.nortekgroup.com, you will find technical support, user manuals, and the latest
software and firmware. General information, technical notes, and user experience can also be found here.

Nortek FAQ
Our old forum where users from all over the world met to discuss and shared their experience with Nortek
instruments has been converted to an FAQ section. If you have comments, questions, application tips,
suggestions for improvements, or simply want to learn from others or share your own experience, we
encourage you to comment on the relevant FAQ or start a topic in our new forum.

Your feedback is appreciated

https://support.nortekgroup.com/hc/en-us/articles/360029514052-Integrators-Guide-Classic
https://support.nortekgroup.com/hc/en-us/articles/360029514052-Integrators-Guide-Classic
https://support.nortekgroup.com/hc/en-us/articles/360029514192-System-Integrator-Vectrino-Profiler
http://www.nortekgroup.com
https://support.nortekgroup.com/hc/en-us/categories/360001412211-Frequently-Asked-Questions
https://support.nortekgroup.com/hc/en-us/community/topics
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If you find errors, omissions or sections poorly explained, please do not hesitate to contact us. We
appreciate your comments and your fellow users will as well.

Contact Information
We recommend first contacting your local sales representative before the Nortek main office. If you need
more information, support or other assistance, you are always welcome to contact us or any of our
subsidiaries by email, phone or fax.
Email: inquiry@nortekgroup.com for general inquiries or support@nortekgroup.com for technical support
Phone: +47 67 17 45 00
Fax: +47 67 13 67 70

You can also write us at:
Nortek AS
Vangkroken 2
1351 RUD
Norway

Version/revision Date Comments

Version 2018.1 23.11.2018

Version 2021.1 14.09.2021 Major corrections

Version 2022.1 24.03.2022 Minor corrections

mailto:inquiry@nortekgroup.com
mailto:support@nortekgroup.com
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2 Principles of Operation
This section covers 
ü Basic Doppler principles 
üDifferences between the Velocimeters
üCurrent measurement and auxiliary sensors
üMeasurement volumes 
üMeasurement method and measurement accuracy

Velocimetry is the measurement of the velocity of fluids. The name "Velocimeters" belong to a special
class of high-resolution 3D instruments, that comprises the following Nortek instruments:

The Vector is a field instrument designed for measurements of rapid small scale changes in 3D velocity,
used for turbulence, boundary layer measurements, surf zone measurements, and measurements in very
low flow areas. 

The Vectrino is used in hydraulic laboratories to measure turbulence and velocities in flumes and
physical models. It also comes in a "field" version that has a more rugged design.

The Vectrino Profiler is a profiling version of the Vectrino. Its strength lies in its ability to collect data
comprising of up to 30 cells that are only 1 mm in height.

NOTE: The Vectrino and Vectrino Profiler were discontinued in September 2020, and technical support
for these instruments will end in September 2022.

Velocimeters are typically used in difficult measurement situations such as turbulence measurements,
very slow, low energy flows, and rapidly varying flows in the laboratory or the ocean. They can work well
in areas with high shear, near boundaries, under breaking waves, and many other situations. Pulse
coherent data from single or small ensemble average measurements are useful because of the individual
measurement accuracy and low noise. In this chapter, the principles of current measurements with a
velocimeter are divided into relevant topics.
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2.1 Working Principle

Nortek instruments measure the velocity of water by utilizing a physical principle called the Doppler
Effect. The Doppler Effect is the change in frequency of a sound wave when a wave source moves with
respect to an observer, or when the observer itself moves relative to the wave source. You can hear the
Doppler effect whenever a train passes by – the change in pitch you hear tells you how fast the train is
moving. 

There are many ways to measure the Doppler Effect, each with its own advantages and drawbacks.
Velocimeters measure velocity by transmitting a pair of short sound pulses of a specific frequency into
the water column. Part of the sound wave reflects back to the instrument, and the detected return signal
is processed by the instrument. The reflected signal will be shifted ("Doppler Shifted") in accordance with
the water velocity, which is the basis for the signal processing.

The sound pulses do not reflect from the water itself, but rather from passive tracers suspended in the
water. These tracers or "scatterers" are typically zooplankton or suspended sediment that move with the
same average speed as the water, hence measured velocities correspond to the water flow. It is thus the
moving particles that generate the change in pitch or frequency (the Doppler shift) in the return signal that
the instrument measures.

Velocimeters utilize a pair of short acoustic pulses with a known time lag, or separation, to determine a
Doppler-induced phase shift. The use of two transmit pulses is commonly referred to as a pulse-to-pulse
coherent method. By utilizing this method the instrument is able to differentiate relatively small
differences in the velocities (corresponding to small differences in phase), therefore achieving great
accuracy (often able to achieve velocity variance orders of magnitude lower than standard incoherent
Doppler systems) and low noise measurements. A limitation is the maximum profiling range.

The figure below visualizes how a sound wave transmitted through the central transducer (shown in blue),
hits a particle (red), which in next turn reflects parts of the sound (Doppler shifted - shown in black) back
to the slanted beam (receiver arm), which will detect the reflected sound wave. Only one beam is shown
for the sake of overview.

Figure: Transmit pulse

pair (blue), a moving

particle (red), and the

reflected, Doppler

shifted pulse (black)

Water flows can be measured in many different ways, depending on how accurate the measurements
need to be and how often the measurements need to be taken to detect the variation of interest. As
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described in the section above, velocimeters use sound waves and the Doppler effect to measure velocity
fluctuations underwater, and can do so several times per second. But exactly how does this
transmission and receive of sound waves turn into velocity estimates?

Processing Technique
The phase difference between two transmit pulses is the basis for estimating current velocities using the
pulse coherent processing technique. 

Figure: Two pulses are transmitted by the central transducer, w ith a time lag. The difference in phase

between the two transmit pulses is used to calculate velocity. The reflecting particle can be seen in

green, w ith a vector indicating its speed and direction

The phase difference between the two reflected pulses is a direct measure of the velocity, and can be
expressed as

Here, V is the current velocity, ∆φ is the phase difference, F
source

 is the transmitted frequency and ∆t is

the time difference between two consecutive pulses ("Lag"). V is scaled with the speed of sound in the
liquid (C).

There are some aspects with the pulse coherent method that affects what the instrument is able to
measure. 
· The Doppler phase shift is computed using the covariance method. By computing the complex

covariance of the two return signals, the Doppler phase shift can be calculated by taking the four
quadrant arctangent (atan2 in most programming languages) of the real and imaginary parts of the
covariance function. This restricts solving the phase difference within the range of [-π , π ]. The
calculation of φ is beyond the scope of this manual, but the impact of using this method is important.
It introduces the problem of ambiguous determination of the phase shift; if the phase difference goes
outside the range of ±π , the measurement uniqueness is lost, something known as Velocity
Ambiguity. For example, a sine wave with phase -π  looks the same as a sine wave with phase π .
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Read more about this here; Velocity Ambiguity and Phase Wrap, but the take home is that there is a
maximum velocity the instrument is able to measure.

· The size of the lag (∆t in the equation above) determines the maximum unambiguous velocity that can
be measured. Longer lags have lower maximum velocities, while shorter lags have higher maximum
velocities. Conversely, longer lags will typically have higher velocity accuracy (lower noise levels) than
shorter lags, but potentially degraded signal correlation due to particle advection and turbulence. It is
therefore important to set the time lag properly. Information on what you need to think about when
setting this parameter can be found in the Using a Velocimeter chapter.

· Near boundary measurements are prone to interference. This may happen if the first pulse is reflected
from a boundary and reach the sampling volume on its way back at the same time as the second
pulse is in the sampling volume. This is referred to as a Weak Spot.

2.2 Doppler Beams

All Acoustic Doppler Velocimeters send out short acoustic pulse pairs from the transmitter (center)
element. When the pulses travel through the focus point for the receiver beams, the echo is recorded in
each of the acoustic receiver elements and the phase shift between two consecutive returns is found.
The phase shift is then processed to find the actual velocity of the water, as described in the previous
section. The instrument samples on all three of four receivers simultaneously. 

The Doppler shifts measured at the three or four receivers provide estimates of flow velocity along the
different beam directions, which are then combined geometrically to obtain the three orthogonal
components of the water velocity vector V (illustrated by the blue arrow in figure below). The
Velocimeters are in this way able to calculate 3D water velocity in the sampling volume by knowing the
exact orientation of the beams. 

Figure: The blue arrow indicates a positive velocity.

The Vector, which is shown in the figure above has three receiver arms, while the Vectrino and the
Vectrino Profiler have four receiver arms. Because of the arrangement of the receiver arms in a 4-beam
system, each pair (composed of two opposing receivers) can measure the horizontal velocity component
and the vertical velocity component. Z1 and Z2 are the vertical velocity estimates associated with
receivers 1 & 3 (X) and 2 & 4 (Y). For the standard downward looking probe, Z1 and Z2 are thus
independent measurements of the vertical velocity. Note that the side-looking probe does not have a
secondary measurement of the vertical velocity. Z1 will be the correct vertical velocity and Z2 should be
output as zero.

Every velocimeter goes through a probe calibration procedure during its production. This to document the
exact geometry of the probe, and this information is saved in what we call a head matrix. As long as the
sensor heads are not physically deformed, the head matrices will remain the same. This also means that
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the calibration only needs to be done once, and there is no need to re-calibrate the probe again, unless it
has physically been deformed. 

A bistatic system
Bistatic geometries have been used with intersecting narrow beams to produce a measurement volume
in the intersection zone. A bistatic system is one where the transmitter and receivers are physically
separated; the transmitter generates sound along the vertical beam, and the receivers listens for it. This
results in motion along two axes: the component of motion of the object in the direction of the transmitter
and the component of motion in the direction of the receiver. The motion can be considered as
proportional to the rate of change along the bisector of the transmit and receive beams (indicated by the
blue arrow in the figure below). Knowing the relative orientation of the bistatic axes and the receivers
makes it easy to calculate 3D velocities. The receive beams are slanted at ~30°, thus the angular
bisector is 15° away from the transmit beam.

Figure: The transmit/receive beam pair is sensitive to

velocity in the direction of the angular bisector between

the beams.

The Z (vertical) and X and Y (horizontal) velocity limits are tied fundamentally to the geometry and are not
independent. The "Vertical" and "Horizontal" velocity range is reported in the Deployment planning dialog.
These velocity ranges are tied to the time lag between pulses. The time lags used for the selected
nominal velocity range can be found in the header file after data collection. The reason that the Vertical
range is so much lower than the Horizontal velocity range is because of the angle used by the passive
receivers (~30°). This makes the projection of the passive beams onto the horizontal plane about ~1/4
(sin(15)) (so the maximum horizontal velocity measurable is ~4x the maximum beam velocity) while the
projection of the passive beams onto the vertical plane is 0.96 (cos(15)) (so the maximum vertical
velocity is pretty much the same as the maximum beam velocity). Consequently, the Z-velocity
component yields a lower measurement uncertainty.

In other words, for best measurement, you should always have the largest component of speed in the
horizontal plane from the point of view of the transducers. On another note, even if you do reorient the
probe, when operating at that current, you will likely still have to watch out for wraps in the velocities if
there are any local eddies occur which result in the beam ambiguity velocity being exceeded.

2.3 Measuring Currents

The processing technique described above is used because the measurement of a phase shift is more
accurate than direct Doppler frequency determinations and provides pulse coherent systems with their
characteristic low noise measurements. The instrument reports the phase shift converted to an along-
beam velocity by utilizing the speed of sound in water. The velocity data is output in m/s. 
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The user can specify which coordinate system to present the velocity data in. The raw velocity
measurement is a vector in the direction along each of the three or four beams, which is referred to as
beam coordinates. Beam coordinates can be converted to a Cartesian coordinate system (XYZ) by
knowing the beam orientation (i.e. the geometry of the sensor head). Furthermore, the flow can be
presented in Earth normal coordinates (ENU: East, North and Up). In order to get the information
referenced to Earth coordinates it is therefore necessary to detect the instrument’s orientation in space.
Attitude sensors, such as magnetometer and tilt are therefore used to aid in the transformation needed
to correct for the instrument’s attitude and motion. The definitions of the coordinate systems are
presented here: Coordinate System

The decision on which coordinate system to use should be based on what the aim with the data
collection is. When handling data, XYZ or ENU coordinates are the most practical for a user. Beam
coordinates are used when dealing with ambiguity (phase wrapping) and higher order turbulence
calculations, as these are the "rawest" format.
 
Along with determining a phase shift (and then the velocity vector), the instrument will also typically
compute the speed of sound, measure the return signal strength, and measure the attitude sensors such
as pitch, roll, and compass heading (if equipped). For more about this; check the auxiliary sensors
section. 

To assure high quality velocity data from a Velocimeter, it is important to configure it properly. The
specifics for each instrument version is described in Using a Velocimeter.

2.4 Auxiliary Sensors

Along with determining a phase shift, the instrument will also typically compute the speed of sound
(needed to convert the phase shift to an actual velocity) and measure the return signal strength (reported
in arbitrary units as counts and output as the variable Amplitude). Vectors also measure the attitude
sensors such as pitch, roll, and compass heading (if equipped) to aid in the last step in processing,
coordinate system transformation.

Pressure (Vector)
The pressure sensor measures the hydrostatic pressure and reports in units of dBar. Vectors sample
pressure at the same rate as velocity.

The instrument do not set the pressure offset automatically, so this must be done using the software
right before deployment to corrects for local atmospheric pressure. For more about this, check out the
Service Manual. Note that a Nortek pressure sensor cannot measure negative values.

Temperature
The instruments use the speed of sound to convert time to distance and Doppler shift to velocity, and
since speed of sound depends on temperature, the data from the temperature sensor is of vital
importance. The temperature is measured by a thermistor embedded in the probe and reported in
degrees Celsius. The instruments sample temperature every second. The time response is about 10
minutes for the Vector, 5 minutes for the Vectrino and the Vectrino Profiler.

Magnetometer and Tilt (Vector)
The Vector compass is a system including a 3-axis magnetoresistive magnetometer, a liquid tilt sensor
or IMU, algorithms to convert data from these sensors into heading and instrument tilt, and a calibration
algorithm. The magnetometer measures the magnitude of three components of earth's magnetic field,
and the tilt sensor measures two components of tilt and detects up/down orientation. The Vector (with
compass) combines this information to compute the instrument's tilt and heading, then uses the tilt and
heading to correct measured velocities to ENU coordinates.
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Tilt sensor:
The tilt sensor measures the orientation of the instrument and comes in two versions; vertical orientation
and horizontal orientation. The tilt sensor is calibrated within +/- 30º, but the accuracy is significantly
better for smaller tilt angles because of the technology used to measure tilts. 

If an instrument with vertical orientated tilt sensor is to be mounted horizontally, the tilt sensor data will
be unusable and the data would need to be collected in XYZ or Beam coordinates. It is possible to
change the orientation of the sensor, but the instrument would need to be returned to Nortek. In addition
to the physical replacement of the sensor, the instrument would need to go through calibration.

The tilt sensors measure tilt relative to earth gravity. If the instrument is moving (e.g. when mounted on a
buoy), the tilt sensor cannot differentiate the acceleration from the buoy from the acceleration of gravity.
We therefore offer the Vector with an integrated IMU (inertial measurement unit) which operates over a
larger tilt range and can be used to correct measurements for motion contamination. 

This sensor is intended to help understand how the Vector's own motion influences the measurements.
The simple configuration allows one to basically record motion data simultaneously with the Vector
velocity data. Physically, the IMU is incorporated in the Vector by simply using the magnetometer
contact interface. This means the standard tilt and magnetometer are removed and replaced with the
IMU, so there is no standard Nortek compass system with the IMU integrated. More about this sensor
can be found here: Optional IMU.

Magnetometer:
Magnetoresistive (MR) magnetometers sense magnetic fields with thin strips of a metal alloy whose
electrical resistance varies with a change in applied magnetic field. These sensors have a well-defined
axis of sensitivity. The Vector's compass includes three MR sensors, one each for X, Y and Z
components.

Each compass system is calibrated at the factory to quantify the characteristic response of the individual
components and of the system as a whole. When it leaves the factory, each system can measure its tilt
and the direction of its magnetic field vector accurately, anywhere in the world.

Note: Users disturb the magnetic field near the instrument when they deploy. Adding a battery pack and
mounting the instrument with deployment hardware adds magnetic materials that change the magnetic
field measured by the instrument. The compass calibration procedure quantifies this magnetic
disturbance, and the instrument's compass algorithm then corrects for it to obtain accurate heading. 

2.5 Measurement Volume

The Velocimeters use separate transmit and receive beams and are therefore referred to as bistatic
sensors. The measurement volume is defined by the intersection zone of the three or four slanted
receivers and the central transmitter. 

2.5.1 Vector

The Vector measurement volume is defined as the area where the beams intersect each other, that is,
157 mm from the transmitter. The transmit transducer sends a short pulse with a transmit length
between 2 and 8 mm (user selectable). The sampling volume size corresponds to the time during which
the receivers listen to the echo, and can be set between 5.5 and 18 mm (user selectable). Since the
Vector use three receivers, all focused on the same volume, it obtains three simultaneous velocity
measurements from that very volume. 
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Figure: The Vector beams intersect each other

at a known distance from the center

transducer, defining the measurement volume.

2.5.2 Vectrino

The Vectrino measurement volume is defined as the area where the beams intersect each other. For the
Vectrino that is 5 cm from the transmitter, for the Vectrino field probe, it is 10 cm. The transmit
transducer sends a short pulse that covers 3-15 mm vertically (user adjustable), and the receivers listen
to an echo that corresponds to this volume (see figure below). The diameter of the volume is 6 mm. 

The Vectrino side-looking probe (figure below, middle) has two horizontal beams and two slanted 65°
from the vertical. The two horizontal beams measure the U and V velocity. This means that the data from
the two slanted beams are not required when measuring horizontal velocity, and the side-looking probe
then act as a 2D system. This means that this probe can be used in really shallow water applications,
as only the two horizontal beams need to be submerged to get 2D velocities. Side-looking probes do not
often have the problem of weak spots since they are usually further away from a boundary, so they are a
little more robust to operate, especially in high flow environments. Due to the design, the side-looking
probe has higher instrument noise in the vertical than in the horizontal. 

The Vectrino beams intersect each other at a known distance form the center transducer, defining the

measurement volume. The Vectrino to the left is the down-looking version, the one in the middle is a so-

called side-looking probe, and the field probe is presented to the right.

2.5.3 Vectrino Profiler

The mechanical and acoustic characteristics of the Vectrino and the Vectrino Profiler are identical; both
employ the same probe assembly and transducers. However, the Vectrino Profiler provides for profiling
over a 30 mm range interval thereby allowing measurement of the spatial structure of the flow (see figure
below).
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The figure above shows how the beams intersect each other 50 mm from the transmitter. The
measurement profile is defined by this intersection and by range gating in time.  Four passive
transducers, angled at ~30° towards the center surround the central active transducer, allowing 3D
velocity measurements. With a profiling range up to 30 mm, a usable profiling region approximately 40-70
mm in height from the central transducer is provided. The Vectrino Profiler pulse intervals are longer than
the Vectrino because of the need to sample data from further away.

2.6 Coordinate System

You may specify the preferred coordinate system in the Deployment Planning menu of the instrument -
specific software. The velocity measurement is a vector in the direction of the transducer beam, which we
refer to as Beam coordinates. Beam coordinates can be converted to a Cartesian coordinate system
(XYZ) by knowing the beam orientation.  Furthermore, the flow can be presented in Earth normal
coordinates (ENU: East, North and Up) if the instrument is equipped with a compass and tilt sensor. 

The coordinate systems are defined as follows:
· In Beam coordinates, a positive velocity is directed in the same direction as the beam points. Beam 1

is defined as the arm with the black / red marking. If the marking is missing, beam 1 can be identified
as the arm opposite of the engraved serial number on the probe. Beam velocities are not corrected for
probe geometry.

· In XYZ coordinates, a positive velocity in the X-direction goes in the direction of the X-axis arrow. The X-
axis points in the same direction as beam 1, and newer models have the direction engraved in the
probe endbell itself. Use the right-hand-rule to remember the notation conventions for vectors. Use the
first (index) finger to point in the direction of positive X-axis and the second (middle) finger to point in
the direction of positive Y. The positive Z-axis will then be in the direction that the thumb points.
Remember that XYZ coordinates are relative to the probe head and independent of whether the
instrument points up or down. For instruments with 4 receiving transducers, an extra Z velocity is
outputted (X, Y, Z1 and Z2).

· In ENU coordinates, a positive east velocity goes toward east. This is also a right-handed orthogonal
system.

ENU and XYZ coordinates are the most practical when handling data. Beam coordinates are primarily
useful for higher-level turbulence calculations and for dealing with phase wrapping issues.
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Figure: Coordinate systems. From left: Beam coordinates, XYZ coordinates and ENU coordinates

The figure below shows an assortment of Velocimeters probes and the definitions of beam and XYZ
coordinates.

Figure: The Vectrino/Vectrino Profiler and Vector XYZ coordinate systems and beam numbering as defined

relative to the probes. Beam 1 of the Vectrino has a red marking, a black marking defines beam 1 for the

Vector (not shown here). For the Vector, beam 1 is also the arm opposite of the engraved head ID. Beam 1

point in the direction of positive X-axis. The Y direction can be found in accordance with the right-hand rule.

For the interested reader: For the Vector probe (see illustration third to the left, lower part), one may
notice that the X component is predominantly measured by beam 1 with nearly equal contributions from
beam 2 and beam 3. This makes sense since the XYZ coordinate system is aligned with X pointing along
one receiver arm. Beams 2 and 3 are at some angle α to the X-axis and measure a  component of X
proportional to cosα. For the Y-component, beam 1 contributes to zero (or very near zero) because the
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Y-component is perpendicular to beam 1. Finally, the Z component is an equal combination of all three
beams since the Z-axis is aligned with the central transducer and each beam is at the same angle to the
Z-axis. Note that this concept applies to the other probes as well.

To calculate speed and direction from velocities in an orthogonal coordinate system, you can use the
following equations:

Current speed (Pythagoras): 

· Excel and Matlab: sqrt(X̂ 2+Y 2̂)

Current direction: The calculation is based on the familiar θ=arctan (X/Y). In order to know the correct
quadrant that the computed angle belong in, one has to use the four-quadrant inverse tangent, arctan2.
The 180/π  converts from radians to degrees. The modulo (mod) is taken in order to avoid negative
degrees.

• Excel: MOD(ARCTAN2(X,Y)*180/PI,360)
• Matlab: mod(atan2(Y,X)*180/pi,360)

Note that the current direction is defined as towards. 

2.7 Signal Strength

To be confident about the quality of the data and allow proper calculation of the velocities, the received
echo (reflected by particles) need to be over a certain level. Signal strength (amplitude) is a measure of
the magnitude of the acoustic reflection from the water, and is a function of type and amount of particles
in the water. If the echo is weak, the calculation will be statistically "noisy" and the velocity data will
show significant short-term variability. Signal strength is outputted by the instrument and can be used to
assess data quality.

The signal strength is accessed as raw signal amplitude (using dimensionless unit called Counts) or as
a "Signal-to-Noise ratio", SNR (in dB).

Counts
For signal strength, Nortek frequently make use of the word counts, which obviously seem to be
connected to the decibel term, but how and why?

Inside the velocimeters there are circuitries for the amplification of input signals. The number of counts is
an indicator of how much gain we must apply to a signal – the less gain needed, the higher the input
signal level is. The number of counts is inversely proportional to the logarithm of the gain setting, which
means that a higher number of counts reflects a need for less amplification than a lower number of
counts will do.

Strong signals have a higher noise immunity and they correlate much better than weak signals do. For
the Vector, 1 count ~0.4–0.45 dB.

SNR
The Signal-to-Noise ratio (SNR) is defined as  
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SNR is displayed for each receiving beam. It is a measure of the level of the signal with reference to the
background noise level. Strictly speaking, we are unable to measure the signal without the noise
present, so Amplitude

signal
 should read Amplitude

signal+noise
. However, for SNR values in the magnitude

applicable to typical Velocimeter situations, the difference is negligible.

The particles that are necessary to generate reflections of the acoustic signal can be naturally occurring
suspended sediments (rivers, ocean, sand-filled or polluted model basins), bubbles entrained from pump
systems (often the case in flumes), or artificial "seeding" (e.g. very small hollow neutrally-buoyant glass
spheres).

When measuring in basins or flumes, seeding is often needed. If practical, we recommend that stagnant,
clear basins or flumes are seeded with hollow spheres that have a density close to that of water and a
size around 10 µ m. Particles that are close to neutrally buoyant will remain in suspension without
additional stirring and are ideal for low-flow experiments. The choice of size is motivated by the relatively
strong echo that these particles generate per unit of concentration. Smaller particles (e.g. 1 µ m particles
used to seed Laser Doppler systems) are not recommended because the required concentration is quite
high.

When collecting raw data (e.g. at 25 Hz), we recommend an SNR that is consistently above 15 dB.
When collecting mean data (for example, 10 second averages), we recommend an SNR of at least 5 dB.
If the SNR remains low even after seeding, try to clean the receive and transmit transducers by gently
rubbing the surface with a finger. This will clean off residues or bubbles that may have collected and are
blocking the sound. Take a look at the Troubleshooting Guide for more about how to increase SNR.

The determination of the quality of the data is the primary use of the signal strength. For the Vectrino
Profiler it also determines the range over which the instrument can measure velocity accurately. It may
also be used to retrieve information about the suspended sediment or the concentration of the scattering
materials. Note that different types of scattering elements produce different echoes, and it is difficult to
distinguish between conditions with few, relatively big scattering elements or many small elements. For
users interested in sediment concentration estimates it is recommended to take a look at this subject in
the Frequently Asked Questions (FAQ) section on the Nortek website. 

Figure: Signal to Noise Ratio from one Vectrino Profiler beam. A fixed boundary can be seen at about 6cm from

the transmitter

2.8 Correlation

Correlation is a measure of the similarity of the two pulse echoes being measured. Zero correlation
means nothing at all is similar between the two echoes, and a correlation of 1 means the two echoes are
identical. The number reported by Nortek instruments is a normalized correlation value and will always
lay in the interval 0-100%. The aim is high correlation because it gives confidence the system measured
the two pulses it originally sent out and is determining a valid phase shift. In practice we will never see
correlations of zero because of noise due to electronics, temperature fluctuations, and other factors that
will always correlate above zero.

https://support.nortekgroup.com/hc/en-us/categories/360001412211-Frequently-Asked-Questions
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Discarding measurements with correlations lower than a certain threshold significantly reduce the
variance of the data set, which is generally the goal of most data screening operations. Removing low
correlation measurements is still a good idea because correlation is a strong indicator of data quality in
the sense of a valid Doppler phase shift determination. However, high correlation is not always indicative
of a valid measurement of the flow. It is also important to note correlation is tied to a specific beam
velocity measurement, not to an orthogonal coordinate direction such as X, and any screening should
take this into account.

In the early days of the acoustic Doppler velocimeter, if a user did some tests and determined
correlations were above ~70% then the instrument was considered to be generating good quality data.
Many users still use this number for screening out bad data, although a generalization to some universal
value is unwarranted and a close examination of the dataset is the best way to set a correlation
threshold (if any) for discarding bad data points.

Figure: Correlation from one Vectrino Profiler beam. This plot corresponds to the SNR figure in the previous

section. Note how the boundary shows up in this plot

2.9 Distance Measurement / Bottom Check

The distance check (also referred to as Bottom Check) is used to measure the distance to the bed from
the central transducer. The return from this pulse is listened to over some time to obtain an amplitude
profile. The amplitude profile is checked for peaks, and an interpolation scheme is used to locate the
peak location based on the largest amplitudes recorded. 

The Distance Check function is available in the Vectrino Plus firmware, the Vector and the Vectrino
Profiler, but not in the Vectrino standard firmware. 

Vector: The Vector reports the distance to the boundary at the start and end of each burst, or at the
start when running the instrument in Continuous mode. That means that it is possible to do very short
bursts and get almost simultaneous measurements (requires Firmware V1.20 or higher).

Vectrino Plus: The Vectrino+ firmware comes with a separate boundary distance mode (10 Hz), where
the distance to the boundary is measured. The distance measurement is not done at the same time as
the velocity measurements. The Boundary Distance functionality is typically used in experiments where
bottom changes as a function of time are needed, or when the Vectrino+ is mounted on traverse
systems for bottom topography measurements. 

Vectrino Profiler: The Vectrino Profiler has an interleaved boundary distance functionality. In other
words, you get both velocity profiles and distance to the bottom at the same time. The reasons for this
are both that it can be done technically, and also that the problem of weak spots is much more
challenging with the Vectrino Profiler than with a single point instrument. Hence, in order to operate the
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Vectrino Profiler properly we depended on interleaving velocity and distance measurements, such that
the time lag between the two pulses in every pulse pair can be adjusted adaptively.

Measurement range:
The maximum and minimum distances that can be measured are approximately as listed below, but
note that it will depend a lot on the hardness of the bottom.

· Vector: 4 cm - 45 cm
· Vectrino+: 1 cm - 35 cm
· Vectrino Profiler: 20 mm - 2 m. The Vectrino Profiler can be configured where to start collecting bottom

check data. Refer to SW user guide (available within the software) for more details.

We provide all of the data used to determine the peak location if users need to create their own bottom
detection algorithm. This is available as the probe check data in the Vector and Vectrino, and in the
Bottom Check fields in the Vectrino Profiler data structure. 

Quality (relevant for Vectrino Plus)

Quality is a number indicating how valid the distance measurement is. Above 100 should be a good
distance measurement. It is always good to have an independent estimate of position though, so we
usually recommend using the probe check feature of the Vectrino software to get a ballpark number.

More information about the Distance Check can be found in the Using a Velocimeter chapter.

2.10 Velocimeter Accuracy

The word accuracy is often used loosely to cover some combinations of bias and short-term uncertainty.
Bias and short-term uncertainty are different, and they have different ramifications for the results of your
data collection. Here is the difference:

· Bias is error that remains after taking long-term averages.
· Short-term error/uncertainty is the random error of individual measurements, which can be removed by

averaging.

These errors have different sources and different consequences for the results. The following will address
each of these errors separately.

The velocity measurements are the average of many velocity estimates (called pings). The uncertainty of
each ping is dominated by the short-term error. This error is uncorrelated from ping to ping, so by
averaging together many pings, the measurement uncertainty is reduced. The short-term error depends
partly on internal factors, such as the size of the transmit pulse, the measurement volume and the beam
geometry. Beams parallel to the dominant flow will have smaller short-term errors than beams at a steep
angle relative to the flow. 

The instrument’s software predicts errors based on the short-term error of a single ping and the number
of pings averaged together. Averaging multiple pings reduces errors according to the formula:

Where σ represents the standard deviation and N is the number of pings you average together. Note that
the software predicts only the instrumental error. 

In many situations, external factors such as the environment itself dominate the short-term error. This is
true near an energetic surface and in turbulent flow such as boundary layers and rivers. In situations like
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this, your data collection strategy should take into account the nature and the time scales of the
environmental fluctuations. Here are two scenarios:

ÜExample: Waves. When measuring mean velocities in the presence of waves you should sample
velocity at roughly ¼ the interval of the dominant wave period, and you should sample through 6-10
wave cycles. 

ÜExample: Turbulent flows. In boundary layers, a rough rule of thumb is that the root-mean-square
(RMS) turbulent velocity is 10% of the mean velocity. If, for example, your mean velocity is 1 m/s, you
could estimate turbulent fluctuations to be 10 cm/s. Obtaining 1 cm/s RMS uncertainty would require
at least 100 pings.

When averaging several pings to reduce the error, there is a difference between the resulting “mean
current” and the measured current. This deviation from the actual current measurement is called bias.
Velocimeter bias depend on the geometry of its probes and the stability of its internal oscillators. Over
most of the velocity range, bias can be measured in terms of an offset and a scale-factor error. Offsets
would appear as a non-zero velocity in still water. If probe geometry were entirely fixed and repeatable,
then we could determine the velocity scale factor based entirely on dimensions, frequencies and our
physical model. In practice, small variations in probes require that probes are calibrated individually in the
factory.

A factory-calibrated velocimeter should have a scale-factor bias that is less than 1% of the measured
velocity. A velocimeter will retain this accuracy as long as its probe remains unbent.

Bias increases near the extremes of a velocimeter's velocity range because velocities that would be
measured beyond the extremes wrap around to the opposite end of the range. This can be avoided by
keeping the maximum observed speed toward the middle of the velocimeter's maximum range. The
configuration parameter to adjust is the Velocity Range.

Uncertainty, variance and standard deviation

Uncertainty is often measured in terms of measurement variance or standard deviation. These two are
related:

variance = (standard deviation) 2̂ 

Standard deviation quantifies the amount of variation of a set of velocity values, around the true value of
the velocity. For example: Imagine taking measurements of an unvarying velocity. The best estimate of
the true velocity is the mean of the measurements, and the uncertainty of each of the measurements is
the standard deviation of the collection of measurements. 

Averaging

When averaging a collection of velocity measurements, the average is a better estimate of the true
velocity than each individual estimate. The uncertainty of the average is reduced according to:

variance(mean) = variance(individual measurements)/N            
std dev(mean) = std dev(individual measurements)/N 1̂/2

In other words, by reducing the variance of individual measurements by a factor of 2, you can collect data
twice as fast.

Measurement Load (Vector)
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A 100% measurement load means that the instrument pings as fast as it is able to. Consequently, a
measurement load of 50% means that the instrument pings at half that rate. From signal theory we know
that the more pings there are within an averaging period, the better the estimate of the true value we are
measuring will get. By increasing the measurement load, the precision in the velocity measurements
increase, but alas at the expense of battery consumption. By decreasing the measurement load it is the
other way around. 

The measurement load for the Vector is adjusted according to the velocity range selected.

Variance and Noise Level

A velocimeter's noise level, also called the noise floor, is its most fundamental measure of measurement
uncertainty. If the noise level is known, one can easily compute the expected variance or standard
deviation of the measurements for any sample rate. Velocimeter uncertainty is a random white noise.
This means that each velocity estimate is independent of the next, and it means that the noise has no
preferred frequency.

The noise level varies widely according to the characteristics of the velocimeter, how it is set up, the
characteristics of the flow, and the acoustic scattering environment. Here is how the noise level and
measurement variance are related:

variance = (noise level)*(sample rate)/2

By using the equation in the "Averaging" section, the equation above can be turned into an equation for
standard deviation. 
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3 Using a Velocimeter
This section covers

üWhat you need to know when using a Vector
üWhat you need to know when using a Vectrino and/or a Vectrino Plus
üWhat you need to know when using a Vectrino Profiler
üMeasurement scenarios, and what you need to think about when configuring the instrument for these

scenarios
üGeneral operational considerations, common configuration problems and common data analysis

scenarios

The Velocimeters bear lots of similarities, and this section is trying to separate the instruments from
each other at the same time as covering subjects that are relevant for them all. 
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3.1 Vector

3.1.1 Technical description

For technical specifications, check out the product on our website.

Probe with Transducers
The probe is mounted either on a cable or a fixed stem connected to the main housing through the probe
endbell. The probe consists of three receiver transducers, each mounted inside a receiver arm, and a
transmit transducer at the center. When an instrument uses separate transmit- and receive transducers,
it is called a bistatic sensor.

The center transducer transmit the sound waves, and the three receivers listen and measure the Doppler
shifted return signal.

Pressure Sensor
The Pressure sensor is located inside the probe endbell. The pressure sensor provides instrument depth
data, and can also be used for wave measurements.

The pressure sensor is not calibrated to, or corrected by the atmospheric pressure. This means that the
pressure sensor reading will follow the atmospheric pressure. Therefore, a pressure offset should be run
before using the instrument, and this can be done using the Vector software; click Menu: 'On-line' - 'Set
Pressure Offset...'. 

The pressure sensor offset should be run right before the instrument is deployed. The pressure offset
corrects for local atmospheric pressure, so by definition we want the pressure sensor to read zero in the
air. If there were not large changes in atmospheric pressure relative to the current pressure offset, or the
pressure sensor sensitivity was less than any atmospheric pressure changes, then the pressure sensor
will read zero in the air.
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The pressure data is collected at the same rate as velocity, which is set by the user in the Deployment
Planning under Sampling Rate. That means that it can sample at up to 64 Hz.

Because conversion from pressure to depth becomes quite complex as you move down below 500 m, we
have included the full UNESCO calculations of depth as a function of pressure depth, salinity,
temperature.

Temperature Sensor
The temperature sensor is located inside the probe endbell. The temperature sensor provides data on the
water temperature, and is used for computing the Speed of Sound. Speed of sound can be set by the
user (Fixed) or calculated by the instrument based on the measured temperature and a user-input value
for salinity (Measured). The salinity is 0 for fresh water and typically 35 for the ocean.

The temperature sensor samples at 1 Hz.

Tilt Sensor
The tilt sensor is mounted on a small round PCB board attached to the probe. It is normally aligned
parallel to the axis of pressure case axis for vertical operation. It can, however, optionally be installed
perpendicular to the pressure case axis for operation with the pressure case horizontal. 

The tilt sensor works equally well with the instrument pointed up or down. Note that when using the
Vector in Continuous mode, only the very first measurement includes orientation information. If the
Vector is oriented the opposite way during continuous data collection, the tilt sensor will not detect the
change.

Tilt data is sampled at 1 Hz. The measurement range is +/- 30 degrees. 

Is there uncertainty about whether the Vector has a vertical or horizontal tilt sensor? If the tilt (pitch
and/or roll) as indicated in the Sensors’ pane is unrealistically far from 0° when placing the canister
(upright or lying down) on a table, the Vector is of the other type.

Compass
The compass is located inside the pressure case, and measures the earth’s magnetic field. Combined
with the tilt sensor on the head, the compass enables the Vector to obtain the heading. Without a
compass, the Vector can still measure tilt. The compass enables the Vector to convert velocity
measurements to Earth (ENU) coordinates.

Compass data is sampled at 1 Hz.

IMU sensor (Optional)
Nortek offers the Vector with an integrated Inertial Motion Unit (IMU). The IMU sensor is an electronic
device that replaces the Compass board on the standard Vector. This sensor measure acceleration,
angular rate and magnetic field along three axes. It is a valuable data source for applications where the
instrument moves. Using an IMU with the Vector allows one to basically record motion data
simultaneously with Vector velocity data. IMU data is sampled at the same rate as velocity. Note that
there is no advanced internal processing.

Electronics Module
The electronics module is located inside the pressure case, and is a single board that holds the power
transmitter, analogue and digital signal processing, power conditioning and the standard data recorder.

Power & Communication Cable
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The power and communication cable is mounted to the endbell connector. The cable supplies external
DC power and connects an external computer to the Vector for 2-way serial communication.

Cable Wiring is presented here: Cable Wiring. The Vector comes standard with an 8-pin connector and
cable. 

External power
You may supply power with the external supply that is delivered with the systems, or you can use your
own external supply. If using your own supply, make sure the voltage does not exceed the voltage
specification for the instrument.

The power and battery lines are diode protected, so you do not have to worry about wiring the instrument
power backwards - this will not damage your instrument.

Vector power range: DC input 9-15 VDC

If you want to use an internal battery as a backup battery: The instrument will pick the power source with
the highest Voltage. If using an external supply of 15 VDC and an internal battery of 13.5 V, the external
supply provides a higher voltage than the battery pack, which prevents the internal pack from
discharging. Then, if external power fails, the internal battery pack takes over and sustains operation.

Internal batteries (optional)
The internal battery pack is located inside the pressure case, and enables autonomous (stand-alone)
deployments. It also provides backup power in the event of failure of the external supply. Note that the
battery pack inside the pressure case is disconnected when sent from Nortek.

Nortek alkaline battery packs use 18 AA cell batteries at a nominal starting voltage of 13.5 VDC. The
voltage of alkaline batteries falls quickly at the beginning, slowly during most of its life, then again quickly
at the end. Thus, a 13.5 VDC battery pack will spend most of its life somewhere in a voltage range of
10.5-12.5 VDC.

Refer to the Changing a battery pack section for instructions on how to connect or change a battery
pack. 

The Vector power and/or battery lines are diode protected wiring the Vector power backwards will not
damage your instrument. 

Internal Hardware (Electronics Module)
The signal processing hardware generates the signal that is converted to acoustic energy at the
transducers, it digitizes the return signal and runs the Doppler processing that results in velocity
estimates before it is outputted to the recorder or to a PC.

Recorder
The instrument comes standard with a 9MB recorder. There are options for 4 and 16GB recorders.

Additional Features
Analog inputs and Synchronizing Vectors

3.1.2 Instrument software

The software is designed to aid in the planning, execution, recovery and exporting data of stand-alone
Vector deployments. It also contains an on-line section, including all functions required to operate the
Vector in real-time applications. The Vector program can be found on the flash disk that came with the
instrument, or on the Nortek web site: www.nortekgroup.com/software. Nortek Windows programs run on
all versions since XP (SP3), including Windows 8.

http://www.nortekgroup.com/software
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Software Help: An on-line help system is integrated in the software; containing answers to all questions
you may have on how to use the software. Click Help > Help Topics.

It is emphasized that the Vector program is not primarily designed for rapid data collection at high
sampling rates.

Installing the Vector PC Software
1. Insert the Flash disk, or find the Vector.exe file on the web site.
2. Follow the on-screen instructions, accept the default settings. The Setup program will by default

install the application in the c:\Nortek\Vector folder and create an application shortcut in the Nortek
programs folder and on the desktop.

3. Restart your PC if prompted to, to finalize the installation process.

Communication with the instrument
Connect the instrument to one of the computer serial ports, using the Serial-to-USB adaptor. Select
Serial Port from the Communication menu to specify the port number to use. It is recommended to
accept the default baud rate settings - which is also the default instrument baud rate. 

To check the instrument communication and verify that the instrument is connected, select Connect from
the Communication menu or click the corresponding toolbar button. A message box with an identification
or status string will pop up. Alternatively activate the Terminal Emulator window and press the send
break button to send a BREAK signal over the serial port. A break causes the instrument to report an
identification or status string. If it is not responding, or it responds with something unexpected, check the
Troubleshooting chapter.

Changing the Baud Rate
There are two baud rates that can be specified in the software; communication baud rate and
Recorder/firmware upgrade baud rate. A higher baud rate speeds up large file transfers and is appropriate
when you have a short serial cable and a relatively noise-free environment.

The standard baud rate is 9600. However, for 64 Hz data collection, you will need to use 19 200 baud.

To change the baud rate and make it permanent, do the following:
1 Connect the Vector to your computer.
2 Set the baud rate in Communication > Serial Port to the baud rate you prefer.
3. Press Stop Data Collection. The software will change the baud rate and make it permanent.

If you remove power and reapply it, the Vector will re-awake with the new baud rate.

Note! If data download is interrupted, the Vector may be left with a baud rate setting other than the one
used for normal communication. When the software tries to establish communication in such cases, it
may spend a few moments searching for the correct baud rate to use.

3.1.3 Initial preparation

We recommend the following procedure to prepare the Vector for successful operation:

1. Verify that you have received all parts by using the Content of Shipment document that came with the
instrument as a reference.

2. Install the internal battery pack.
3. Install the Vector Software on a PC.
4. Before a deployment it is recommended to run a functional test as described in the Service Manual to

verify that the instrument is functioning as intended and thus avoiding using a malfunctioning
instrument during deployments.
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5. When you are ready to make your measurements, mount the Vector in accordance with the
guidelines presented in Mounting and Handling the Probe. When deploying an instrument in the field,
the primary goal of any deployment is to keep the mooring at the chosen location and to make as
accurate measurements as possible.

6. We recommend starting a deployment with fresh batteries. If you are using an internal and external
battery the primary battery will be selected based on which has highest voltage.

7. Verifying performance prior to the actual deployment can be a good idea to verify that the
configuration works well and that you are going to record meaningful data before deploying the Vector
and leave it on its own. For this you may use the data collection mode. 

8. Do not forget to erase any data recorded by the Vector before the deployment is started, if storage
capacity is crucial. We recommend starting new deployments with an empty memory.

9. For stand alone systems, it is vital to remember to connect the dummy plug to protect the
connectors.

3.1.4 Configuring a Vector

The Deployment Planning dialog contains all parameters required to specify the operation of the
instrument. The Deployment Planning frame on the right hand of the dialog displays performance
parameters that are automatically updated as you change the parameter settings. 

The deployment Planning dialog allows you to specify the instrument operation at two levels. Use the
Standard tab to configure the system with default settings for various environments and mounting
arrangements. Use the Advanced tab to fine tune the operation parameters. It is recommended to use
the Help file that is available within the instrument software for a complete overview of each of the setup
parameters, what they mean and what effects tuning them has.

For general recommendations for sampling in specific environments, check out these sections: Things to
Consider, Applications and Common Configuration Scenarios.

Sampling Strategies
A general rule when selecting an appropriate sampling strategy is to consider how often you need data
and what type of variations you want to resolve.

· Continuous sampling: the instrument is actively collecting data at all times until it is stopped.
· Burst sampling: the instrument will sample rapidly for a set period of time. In burst mode you specify

two parameters, Burst Interval which is the time between when bursts start and Samples Per Burst,
which sets the number of samples collected in the burst. A general rule to figure out the sampling rate
for a certain configuration is to consider what information you want to resolve. 

Figure: Sampling sequence when an instrument is configured for Burst sampling, w ith 600 sec burst

interval, 300 samples at 1 Hz

Sampling Rate
When it comes to sampling rate, the general recommendation is that you will need to sample at least
twice as fast as the signal of interest in order to unambiguously resolve it (i.e. the Nyquist sampling
criteria). You will need to make a few estimates of what time scales and processes are of interest and
select a sample rate appropriate for those. For autonomous deployments: You need to balance memory
and power limitations also.
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ÜFor example, when measuring waves, the sampling should be set up such that the wave record is “well
sampled.” This generally means the burst is greater than 15 minutes in duration. This can easily be
achieved if the instrument is set to 1 Hz and 1024 samples, or 2 Hz and 2048 samples. This provides
over 17 minutes of data and both examples are encouraged setups.

Internal Sampling Rate
The higher the velocity data output rate (for example by selecting 64 Hz in the configuration dialog) the
less internal averaging is occurring. This is related to the ping rate. Here are some relevant terminology:
· Ping rate: How often the instrument transmits pings. 
· Internal Sampling Rate: The internal sampling rate is fixed within each velocimeter according to its

acoustic frequency and velocity range. From a data quality perspective, the interesting parameter is
the internal sample rate

· Sampling Rate: Parameter set in the software. It sets the output rate of the data. It also sets the date
at which data are recorded internally or to disk.

For a given velocity range, the internal ping rate is constant and independent of the "sampling rate" used
in the software setup and which tells how often the Vector should output data.  

Velocity Range Internal Sampling Rate (all three beams)

0.01 m/s 70 Hz

0.1 m/s 250 Hz

0.3 m/s 250 Hz

1 m/s 125 Hz

2 m/s 125 Hz

4 m/s 125 Hz

7 m/s 125 Hz

ÜExample: If the Vector is configured with a 1 m/s velocity range, it has an internal sampling rate of
125 Hz. Each Vector measurement interval uses all of the available samples. If the Sampling rate is
set to 64 Hz, then most of the output records will be averages of 2 samples, but a few will have only
one sample (125/64 = 1.95). At 4 Hz, most of the records will hold an average over 31 samples, but
about 1/4 will average 32 samples.

Velocity Range
The velocity range is an important parameter to set properly. The range is a nominal value and the exact
maximum velocity is different along the vertical axis (i.e., toward the transmitter) and in the horizontal
plane.

ÜExample: If the velocity range is set to +/-30 cm/s, the maximum velocity Vz is 23 cm/s toward the
transducer and 81 cm/s in the plane perpendicular to the transmit axis (Vx and Vy). The ratio between
the software adjustable (nominal) velocity range and the maximum value for Vx, Vy, and Vz does not
remain constant but is different for each setting.

As a general rule, the velocity range should always be set as small as possible. If for example, the
maximum expected velocity is 8 cm/s, the velocity range should be set to +/- 10 cm/s. The reason for
this is that the noise in the data increases with increasing velocity range. If we set the velocity range to
+/-70 cm/s and the actual velocity is only 2 cm/s the data will appear excessively noisy.

If the conditions are not known in advance, the velocity range must be set high enough to cover the whole
deployment period. Be aware that the velocity range must cover the full range of wave motion on top of
the mean current. If, for example, the mean currents are expected to be around 10 cm/s and the wave
orbital velocity may reach 40 cm/s, the velocity range should be set to 1 m/s.
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Speed of Sound
The instruments use the speed of sound to compute velocity from the measured Doppler shift, so this
information is of vital importance. The speed of sound in water is primarily a function of temperature and
salinity. The temperature is measured by a thermistor embedded in the probe and reported in degrees
Celsius, and this information is used when selecting Measured speed of sound. If the measurements are
to be done in an area with changing salinity (for example, an estuary), it can be an idea to use a fixed
speed of sound and correct the measurements for speed of sound errors as a post processing step.

3.1.5 Data Collection

The Vector system allows for both stand-alone (self-recording) and real-time data collection (monitoring
applications). Both applications share the same procedure for the deployment planning (i.e. instrument
configuration). A typical sequence includes:

1. Test the Vector as described in Initial Preparation.
2. Erase recorder. Click Deployment > Erase Recorder. 
3. Set the real time clock in your PC (the correct time of day).
4. Set the pressure offset: On-line > Set Pressure Offset.
5. Use the Vector software to plan the deployment. Click Deployment > Planning.
6. Install the Vector in its frame, and run a compass calibration. Click On-line > Compass Calibration.
7. Start deployment. Click Deployment > Start Recorder Deployment (Stand-alone) or Start Data

Collection (Real-time).
8. Enter a 6-character deployment name.
9. If appropriate, set a delayed start-up time.
10.  Disconnect cable and install dummy plug. Insert plug pins with silicone spray.
11.  Install on site. Ensure that the acoustic beams point where you want and that they are not

obstructed. If you use a cable probe and configure the instrument to measure in ENU, please
remember that the probe and the main housing need to be aligned.

Note: If you set the Vector to collect data, remove power, and then re-apply power later, the Vector will
immediately resume data collection. Remember that the date and time may be lost if the power is gone
for some time.

Although designed primarily for autonomous deployments, the Vector may just as well be used in
monitoring applications with online connection to a remote computer. You may then set up the Vector to
record a copy of all data acquired to the internal recorder, in addition to have the data transferred to the
remote computer. This is called Recorder Data Collection, as opposed to Deployment (see buttons in the
Vector software).

The Vector may also be used together with other sensors or with a controller. When used with a
controller, the controller may serve as an external storage device (if applicable) and it may provide power
and sampling control creating a very sophisticated system. All this is treated in detail in the Integrators
Guide - Classic.

3.1.6 Mounting and Handling the Probe

· It is important to remember that any motion of the instrument can significantly alter the flow pattern
and amplify the vortex-induced forces. A primary goal is thus to keep the instrument from moving. If
not, an IMU should be considered.

· Self-disturbance of flow can be a source of data contamination for Vectors. Flow disturbance affects
your measurements, and significant errors can be generated when the sensor samples in its own
turbulent wake. Thus, it is important to consider the effects large objects will have on the flow itself. A
rough rule of thumb is that objects disturb the flow as far as 10 diameters away from the object. Flow
disturbance is greatest directly downstream in the wake behind the object.

· Use extra attention to ensure that no part of the deployment comes in the way of the beams (mooring
line, buoy, frame, etc.). Objects in the way of the beams will corrupt the data. Objects interfering with
the beams may violate your data.

https://www.nortekgroup.com/
https://www.nortekgroup.com/
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· When wave measurements are of interest; usually we aim to classify the incident wave and current
field, therefore it is critical that we deploy the instrument in a location that exposes it to an incident
wave environment that is undisturbed by its surroundings. Some neighboring structures that influence
the data collection could include piers, breakwaters, unusual changes in bathymetry, as well as rivers
(or exposure to high currents). Such structures affect the local wave field by reflections, diffraction,
refraction, evanescent modes, etc. For example, an instrument deployed in front of a breakwater would
be exposed to the combined incident and reflected waves. The PUV approach does not have the ability
to separate these two fields. Therefore close proximity to any of the above listed is discouraged,
unless of course the objective of the data collection exercise is to measure the locally influenced wave
environment at the particular location of deployment. 

· Make sure that there is enough return signal from the scatters in the water. The Vector needs a certain
signal-to-noise ratio, SNR to get accurate estimates. The more scattering particles there are in the
water, the better the SNR.

· Mounting on or near metal that influences the magnetic field should be avoided. If this cannot be
avoided then the user can either calibrate the effects (run the compass calibration), or note the
orientation of the instrument in its deployment position (heading) so that it may be corrected during
data processing. The data can also be collected in XYZ coordinates instead of relying on the
magnetometer (compass). By using XYZ coordinates, the data will not be transformed to ENU
coordinates, and are thus not in the risk of being incorrectly transformed.

· The whole deployment system might move into a different measurement site if care is not taken. The
shifting tide combined with a slack mooring line might result in a shift in deployment location. It is
important to consider stretching of the mooring components under tension, especially the mooring line,
in order to know the exact horizontal and vertical position of the instrument.

· The deployment depth should not exceed the depth limitations of the instrument’s pressure sensor.
The absolute maximum pressure the sensor can handle is a pressure twice its range. For example,
the standard 50 m pressure sensor can safely withstand 100 m depth, but it will not record meaningful
data beyond 50 m. It has only been calibrated to 50 m. Beyond 100 m it will be damaged.

· Special consideration must be taken when using a Vector with a cable probe (opposed to the fixed
stem type). For the cable probe, it is critical that during data collection in ENU coordinates, the “X”
receiver arm (marked with red) is aligned with the “X” mark on the Vector housing. This is because the
compass and tilt sensor is located in the Vector housing. The internal tilt sensor determines up or
down, and ultimately ensures that the correct coordinate system is used for the directional estimates.
If you collect data in beam or XYZ coordinates, you can mount the probe in whatever direction you
want.

· Boundaries are not a concern in mid waters, but if you want to use the instrument near the bottom or
surface, you should consider the effects of boundaries as you design your experiment. Use the
Distance Check functionality for useful input.

· If the batteries need to be replaced or re-changed or the data need to be downloaded on a regular
basis, the deployment should facilitate easy recovery and redeployment.

3.1.7 Orientation of Vector probes

The Vector XYZ coordinates are different depending on the orientation of the tilt sensor and if it is cabled
or fixed stem probe. The tilt sensor and compass are both located in the housing. The SNR, amplitude
and correlation data you have gathered are not dependent on attitude, they are always collected with
reference to beam coordinates.  In the image below you can see the XYZ coordinates relative to the
probe head.
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Figure: XYZ coordinates relative to probe head

The orientation of the tilt sensor is easy to find out by doing simply bench test and rotating the
instrument to see when pitch and roll approaches zero.

In a situation where tilt (and therefore heading) values are incorrect due to the instrument and probe not
being aligned the XYZ and Beam coordinates are still valid. XYZ and Beam velocity data are gathered
with respect to the probe head only. 
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Figure: Orientation of Vector Cable Probe

Special consideration must be taken when using a Vector with a cabled transducer array (opposed to the
firmly attached stem type). For the cabled type, it is critical that during deployment the instrument’s
array relative to its body (cylinder) is the same as it is with the Vector with the stem. This is because the
internal tilt sensor determines up or down, and ultimately ensures that the correct coordinate system is
used for the directional estimates.

3.1.8 Measuring Waves

For readers interested in information about wave measurements in general we recommended reading the
Comprehensive Manual - ADCP, as this manual covers this subject in detail. In this manual we focus on
how wave estimates can be calculated using a Vector.

Waves on the ocean surface are clear to us all, however less obvious are the subsurface dynamics
generated by these waves. Beneath the surface, waves generate an orbital motion as they pass by a
point (indicated in the figure below). The motion associated with the waves penetrates down into the
water column. Additionally there is also dynamic pressure that is associated with the combined effect of
the vertical acceleration and the change with depth of the water column. The ability to measure these
dynamics below the surface makes it possible to interpret the waves on the surface and therefore
provides the means to estimate many of the wave parameters that are commonly used to describe a sea
state, such as height, period, and direction.

The name "PUV" itself is a description of the method as it is an abbreviation of the three quantities
measured: Pressure and the two horizontal components of the wave’s orbital velocity, U and V. These
measurements are made at the instrument’s deployment depth and because they are co-located at the
same point, this is referred to as a “triplet” measurement. 

https://support.nortekgroup.com/hc/en-us/articles/360029839331-The-Comprehensive-Manual-ADCP
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Orbital Velocities
When a wave propagates past a point it creates local currents below the surface. These currents are
special in the sense that they are changing direction, whereby the crest of a wave will have the affected
water below it moving in the direction of propagation, and the affected water below the trough moving in
the opposite direction of the propagation, as illustrated in the figure below. This cyclical motion
constructs a circular path in the water column and is often referred to as a wave’s orbital velocity. The
orbital velocity produced when a wave passes is the basic mechanism for obtaining information about the
waves on the surface, by use of linear wave theory. This provides the means to estimate the directional
wave parameters that are commonly used to describe the sea state.

Figure: Description of the orbital velocities beneath a wave as it

propagates. Note that the orbital velocity attenuates w ith depth.

An important detail to understand about orbital velocities is that it attenuates exponentially with
increased depth and shorter wavelength. The wave energy will only propagate to a certain depth; and the
energy cannot be detected below this depth. This means that:
· Short waves in deep water do not have an orbital velocity signal that penetrates to the bottom. The

depth limit is related the Wavelength (L), and is typically at depth L/2.
· Higher frequency waves attenuate more quickly with depth. 
Thus there exists a tradeoff between the depth of the measurement location and the ability to measure
the higher frequency waves. This is exactly why we are both depth and frequency limited when
measuring waves. See example in next section.

Pressure
Another important property when measuring waves is the dynamic pressure. It is largely dependent on
the presence of orbital velocities and this means it also experiences attenuation as a function of depth
and wavelength. The dynamic pressure is at maximum under the wave crest. The rate of decrease with
depth is well understood and modeled by linear wave theory. This allows us to measure the pressure, to
rescale the measurement to obtain the wave elevation spectrum at the surface, by use of transfer
functions. The pressure data is thus used for the non-directional wave estimates.

3.1.8.1 Processing Method

The instrument samples pressure and measurements of orbital velocities, but the resulting time series of
raw measurements is not particularly useful from a practical standpoint. The wave data therefore needs
to be processed to yield the relevant wave parameters that can broadly, yet accurately, characterize the
sea state. 

The PUV analysis provides an accurate estimate of the wave elevation spectra in addition to the direction
and the directional spreading. The dynamic pressure measurement provides a means of estimating all
the non-directional wave parameters, while the combined P, U, and V measurements allow for estimating
the directional wave parameters. 
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Since these estimates are based on the wave energy distribution, and not a direct measure of the free
surface, they are considered inferred estimates. Fourier transforms are used to separate the signals into
different frequency bands so that it can determine the direction separately for each band. This means
that if you have a long-period swell coming from one direction, and a shorter period coming from another,
you can tell the direction for each of them separately. The main assumption for standard PUV wave
measurements is that waves at a given frequency come from one primary direction. 

Limitations
The most important thing to understand about the PUV method is that it is limited to 
1. Deployment depths that are shallow (less than 10 meters) and 
2. waves that are long (approximately periods of 4 seconds or longer). 

The limitation of only measuring long waves (swell) is the one that should raise a warning flag for those
who are interested in the complete description of the wave environment. 

ÜExample: Investigating a structure’s response only to swell in shallow water. The accuracy of the
solution requires measurements over the entire wind wave band (waves with periods of 0.5-30
seconds). Incomplete coverage of the wind wave band can result in underestimation of wave height and
missing peaks in the spectrum. The only way to improve the coverage of the wind wave band is to
deploy the instrument in relatively shallow water (i.e. 3 meters depth).

3.1.8.2 Wave Parameters

The most common non-directional wave parameters describe height and period of the wave field and are
single values representative of the time series. In many practical situations, the directions of the waves
are also of great interest and these are based on the first pair of Fourier coefficients and describe the
mean direction at a given frequency. The Post-processing of raw wave data will lead to classic wave
estimates for the following wave parameters:

Acronym Description Range Note

Hm0 Known as Significant Wave Height, defined as the mean of the
highest 1/3 of all waves in the record’s ranking. 

Meters

Tm02 Mean period. seconds

Tp Peak period of the waves corresponding to the peak frequency. seconds

DirTp Peak direction is the wave direction at the frequency at which a
wave energy spectrum reaches its maximum

0-360 degreesReported as
"From"

SprTp Measure of the directional variance at peak frequency. 0-360 degreesReported as
"From"

Mdir Mean direction. Weighted average of all the directions in the wave
spectrum.

0-360 degreesReported as
"From"

Unidir.
Index

Measure of how much of the wave energy over the full spectrum is
from a single direction. Value of 1.0 indicates the energy is from
one primary direction

3.1.8.3 Deployment Considerations and Cautionary Notes

The PUV approach is based on linear wave theory; occasionally situations arise where linear theory is no
longer valid and second order effects become increasingly significant. Such situations occur when one
attempts to improve the instrument’s response by placing it in increasingly shallower water. Long waves
in shallow water become solitary, and hence have a nonlinear profile that is not accounted for by the
PUV transformation. The result is that waves are properly sensed but the wave height is slightly
underestimated.

Perhaps the most difficult aspect of classifying sea state via spectral based estimation is the realization
of wave energy at high frequencies. These types of spectra prove to be quite tricky. Amongst the
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problems are the errors in the calculation of moments and cutting off peaks at higher frequency. One
scenario is that an instrument placed in 15 meters of water may never detect the energy up above 0.25
Hz. 

Usually, the aim is to classify the incident wave field and therefore it is critical that the instrument is
deployed in a location that exposes it to an incident wave environment that is undisturbed by its
surroundings. Some neighboring structures that influence the incident waves could include piers,
breakwaters, unusual changes in bathymetry, as well as rivers (or exposure to high currents). Such
structures affect the local wave field (reflections, diffraction, refraction, evanescent modes, etc.) and are
not the best representation of the incident wave field. For example an instrument deployed in front of a
breakwater would be exposed to the combined incident and reflected waves. The PUV approach does not
have the ability to separate these two fields. Therefore close proximity to any of the above listed is
discouraged, unless of course the object of the data collection exercise is to measure the locally
influenced wave environment at the particular location of deployment.

For tips on how to configure the Vector for wave measurements, check out the "Setting up for operation"
chapter.

Target Depth

What considerations that must be taken into account first and foremost depend on the wave frequency of
interest. Knowledge about the limitations that exists when measuring waves and having an anticipation of
the waves that are to be captured is critical to determine the instrument’s depth and ultimately
successful data collection and post-processing. Therefore the aim is to achieve a ‘Target Depth’. This is
the deployment depth that will capture as much of the wave spectrum as possible with the greatest
amount of accuracy. Knowing the types of waves the instrument is likely to be exposed to, and what
types of waves that are of interest to measure, makes it much easier to decide upon the deployment
depth. 

Depth 20 15 10 5 3

Tp [s] 5.86.4 7.28.3 10.
1

5.0 5.5 6.2 7.1 8.7 4.14.55.05.8 7.1 2.9 3.2 3.6 4.1 5.0 2.3 2.5 2.8 3.2 3.9

Hm0
[m]

0.7
5

0.6 0.3
5

0.3 0.2 0.5 0.4 0.2
5

0.2 0.150.40.30.20.1
5

0.1 0.2 0.1
5

0.1 0.0
7

0.0
5

0.1
2

0.1 0.05 0.0
4

0.03

Table: Limitations of the measurable waves (PUV method) w ith regard to depth, peak period (Tp) and

significant wave height (Hm0).

PUV method: Pressure, U and V velocity components (orbital velocity components) are the parameters
of interest. The pressure and orbital velocity signals attenuate with depth, thus the signals from the
waves are not detectable at a certain depth. If you know the significant wave height of the area and the
prevailing period of the waves, you can find the depth in the table above that are able to measure the
waves of interest. This table provides a general guideline for the limitations when measuring waves. 

Perhaps the most difficult aspect of classifying sea state via spectral based estimation is the realization
of wave energy at high frequencies. These types of spectra prove to be quite tricky. Amongst the
problems are the errors in the calculation of moments and cutting off peaks at higher frequency. One
scenario is that an instrument placed in 15 meters of water may never detect the energy up above 0.25
Hz.

3.1.8.4 Corrections, Measurement Errors and Uncertainties

Corrections
In case of strong background currents, the measured waves may be affected by a Doppler shift. That is,
when currents are directed against the waves, the waves are compressed. When the currents travel in
the same direction, the waves are elongated. The resulting spectra will see the peak energy shift slightly
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to lower or higher frequencies. It is not just the magnitude of the currents that is essential but also the
direction. Currents flowing in a direction perpendicular to the wave direction will have no effect on the
waves.

The degree to which the Doppler shift modifies the surface waves depends on the current speed relative
to the wave propagation speed. This means that slow propagating (short period) waves are the most
affected by currents. Measurements that infer the surface waves from either orbital velocity or pressure
measurements, like PUV, require special attention regarding background currents. This is because the
transfer function used for inferring the surface waves is wavenumber dependent, and it is the wavenumber
that is modified by the background currents. The wavenumber solution must take into account the mean
current and direction relative to the wave direction. 

Measurement Errors
Measurements are estimates of the value of something real. Given a real wave direction, each
measurement is an estimate of this direction. If the instrument happens to be measure waves with
infinitely-long, parallel crests, wave direction is easy to define; it is perpendicular to the wave fronts.
However, real waves are rarely so simple. At any given time, wave spreading blurs the wave direction,
making the real wave direction meaningful only as an average. 

Uncertainty
There are three primary factors in the uncertainty:
1. The actual directional spread of the waves themselves. Uncertainty in the mean wave direction is

proportional to the spreading of the waves.
2. SNR or signal/noise ratio. A noisy measurement increases the apparent spreading and the

uncertainty of the measurement.
3. Averaging. Like most estimators, averaging produces more accurate estimates. 

The directional estimator is unbiased, so averaging should always reduce the uncertainty. In contrast,
the spreading estimator is biased. Averaging still helps, but you will always have a residual bias, the
magnitude of which depends on the amount of spreading.
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3.1.9 Optional IMU

Nortek offers the Vector with an optional integrated Inertial Motion Unit (IMU). This sensor is intended to
help understand how the Vector's own motion influences the measurements. The simple configuration
allows one to record motion data simultaneously with the Vector velocity data. The data from the IMU
sensor are sampled and stored in real-time, so the velocity measurements and the motion and
orientation measurements are tightly synchronized. Before continuing; be aware that the description
below applies for Vectors using firmware/software versions from V3.42/V1.39 and onward. If you use
older versions, an update is recommended.

Physically, the IMU is incorporated in the Vector by simply using the magnetometer contact interface.
This means the standard tilt and magnetometer are removed and replaced with the IMU. So there is no
standard Nortek compass system with the IMU integrated. 

Note that the use of IMU demands the use of 4GB recorder, due to the amount of data collected. 

Figure: The IMU sensor replaces the compass board

The velocity measurements and the IMU data will be presented in the coordinate system selected. The
IMU can be used as an AHRS; since the Vector with IMU can be used in any orientation (horizontally,
vertically,..) while simultaneously converting the measured velocities to ENU, - thus a full 3D solution.
We also indicate the heading, pitch and roll to the direction the instrument had during the measuring
period.

Note that there is no advanced internal processing as this is left with the end user. The software does
only correct for orientation, it does not manipulate velocity other than transforming it to ENU. Correcting
for movement will have to be done as a next processing step by the user, using e.g. delta velocity/delta
angle. But the good news is that the orientation will be correct even when there is movement.

The end user would benefit by understanding the sensor itself. This may be done by visiting the product
page and looking at the Documentation tab: http://www.microstrain.com/inertial/3DM-GX3-25-OEM

The location of the IMU is relevant if e.g. removing the affect of mooring vibrations are of interest. The
center of the sensor is 16 cm from the end of the endbell where the probe stem is affixed.

http://www.microstrain.com/inertial/3DM-GX3-25-OEM
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Figure: Location of IMU relative to stem

3.1.10 Data handling

Data
The Vector creates binary files (*.vec), which can be converted to ASCII format files by using the Data
Conversion tool within the Vector software. The Vector records the following:
· The *.hdr file is a self-documented table. Please note that this file contains the detailed data format of

all the other ASCII files.
· The *.dat files contains velocity and pressure data at the full sample rate.
· The *.sen files contains system data such as the time/date, compass, tilt, temperature, battery

voltage, etc. These data are sampled once per second
· The *.pck contains the probe check data 
· The *.vhd contains the Velocity header data - the data that is collected during the very first second

when running Continuous mode, or at the start and end of each Burst.

The ASCII files are easy to import into most spreadsheets and data analysis programs. 

Check out our web pages to gain access to the latest technical notes and user-experience regarding
data analysis and related matters.

Quality Assurance and Quality Control Tips:
Check the Looking at Velocimeter Data section. If the data looks different from what you expected and
you have reason to believe that this is instrument or deployment related, consult the Troubleshooting
section before spending too much time on QA/QC.
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3.2 Vectrino

3.2.1 Technical description

For technical specifications, check out the product on our website.

Probe
The standard and the field probe is made of stainless steel and consists of four receive transducers and
a transmit transducer. It is mounted either on a fixed stem connected to the main housing through the
probe endbell, or on a cable connected to the main housing through the same probe endbell.

Transducers
Each of the four receive transducers is mounted inside a receiver arm. The transmit transducer is in the
center of the probe.

Electronic Module
The electronic module is located inside the pressure case and consists of a single board with the power
transmitter, analog and digital signal processing, power conditioning and interface circuits.

Temperature sensor
The temperature sensor (thermistor) is located inside the probe head

Power and Communication Cable
The power and communication cable is connected to the endbell connector. The cable supplies external
DC power (12–48 V) and provides two-way serial communication with an external computer. It also
provides four analog outputs (0-5 V DC) for input to an AD converter. The cable also provides
synchronization options when the Vectrino is used as master or slave to synchronize measurements
with other Vectrinos and/or other instruments.
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The Vectrino is shipped with a 12-pin cable and waterproof connector. The Vectrino power lines are diode
protected, hence, you do not have to worry about wiring the Vectrino power backwards. If you do, it will
not damage your instrument. The pin-out is shown in the Service Manual.

Options
The Vectrino can be shipped with the following components to suit different requirements:
· Standard or Vectrino Plus firmware. Upgrading to Vectrino Plus is also available as retrofit
· 4-beam down-looking probe or side-looking probe. Fixed stem or flexible cable. Changing the probe is

available as retrofit.
· Field probe

3.2.2 Instrument software

The Vectrino software is designed to aid in the planning and execution of on-line data collection, and is
available in two versions:

· Vectrino, 25 Hz sampling
· Vectrino Plus, 200 Hz sampling

The Vectrino Plus software is used with Vectrinos with the Plus firmware installed, and provides a wider
range for some of the settings than the standard version does. It is emphasized that the Vectrino and
Vectrino Plus software is not primarily designed for controlling multiple instruments. For these types of
measurements, we instead recommend using Polysync.

The Vectrino and/or the Vectrino Plus software can be found on the flash disk that came with the
instrument, or on the Nortek web site: www.nortekgroup.com/software. Nortek Windows programs run on
all versions since XP (SP3), including Windows 8.
 
Installing the PC Software
Follow these steps to install the software on a computer running Windows:

1. Download the latest version of the software from the Nortek website and open the .exe file.
2. Follow the on-screen instructions. Accept the default settings. The Setup program will by default

install the application in the c:\Nortek\Vectrino folder and create an application shortcut in the Nortek
programs folder and on the desktop.

3. Restart your PC if prompted to, to finalize the installation process.

Software Help
An on-line help is integrated in the software, and it contains answers to all questions you may have on
how to use the software. Click Help > Help Topics.

3.2.3 Initial preparation

Communication
Check that you have installed the software correctly according to the procedure in the previous section,
and then follow this procedure to test the communication:
1. Using the enclosed cable, plug in the AC adapter, and connect the Vectrino cable and the Serial-to-

USB converter to the USB port on your computer. 
2. Start the Vectrino software.
3. Select Communication > Serial Port, and specify which port number to use.
4. Accept the default baud rate settings (19200 baud), which is also the default baud rate for the

instrument.
5. Click the Connect toolbar button. The Vectrino instrument should reply with an identification string.

Baud rates

http://www.nortekgroup.com/software
http://www.nortekgroup.com/software
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The baud rate is specified in the Serial Port dialog box. There are two baud rates that can be specified;
one for normal communication and data transfer, and one for firmware upgrades. For the standard
Vectrino, the default baud rate is19200. For the Vectrino Plus, the default is 57600.

The baud rate settings for transfer of head files and firmware upgrades may differ from those for
transmission of deployment setups and for online data collection. The reason is that the former assumes
that high transmission rates can be used without problems, i.e. that the cable connecting the computer
to the instrument is short. A higher baud rate may reduce the download time, but note that the baud rate
is limited to the operating system of the PC, the serial port, and the length of the USB cable. If you
experience communication issues after changing the baud rate, try changing it back to the default.

The baud rate setting can be changed if you upgrade in-situ using long cables. The Vectrino verifies the
received head file and firmware upgrade files before they are allowed to replace the existing head and
firmware files, hence, using the wrong transmission speed will not cause trouble.

The table below shows the highest permissible sampling rate for a given baud rate (Vectrino).

Baud Rate Max Sampling Rate

300 1 Hz

600 2 Hz

1200 4 Hz 

2400 8 Hz

4800 16 Hz

9600 32 Hz

19200 64 Hz

38400 128 Hz

57600 200 Hz

Check the transducers
1. Fill a bucket with water and a little sound-scattering material ("Seeding").
2. Click Data collection > Start Data Collection. While the transducers are in the air, the velocity

measurement will look like random noise.
3. Immerse the transducers in the water, and observe the velocity, the standard deviation, and the

amplitude in counts. Note the change in the graphical view of the velocity when the probe is lowered
into the water. In the air the graphs are noisy; in water they should be smooth. Noisy velocity graphs:
If the velocity graphs remain noisy when the probe is immersed in water, try varying the position of
the probe, or add some seeding like dirt or small particles to the water.

4. Designed to act as a measurement quality assurance tool, the Probe Check function in the Vectrino
software lets you inspect the region where the Vectrino makes its measurements by showing how
the signal varies with range. You can use it to diagnose and correct problems and to optimize data
collection. Click Data Collection > Probe Check to start the Probe Check.

3.2.4 Configuring a Vectrino

The Deployment Planning dialog contains all parameters required to specify the operation of the
instrument. The Deployment planning frame on the right hand of the dialog displays performance
parameters that are automatically updated as you change the parameter settings. It is recommended to
use the Help file that is available within the instrument software for a complete description for each of the
setup parameters available.
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For general recommendations for sampling in specific environments, check out these sections: Things to
Consider, Applications and Common Configuration Scenarios.

Sampling rate
When it comes to sampling rate, the general recommendation is that you will need to sample at least
twice as fast as your signal of interest in order to unambiguously resolve it (i.e. the Nyquist sampling
criteria). You will need to make a few estimates of what time scales and processes are of interest and
select a sample rate appropriate for those.

Nominal Velocity Range
The velocity range is set before data collection is started. The range is a nominal value and the exact
maximum velocity is different along the vertical axis (i.e., toward the transmitter) and in the horizontal
plane. The horizontal and vertical ranges are presented in the planning dialog. Setting the velocity range
to an appropriate value for the flow being measured is the most important instrument parameter in order
to get good data quality. Too large a velocity range will result in noisy data because the detected phase
shift is very small relative to the ambiguity velocity. Too low a range will result in de-correlation of the
return signals or phase wrapping. The appropriate Nominal Velocity Range will generate good quality
data minimizing data quality problems.

ÜFor example, if the velocity range is set to +/-0.3 m/s, the maximum velocity Vz is 0.27 m/s toward
the transducer and 0.94 m/s in the plane perpendicular to the transmit axis (Vx and Vy). The ratio
between the software adjustable (nominal) velocity range and the maximum value for Vx, Vy, and Vz
does not remain constant but is different for each range setting.

As a general rule, the velocity range should always be set as small as possible, but still cover the
expected velocities.

ÜFor example, if the maximum expected velocity is 4 cm/s, the nominal velocity range should be set to
+/- 0.1 m/s. The reason for this is that the noise in the data increases with increasing velocity range. If
we set the velocity range to +/- 4 m/s and the actual velocity is only 2 cm/s the data will appear
excessively noisy. 

If the conditions are not known in advance, the velocity range must be set high enough to cover the whole
deployment period. Be aware that the velocity range must cover the full range of wave motion on top of
the mean current. If, for example, the mean currents are expected to be around 0.1 m/s and the wave
orbital velocity may reach 0.4 m/s, the velocity range should be set to 1 m/s. 

Adjusting sampling volume and/or transmit length

Transmit length is the length of the acoustic pulses transmitted by the instrument. In theory, sample
volume size is entirely independent and set by the amount of time spent listening. In reality, the
sampling volume size has been optimized for a given transmit length for the best performance.

Theoretically, a shorter transmit length is better because it results in a higher signal bandwidth. In reality,
the SNR will decrease simply because there is less energy in the return signal. There are tradeoffs to be
made, but usually there is not a need to change the transmit length to try and further optimizes
performance. The exception is if the user is trying to get closer to boundaries.

The sample volume height will control how much spatial averaging there is. While there might be some
theoretical benefit to using either a shorter transmit pulse or a smaller sample volume, in reality our
experience suggests the drop in SNR usually leads to a slightly higher noise variance that offsets any
theoretical benefit. If unsure about this setting, the easy way is to perform several measurements with
different sample volume sizes and compare results.
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Power Level
There are four different power levels:
· Low-
· Low+
· High-
· and High+. 

It is about 6dB difference in SNR between High+ and High -, 10 dB between High- and Low + and about
6dB between Low + and Low -. Adjusting the power level should thus be related to the signal strength, so
if the scattering level is low then the power level should be set to High. 

Take a look at the Probe Check section for a couple of examples on how to determine whether the power
level should be increased or decreased from the default setting.

3.2.5 Mounting and Handling the Probe

When using an instrument in a laboratory flume, it is recommended to ensure alignment of the
coordinate system. For a quick setup, aligning everything by eye works surprisingly well if you have good
references to align against (e.g. flume walls). For a more rigorous setup, two spirit levels mounted
orthogonal to one another can be used to make sure the mounting fixture and probe are level. This
assumes the top of your flume is level since everything is usually mounted on a cross piece to it. 

Follow these guidelines when you mount your Vectrino:
· Make sure that there are no obstructions between the sensor and the focal point (sampling volume)

located about 5 cm from the transducers for the standard Vectrino, 10 cm for the field probe. 
· When mounting the sensor, use the recessions to strap it to the structure. Never use the probe stem

as mounting point.
· Consider the effects of large objects on the flow itself. A rough rule of thumb is that objects disturb the

flow as far as 10 diameters away from the object. Flow disturbance is greatest directly downstream in
the wake behind the object.

· All acoustic transducers must be submerged during data collection. Operating your instrument when
the transducers are out of water will not cause any damage, but your data will be meaningless. For
side-looking probes, it is possible to collect 2D-data with only the lower receiver arms submerged.

· The best quality is achieved if the main flow direction is perpendicular to the transmit axis. Flow
directly into the transmit axis should be avoided.

· Make sure your mounting structure is stable. Small vibrations in the mount can generate large
accelerations in the data.

· After mounting the instrument, run a Probe Check as a diagnostic tool to confirm that the sampling
volume and signal strength looks good.

If the flow is dominantly 1D, the side-mounted configuration where the transmitter is orientated
perpendicular to flow direction is preferable. There are two main reasons for this:
· It avoids any possible flow interference from the probe into the sampling volume (especially relevant for

wave measurements)
· It avoids bottom interference through the weak spot problem.

When two probes are close together, there is a chance of acoustic cross interference. Mostly, this
should happen when one unit is transmitting and the other is receiving. For this reason, it is probably
wise that the two probes are not mechanically coupled. Otherwise, the cross interference is going to be
a function of the particle concentration - lots of particles give strong return signal and the effect of the
cross interference will be less important. Please be aware that the transmitters in the two systems are
asynchronous - even if the data collection is synchronized using the synch input/output lines. This also
means that a test to check for cross interference should be left to run for at least 5 minutes. Note that for
the Vectrino Plus version, the firmware allows for synchronization of the transmit pulses.
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3.2.6 Data Handling

Data
The Vectrino software saves data in binary files (*.vno), which are easily converted to ASCII format files,
using the conversion module in the software.

· The *.hdr file is a self-documented table. Please note that this file contains a detailed data format
description of all files that are generated.

· The *.dat file contains velocity data at the full sample rate. 
· The *.pck contains the probe check data 

ASCII files are easily imported into most spreadsheets and data analysis programs.

QA/QC
Check the Looking at Velocimeter Data section.

Typical processing tasks: 
1.  Assess data quality (QA/QC)
2.  Data screening
3.  Statistics to describe the flow (mean, variance)
4.  Spectral Analysis (turbulence, waves)
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3.3 Vectrino Profiler

3.3.1 Technical description

For technical specifications, check out the product on our website.

Probe
The probe is made of stainless steel and consists of four receive transducers and a transmit transducer.
It is mounted either on a fixed stem connected to the main housing through the probe endbell, or on a
cable connected to the main housing through the same probe endbell.

Transducers
Each of the four receive transducers is mounted inside a receiver arm. The transmit transducer is in the
center of the probe.

Electronics Modules
The electronics module is located inside the pressure case and consists of a single board with the power
transmitter, analog and digital signal processing, power conditioning and interface circuits.

Temperature sensor
The temperature sensor (thermistor) is located inside the probe head.

Power and Communication Cable
The power and communication cable is connected to the endbell connector. The cable supplies external
DC power (12-48V) and provides two-way serial communication with external computer. 

The cable also provides synchronization options when the Vectrino Profiler is used as master or slave to
synchronize measurements with other Vectrino Profiler's and/or other instruments.
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Cable wiring: The Vectrino Profiler is shipped with a 12-pin connector and communication cable. The
connector type is an MCBH-12-FS waterproof connector. The pin out and wiring of the cable can be
found in the Wiring of Cable chapter.

The Vectrino Profiler power lines are diode protected, hence, you do not have to worry about wiring the
power backwards. If you do, it will not damage your instrument. 

USB-Serial Converter
The USB-Serial converter is a high-speed device which supports up to a 1.25 MBaud transmission rate
over shorter distances. It is important that the most up to date version of the drivers be installed with the
converter. Driver updates are available from the FTDI web site at
http://www.ftdichip.com/Drivers/VCP.htm. 

At high sampling rates (above 60 Hz), the driver parameters need to be tuned to provide an adequate
display rate for the application software. Without this tuning, higher sampling rates will appear to be slow
and bursty. 
· Open Windows Device Manager, expand Ports (Com and LPT), right-click on the appropriate serial

port and select Properties. 
· With the properties in view, click on the Port Settings tab. The baud rate displayed (9600 in the menu

shown) doesn’t have to be changed. The application will automatically set the baud rate of both the
USB-serial port and the instrument to the requested rate in the connection menu so this driver entry
can be left unchanged. 

· Click on the Advanced button
· Change the Latency Timer to 5 msec. Faster systems should be able to use 2 msec. 
· Remove and re-insert the USB connector to activate the parameters. 

While having a lower latency timer is better, it can result in significantly higher CPU usage on slower
machines. If the data transfer from the instrument has degraded noticeably with the new latency timer,
increase it to a larger number. Ideally, this number should not be larger than 8 ms or the data display
refresh will start becoming choppy at higher sampling rates. The software will warn the user if it detects
that the latency timer has not been correctly set. 

3.3.2 Instrument software

Find the software on the memory stick that came with the instrument, or on the Nortek website. To
install the software, double-click on the .exe file. This will copy the appropriate files to the installation
directory and create a shortcut to the application on the desktop. 

The Vectrino Profiler acquisition software on the included memory stick requires Java virtual machine
(JVM) to operated. The software has been tested with the sun JVM available from http://www.java.com/
but is also known to be fully functional with other JVMs.

Double clicking on the software shortcut will start it. The application initially displays an empty
instrument panel. To connect to an instrument, select Communication: Connect and choose the desired
instrument. This will bring up a connection dialog box for the instrument. Then:

· Select the appropriate serial port and port speed (baud rate) and press Apply. 
· A baud rate of 937500 is recommended for best performance of the Vectrino Profiler 
· An instrument name can be specified if desired. This will help to differentiate between instruments

when several are used in the same experiment. 
· Setting the serial port to SIM will simulate an instrument connected to the serial port. 

After the instrument has been connected, an instrument display panel is created showing the associated
data displays for the current configuration as well as the action buttons for the instrument. In addition to
the action buttons, a status display is shown on the upper right of the panel. This shows the instrument

http://www.ftdichip.com/Drivers/VCP.htm.
http://www.nortekgroup.com/software
http://www.java.com/
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name and type and four status lights used to display status information while collecting data (run status,
collection status, connection status, and instrument status). Hovering the mouse over each status light
will display more detailed information. 

For more detailed information using the software, check the SW User Guide, available under "Help".

3.3.3 Initial preparation

Communication
Check that you have installed the software correctly according to the procedure in the previous chapter,
Instrument Software, and then follow this procedure to test the communication:
1. Using the enclosed cables, plug in the AC adapter, and connect the Vectrino Profiler cable and USB

converter to the USB port on your computer.
2. Start the Vectrino Profiler software.
3. Select Connect:Vectrino Profiler, and specify which port number to use, and communication speed
4. Click on Apply to initiate communication with the instrument

Check the transducers
1. Fill a bucket with water and a little sound-scattering material.
2. Click the Start Collecting Data button. While the transducers are in the air, the velocity measurement

will look like random noise.
3. Immerse the transducers in the water, and observe the velocity, the standard deviation, and the

amplitude in counts. Note the change in the graphical view of the velocity when the probe is lowered
into the water. In the air the graphs are noisy; in water they should be smooth. Noisy velocity graphs:
If the velocity graphs remain noisy when the probe is immersed in water, try varying the position of
the probe, or add some seeding like dirt or small particles to the water.

4. Designed to act as a measurement quality assurance tool, the Probe Check function in the software
lets you inspect the region where the sensor makes its measurements by showing how the signal
varies with range. You can use it to diagnose and correct problems and to optimize data collection.

3.3.4 Configuring a Vectrino Profiler

The Doppler tab in the software is used when configuring the velocity profiling parameters. 

The Sampling rate determines how often velocity records are collected. Individual velocity samples are
collected at a rate related to the ping interval (related to the velocity range) and averaged over the
sampling rate period to produce a final velocity estimate. The Data rate bar shows the transmit bandwidth
being consumed for the given configuration. If the bandwidth exceeds that of the serial port speed, the
data will be buffered internally within the instrument before being transferred to the host computer. 

The Velocity range, combined with the Ping algorithm determines the appropriate ping timing parameters
to achieve the desired velocity. The Extended Velocity Active field indicates whether or not the selected
velocity range corresponds to dual PRF operation. 

Three algorithm choices are available for the ping algorithm: 
· Max interval: Produces the longest possible ping interval to achieve desired ambiguity velocity and

sampling range. This is best used for smooth flow conditions. 
· Min interval: Produces the smallest possible ping interval to achieve the sampling range and, at

minimum, the desired ambiguity velocity. This is best used for turbulent measurements
· Adaptive: Collects a long profile and examines the return echoes to determine where acoustic

interference is occurring. The ping rate is then calculated to achieve the desired ambiguity velocity and
sampling range while minimizing / removing acoustic interference. The adaptive ping interval selection
is carried out with every configuration performed so the ping intervals selected may vary when the
beam return signals change. This is the best general choice. The adaptive check allows the ping
intervals to be adjusted dynamically during data collection to account for changing conditions within
the environment. Options range from Once (perform adaptive check only during the configuration phase
at the start of acquisition; static checking) to 1/sec (dynamic checking). 
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The corresponding horizontal and vertical ambiguity velocities are displayed (assuming the probe is
facing down). The vertical ambiguity velocity corresponds quite closely to the beam velocity. 

For point measurement instruments, the measured region starts at Range to first cell mm and is of
length Cell size mm. For profiling instruments, the measured region starts at Range to first cell mm from
the transducer and ends at Range to last cell mm from the transducer with each cell being Cell size mm
in length. 

The Power level setting is used to adjust the amount of power supplied to the active transducer during
transmit. Under normal situations, using a setting of High is appropriate since this will provide the highest
signal to noise ratio. 

For general recommendations for sampling in specific environments, check out these sections: Things to
Consider, Applications and Common Configuration Scenarios.

3.3.5 Mounting and Handling the Probe

When using an instrument in a laboratory flume, it is recommended to ensure alignment of the
coordinate system. For a quick setup, aligning everything by eye works surprisingly well if you have good
references to align against (e.g. flume walls). For a more rigorous setup, two spirit levels mounted
orthogonal to one another can be used to make sure the mounting fixture and probe are level. This
assumes the top of your flume is level since everything is usually mounted on a cross piece to it. 

Follow these guidelines when you mount your Vectrino Profiler:
· Make sure that there are no obstructions between the sensor and the focal point (sampling volume)

located about 5 cm from the transducers. 
· When mounting your sensor, use the recessions to strap it to the structure. Never use the probe stem

as mounting point.
· Consider the effects of large objects on the flow itself. A rough rule of thumb is that objects disturb the

flow as far as 10 diameters away from the object. Flow disturbance is greatest directly downstream in
the wake behind the object.

· All acoustic transducers must be submerged during data collection. Operating your Vectrino Profiler
when the transducers are out of water will not cause any damage, but your data will be meaningless.
For side-looking probes, it is possible to collect 2D-data with only the lower receiver arms submerged.

· The best quality is achieved if the main flow direction is perpendicular to the transmit axis. Flow
directly into the transmit axis should be avoided.

· Make sure your mounting structure is stable. Small vibrations in the mount can generate large
accelerations in the data.

· After mounting the Vectrino Profiler, run a Probe Check as a diagnostic tool to ensure that the
sampling volume and signal strength looks good.

When two probes are close together, there is a chance of acoustic cross interference. Mostly, this
should happen when one unit is transmitting and the other is receiving. For this reason, it is probably
wise that the two probes are not mechanically coupled. Otherwise, the cross interference is going to be
a function of the particle concentration - lots of particles give strong return signal and the effect of the
cross interference will be less important. Please be aware that the transmitters in the two systems are
asynchronous - even if the data collection is synchronized using the synch input/output lines.  This also
means that a test to check for cross interference should be left to run for at least 5 minutes.

3.3.6 Data Handling

The Vectrino Profiler software saves data in binary files (.ntk), which are easily converted to Matlab
structured arrays or ASCII format files, using the conversion module in the software.

Matlab: The .mat file contains Data and Config structured arrays. Each array contains a "Comments"
and "Units" field that describe the contents of each structure. 
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ASCII:
· The .hdr file is a self-documented table
· The .dat file contains velocity data at the full sample rate

ASCII files are easily imported into most spreadsheets and data analysis programs

QA/QC
Check the Looking at Velocimeter Data section.

Typical processing tasks: 
1.  Assess data quality (QA/QC)
2.  Data screening
3.  Statistics to describe the flow (mean, variance)
4.  Spectral Analysis (turbulence, waves)

3.4 Things to Consider

This section contains an collection of things to be aware of when using a Velocimeter. 

3.4.1 Probe Check

The Probe Check is a powerful tool to give insight into the operation of the instrument. This tool produces
long average amplitude vs. range profiles for each beam when data collection is started, and thus gives
you "eyes" onto the region where the instrument is making measurements by showing how the signal
varies with range. 

Vector: The probe check data is available in two ways: Before and after each burst a probe check is
made, or at the beginning of the measurement when selecting Continuous mode. Continuous probe
check can be gathered if the recording to disk function is enabled before starting a probe check in the
Vector software (Online > Start Probe Check). After a binary to ASCII conversion it ends up in the .pck
file as explained in the .hdr file.  Note that when recording to disk, the data will be in binary mode. The
format is described in the System Integrator Manual.

Vectrino and Vectrino+: Click Data Collection > Start Probe Check. When exporting data using the
"Data Conversion" function the data will be automatically produced if it is available. Look in the directory
where the data file is located, and after conversion you will see a few additional files created. The
instrument configuration information and other (data) file formats are found in the *.hdr file. The probe
check data (if it is contained in the data file) will be in a file with the suffix *.pck. We recommend using
Matlab or a similar program to plot this data.

Vectrino Profiler: The Probe Check must be enabled in the Configuration Dialog. The probe check data
can be found in the "Data" structure when converting the data to Matlab format (ProbeCheckBeam*).

The probe check output in the first figure below is from a Vectrino, but a similar output is expected from
the Vector and Vectrino+. Note the amplitude at the beginning of the sampling volume (A), the nice
Gaussian peak that indicates the sampling volume (B) and the peak corresponding to the bottom (C).
Also note that the signal strength decrease to the noise floor between the measurement volume and the
bottom, and that all colored graphs show roughly the same amplitude and profile shape. The four graphs
correspond to each of the four receive beams. Graphs are scaled in distance in mm from the transmit
transducer, parallel to the transmit beam. This is also relevant for the side-looking probe. The peak in the
sampling volume (B) should reach over 100-150 counts. For the Vector, the sampling volume is located
at 15.7 cm from the probe, not 5 cm as for the Vectrino (10 cm for the field version).
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Vector and Vectrino: Note the amplitude at the beginning of the sampling volume (A), the nice gaussian peak

that indicates the sampling volume (B) and the peak corresponding to the bottom (C). Also note that the

signal strength decrease to the noise floor between the measurement volume and the bottom, and that all

colored graphs show roughly the same amplitude and profile shape.

The probe check output in the figure below is from the Vectrino Profiler. The four colored graphs in the
profile display correspond to each of the four receive beams. The broad peal centered at 5 cm is the valid
profiling volume. 

Vectrino Profiler: Note that the signal strength is presented in dB and not counts. As above, you should see a

broad peak centered around ~5 cm the profiling volume. Each colored graph correspond to the each of the

four beams. No bottom return are visible in this case.
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If the results of a probe check differs from the above figures, it is recommended to take a look at out
Troubleshooting Guide for some examples.

3.4.2 Distance Check

Bottom check processing determines the distance from the center transducer to the bottom at a given
sampling rate (up to 10 Hz). Bottom check data collection can be either enabled or disabled. When
enabled, velocity profiling is paused for a short period of time (~4ms) while the bottom check calculation
is made. The subsequent velocity sample taken is averaged for a correspondingly shorter period of time
to accommodate for the bottom check while maintaining the same velocity sampling rate. This shortened
period is reflected in the AveragedPingPairs field associated with the velocity record in the data and
displayed in the text output pane. 

For the interested reader: The bottom check sample rate used during data collection will be somewhat
different from that selected. Given that the bottom check and velocity sample rates are interleaved, the
actual bottom check sample interval will be an integral multiple of the velocity sample interval. For
example, if the velocity sample rate is 60 Hz (~16.7 ms) and the bottom check sample rate is 8 Hz
(125.0 ms), then the actual bottom check spacing will be 116 ms (~8.6 Hz). 

In order for bottom check to be effective over larger distances, the instrument should be carefully
oriented. The central transducer used for bottom check functionality is directional. If the probe is tilted
with respect to the bottom surface, then the signal may be reflected away from the transducer,
preventing the bottom echo from being visible in the profile data. 

Tip for Vectrino Profiler users: When configuring bottom check, having the bottom peak centred in the
display window (if the instrument is licensed for profiling bottom checks) with a reasonable number of low
intensity points on either side is optimal. The bottom check process determines a peak level and curve
fits a quadratic to the surrounding points. The vertex of this quadratic is used when determining the
measured distance to bottom. 

3.4.3 Velocity Ambiguity and Phase Wrap

An inherent problem with coherent Doppler processing for Velocimeters is the potential of velocity
ambiguity. This arises as a result of the fact that the phase difference can only be determined to within

±π  radians. If the absolute value of  is greater than π , phase wrapping occurs and the measured phase

shift has a value . We see this phase wrapping in a velocity trace as an
abrupt, unrealistic change in magnitude and almost always with a change in sign. While it is possible for
phase wrapping to occur without a sign change, this would be the result of an extremely large wrap
where the phase shift exceeds 2π . The ambiguity velocity can be estimated: 

Here, F
source

 is the frequency of the transmitted wave and C is the speed of sound in water. The choice of

∆t is crucial for correct operation of the instrument; the size of the separation between pulses determines
the maximum unambiguous velocity that can be measured. Longer lags have lower maximum velocities,
while shorter lags have higher maximum velocities. Conversely, longer lags will typically have lower noise
levels than shorter lags. The lags are controlled by the velocity range setting.

The simplest way to avoid phase wrapping is to have a little prior knowledge of flow conditions and to set
up the instrument appropriately for the environment. The latter is done in the Deployment Planning, where
you can set the Nominal Velocity Range. This is the maximum velocity you expect to measure during
the deployment or experiment. Note that since the transmitter and receiver are physically separated, the
measured velocity is along the bistatic axis (ref. Velocimeters). By decomposing the velocity along the
bistatic axis onto the vertical and horizontal axes you get the corresponding maximum vertical and
horizontal velocity ranges. These ranges are presented in the deployment planning dialog (right part).
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Measurement uncertainty is roughly proportional to the Nominal Velocity Range – smaller velocity ranges
give you better measurements regarding uncertainty. An example of the problem with phase wrapping is
discussed in “A Practical Primer for Pulse Coherent Instruments”.

If you have collected data that are subject to phase wrapping, there is a solution. Take a look in our
Troubleshooting Guide for the procedure.

For the Vectrino Profiler, the Extended Velocity Range (EVR) may be an option to increase the velocity
range.

3.4.4 Extended Velocity Range

Extended Velocity Range (EVR) utilizes an additional pulse pair to create a set of pulses with two
different lags and velocity ranges. With this technique, two alternating ping intervals are used to collect a
single profile. We use the first lag to get a course estimate of the velocity and then we use the second
and larger lag to improve the estimate. The first lag defines the ambiguity range of the setting and the
second is the one that is actually reported after we have used the first estimate to determine what
ambiguity branch we are on. The actual lags change with the velocity setting. The velocity calculated
using this technique is: 

The ambiguity velocity then becomes: 

This technique has the advantage of producing an extended velocity measurement for all cells in the
profile (unlike the coarse / fine pulse-pairs technique). Signal noise effectively limits the minimum usable
time difference. In practice, the gain is limited to a factor of 3-5. Note that EVR does not eliminate the
possibility of ambiguity problems if velocities exceed the specified velocity range in the Deployment
Planning dialog.

3.4.5 Weak Spots

The Vector, Vectrino and Vectrino Profiler transmits two pings, and as such, they are susceptible to
pulse interference when measuring near boundaries. This especially applies to Vectrino Profiler, as this
is a profiling instrument and the pulse is in the measurement volume for a longer period of time. Pulse
interference for acoustic Velocimeters is called a “weak spot” and will show in data as low SNR (Signal-
to-Noise Ratio) and correlation values, as well as noisy velocity traces. 

The table below summarizes the distances where weak spots occur for the Vector and Vectrino indexed
to the Nominal Velocity Range setting. Changing to the next higher or lower velocity range as appropriate
will eliminate the problem. Alternatively, moving the instrument (measurement volume) up or down away
from the boundary by just a few centimeters can reduce the weak spot effects. Note that the distances
to boundaries specified are approximate and will depend on the speed of sound and the boundary
surface.

Velocity Range (m/s) Vector (m) Vectrino (m)

0.01 3.12

0.03 0.38, 0.75

0.10 0.46 0.23, 0.45

0.30 0.20 0.10, 0.23
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1.00 0.08, 0.20 0.05, 0.12

2.00 0.05, 0.09

2.50 0.03, 0.10

4.00 0.03, 0.06 0.02, 0.05

7.00 0.02, 0.04

Table: Weak spots listed as the distance from Sample Volume to boundary for the Vector and Vectrino. Note

that the weak spot location is dependent on the speed of sound and the boundary surface, so the values

given are only estimates and weak spots may be encountered a centimeter or more away from these values.

The Velocity range specifies the separation in time for the two pulses. This parameter can be adjusted in
the Configuration dialog. The rule of thumb is to set the velocity range as low as possible without the
potential for water velocities to exceed the horizontal or vertical velocity ranges. 

A weak spots is related to the spatial separation between the pulse pairs transmitted by the
Velocimeter. A weak spot occurs when the first pulse hits the bottom and the reflected signal of the first
pulse reaches the sampling volume at the same time as the second pulse goes through the sampling
volume. The two pulses passing through the same volume at the same time creates interference,
reducing data quality and generally leading to unusable data. The figure below shows how a weak spot
may show up in the data.



Comprehensive Manual62

© 2022 Nortek AS

Figure: X, Y, Z1 and Z2 velocity plots. The upper plot shows X velocity, which is subject to interference due to a

weak spot

 

The vertical extent of the weak spots is a function of the bottom composition.  If the bottom is well
defined (e.g. sand) the extent is no bigger than the transmit pulse or about 1 cm.  If the bottom is rough,
the vertical extent can be larger.  It is also a matter of the relative strength between the water scattering
and the bottom echo - if the water scattering is high the whole issue goes away.

The Vectrino Profiler can make use of adaptive ping intervals to reduce weak spot interference. This
allows the ping intervals to be adjusted dynamically during data collection to account for changing
conditions within the environment. Options range from Once (perform adaptive check only during the
configuration phase at the start of acquisition) or 1/sec (dynamic checking). Using the Max Interval
algorithm (also accessible in the Configuration dialog) allows the time interval to be adjusted manually.
After setting the velocity range as low as possible, the range can be adjusted to a slightly higher range,
to move the weak spots out of the sampling window.

3.4.6 Interference from Highly Reflective Bottoms

The bottom material used in a lab environment can have a marked effect on the quality of the data.
Surfaces which are acoustically highly reflective will cause very large return signals which pollute the
water column in such a way that obtaining reliable data is not possible. We have seen metal bottomed
flumes that have very large returns from the bottom; so large, in fact, that they caused large areas of
interference in profiles that were stepped up from the bottom. 
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You can tell how large the return is by looking at the signal return from the bottom check. If the
instrument is to be used in such an environment (e.g. a metal bottomed flume), some sort of absorptive
material should be placed along the bottom underneath the probe. Thick plexi-glass, a thin layer of
acrylic or rubber layer or a concrete block have both been shown to work quite well in removing the
bottom reflection interference by providing some acoustic dampening to the return.

3.4.7 Mooring Vibrations

High frequency mooring vibrations due to vortex shedding are caused by current flow past a mooring
structure, such as surface and subsurface buoys, mooring lines, risers etc. Alternating vortex shedding
produces pressure fluctuations with a dominant component in the direction across the flow direction. The
mooring structures, if not mounted rigidly, are very sensitive to excitation from vortex shedding,
especially if the frequency of vortex shedding matches the resonance frequency of the structure. This
results in resonant vibrations transverse to the flow direction of the ocean currents. The occurrence of
vortex induced motion also increases the mean drag force in the current direction, contributing to
aggravating the data collection. Increased offset implies increased mooring line tensions.

The part covering vibrations on the mooring is especially important to users of the Vector. This
instrument has a high sampling rate, making it especially prone to data contamination due to vibrations.
Excessive mooring vibration can adversely affect the data; vibration introduces spurious velocities and
interferes with the proper operation of the tilt sensor. The impact of mooring oscillations must be carefully
considered. A general solution to improve on data quality is to design a more stable deployment by
considering the components that generate mooring vibrations. The addition of aerodynamic devices may
partly prevent and partly reduce the strength of vortex induced vibrations.

You may be able to detect intervals of excessive vibration by looking closely at your data. For more
accurate measurements of vibration, an accelerometer is the solution. An Integrated Motion Unit (IMU) is
a system that consists of an accelerometer, a gyroscope and a magnetometer that samples at 10 kHz,
and can be integrated with the Nortek Vector. By measuring the acceleration, the tilt and the heading,
one can correlate vortex induced vibrations with the sampled current velocities, and during post-
processing the measured sensor motions can be removed from the velocity data. Note that the use of
IMU demands the use of 4GB recorder, due to the amount of data collected. 

3.4.8 Acoustic Streaming (Vectrino and Vectrino Profiler)

The instruments generate acoustic streaming, or secondary flows, as the pulse is transmitted. If ambient
flow velocities are of the order of potential acoustic streaming velocities (below 8 cm/s), acoustic
streaming may represent a significant source of bias. 

This effect can be observed by placing the instrument in still water and observing the flow over a period of
a few seconds. Induced flows of up to 2-3 cm/s are possible in stationary water with the power level set
on HIGH. Reducing the power level will help to reduce the amount of transducer induced flow at the
expense of a reduced signal to noise ratio in the return signal. 

A range of options exist for accounting for streaming when it is unavoidable, including measurement of
streaming magnitudes with the Vectrino itself and analytical or numerical modeling. For the interested
reader; a research article covering acoustic streaming, named “Acoustic Doppler velocity-induced
acoustic streaming and its implication for measurement” is available in our web site.

3.4.9 Incorrect Speed of Sound

As already elucidated, the speed of sound in water influences the calculation of the velocity data. The
time lag between the transmitted and received pulse determines how far the pulse travelled before it was
reflected. 

The instruments compute the speed of sound based on the measured temperature (accuracy of 0.1°C).
A nominal salinity is assumed, an assumption that works relatively well because the sound speed is
more sensitive to temperature variation than it is to salinity variation. 
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Sound speed errors are typically small, but if you must correct velocity data for errors, use the following
equation:

Here, V is the velocity and C is the speed of sound.

3.5 Applications

This section contains typical applications for Velocimeters, and tries to summarize what needs to be
taken into account before starting the sampling of data. Also take a look at the Configuration section of
the chapter covering your specific instrument for some more details.

3.5.1 Mean Currents

· Choose a measurement interval that captures the variations that is of interest. For example, a typical
tidal cycle is well resolved with a measurements every 5, 10, 20 or even 30 minutes.

· The cell size has a default setting that corresponds to the instruments transmit frequency. This may
certainly be changed, but be aware that smaller cells increases the measurement uncertainty, while
large cells reduce the measurement uncertainty at the expense of power consumption.

· Vector: Typical moorings allow the instrument to tilt and rotate freely. The Vector measure tilt and
heading and uses this compass information to convert the data to true earth coordinates. How often
the instrument reads the tilt and heading depends on the deployment method used. Buoy mounted
instruments should have the compass set to update relatively fast (every second) so that buoy motion
is accounted for in the velocity estimates. For bottom-mounted instruments, it is enough with one
compass update per burst, while instruments mounted on a mooring line should update the compass
every other second. IMU should of course be considered if mounting the Vector on a moving structure.

· Vector: If magnetic fields are present, consider collecting data in XYZ coordinates rather than relying
on the magnetometer to rotate the results into ENU coordinates. At least, remember to run a compass
calibration.

· Salinity should be adjusted in the advanced menu options if it is significantly different from the default
value.

· From signal theory we know that the more pings there are within an averaging period, the better the
estimate of the true value we are measuring. 

· Make sure you are using the most recent software and firmware for your instrument. Visit the Nortek
website regularly for updates.

3.5.2 Low Flow Measurements

An important benefit of the pulse-coherent processing technique is that the instrument can be configured
to measure velocities as small as 1 mm/s, or even smaller. This is quite useful in applications where the
water motions are minimal, such as in settling tanks, bore holes and in some lakes. 

Measuring velocities of a few mm/s or smaller has a few inherent problems that should be considered
while planning the measurements:
· All Velocimeters are designed to output as much power as possible. This is done to ensure a strong

echo (high SNR) and good quality data in a broad range of applications. However, the high output
power actually generates a non-linear pressure wave that accelerates the water below the probe. If the
horizontal water velocity is small (<10 mm/s), the pressure generates a (negative) vertical velocity of 1-
15 mm/s in the sampling volume. This problem can be minimized by using the lowest velocity setting,
and the lower power setting while measuring low flows. This is referred to as Acoustic streaming: If
ambient flow velocities are of the order of potential acoustic streaming velocities, acoustic streaming
may represent a significant source of bias.

· Low flow means low turbulence levels, which may mean clear water. In general, all Velocimeters have
problems measuring in clear water because of lack of scatterers (there is no echo). Experience shows

http://www.nortekgroup.com/software
http://www.nortekgroup.com/software
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that unpumped boreholes are difficult while settling tanks usually have enough scatterers in
suspension.

· Thermal flows can superimposed on the net transport flow. In some case, the parameter of interest is
not really the point velocity but the net transport rates. If the liquid is not thermally balanced (e.g,
daytime heating) thermal convection cells can be generated. This  velocity can be quite strong (several
mm/s) and it can be difficult to detect the lower, net background transport velocity.

3.5.3 Turbulence Measurements

Turbulent flows vary widely, both with distance and with time. Because turbulent flows exist in both large
and small scales, acoustic Doppler systems also come in large- and small-scale versions. Systems
designed for large-scale measurements have divergent acoustic beams that send sound waves outward,
away from the instrument. These systems are not described further in this section, but is covered by the
Signature Manuals. Systems designed for small scales tend to have converging acoustic beams that
focus their sound waves inwardly towards a small sampling volume, just like the Velocimeters.

The ability to describe a turbulent flow in three dimensions (two horizontal directions and one vertical) is
important. The vertical velocity component of turbulent flows is a key contributor to the mixing of different
water masses and the exchange of energy, nutrients and particulates. Therefore, the ability to directly
measure the rapid velocity fluctuations in the vertical direction is critical for high-quality turbulent-flow
measurements. 

There are two things to take into account when selecting an instrument to measure turbulence;

1) Sample quickly enough; In order to measure the rapid velocity fluctuations within these eddies, the
systems must sample quickly enough to resolve the variations. The importance of fast sampling cannot
be overstated. Without sufficient individual (and independent) measurements of the flow, the resulting
data will not contain enough detail to describe the phenomenon.

2) Measurement volume; the scale of your measurement volume must match the scale of the turbulence
that you are studying. The smaller the turbulence spatial scale, the smaller the measurement volume
must be in order to properly describe it. If the scales do not match, you will only capture a portion of the
energy within the flow.

3.5.4 Laboratory environments

Follow these guidelines when you mount your instrument in a lab:

· Make sure that there are no obstructions between the sensor and the focal point (sampling volume).
· When mounting your Vectrino or the Vectrino Profiler, use the recessions to strap it to the structure.

Never use the probe stem as mounting point.
· Consider the effects of large objects on the flow itself. A rough rule of thumb is that objects disturb the

flow as far as 10 diameters away from the object. Flow disturbance is greatest directly downstream in
the wake behind the object.

· All acoustic transducers must be submerged during data collection. Operating your sensor when the
transducers are out of water will not cause any damage, but your data will be meaningless. 

· For side-looking probes, it is possible to collect 2D-data with only the lower receiver arms submerged.
· Make sure your mounting structure is stable. Small vibrations in the mount can generate large

accelerations in the data.
· The best quality is achieved if the main flow direction is perpendicular to the transmit axis. Flow

directly into the transmit axis should be avoided. 
· To align the Vectrino or Vectrino Profiler in a laboratory flume to ensure alignment of the coordinate

system, here are some tips:
o For a quick setup aligning everything by eye works surprisingly well if you have good references to

align against (flume walls are great for this).
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o For a more rigorous setup a post level (two spirit levels mounted orthogonal to one another) can be

used to make sure the mounting fixture and probe are level. This assumes the top of your flume is
level since everything is usually mounted on a cross piece to it. If you have a tilting flume this
method will not work.

o For a non-standard setup where the probe is horizontal instead of vertical or for side looking probes,

a level of any type is needed to make sure the probe head parallel to the flume bottom or very
accurate distance measurements.

o Look at the probe check plot after mounting the probe and filling the flume with water. Tilts in the

head can be identified there based on the return echo from the bottom (as long as the velocimeter
can see the bottom). For example, look at the sharp front of the bottom echo and just make sure all
the beams see it in the same location.

o As far as rotation of the head, if you have a ruler with a wide enough surface, we use a level with

markings on it's top, you can align the upstream and downstream probe pair at the same distance
from one wall. It's also fairly easy to rotate the head once the flume is running and try to minimize
the cross stream and vertical components (if this is how your flow is working).

o For example, use zip-ties to mount the probe head as they will typically allow easier adjustment and

are difficult to over-tighten and cause damage to the probe head. 
o If you do not mind transforming your data, you can develop a minimization routine that will rotate and

apply pitches and rolls to the measured velocities to "level" the head by minimizing the appropriate
components

3.5.5 Wave Measurements

This section is written with Vectors in mind. Before describing each setup parameter for waves, there are
a couple of things to be aware of:

· Keep in mind that the location of the pressure sensor is located where the stem is connected to the
unit. This is the location from which one measures the distance off the bottom. It is later entered as a
parameter for the wave processing. 

· Special consideration must be taken when using a Vector with a cabled transducer array (opposed to
the firmly attached stem type). For the cabled type, it is critical that during deployment the
instrument’s array relative to its body (cylinder) is the same as it is with the Vector with the stem. This
is because the internal tilt sensor determines up or down, and ultimately ensures that the correct
coordinate system is used for the directional estimates.

For more information about waves and wave measurements for the Vector, it is recommended to take a
look in this section: Measuring Waves. More details about wave processing can also be found in the
manual called Comprehensive Manual - ADCP (available in the web site).

Burst Sampling vs Continuous Sampling: Wave data is collected in a mode that is referred to as
Burst. Burst sampling mode takes rapid sampling over a specified time interval. Burst sampling is of
particular use when there is an interest in sampling a specific part of the energy spectra.

Basic Sampling Requirements: Waves are random and therefore measuring waves requires sampling
over a period of time that will best “capture” or represent the complete sea state statistically. The
objective is to measure the wave event over a long enough time so that the random event can be properly
characterized. 

Sampling theory suggests, as a rough rule of thumb that the measurement duration is long enough to
capture a minimum of 100 cycles of an event (waves, in this context). When we measure ocean waves
we have to consider what the longest expected wave period is going to be; 100 cycles of this longest
wave will be the minimum wave burst duration.

Number of samples: This is the number of data samples collected during a wave burst. The optimum
choice for number of samples is used in conjunction with the sampling rate where the total burst length
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in time is considered. As with all measurements there is a trade off between accuracy of the estimates
and the consumption of resources (battery power and memory). The consumption is considerably more
for wave measurements than current profiles.

ÜExample: If waves are to be measured in the Mediterranean sea, we would expect the waves to be 10
seconds or shorter. Therefore 10 seconds x 100 cycles is 1000 seconds. Sampling rate and number of
samples defines the sampling length. A corresponding configuration could be either 1024 samples at 1
Hz or 2048 samples at 2 Hz.

In order to use Nortek developed waves post-processing software the instrument must be set in burst
mode. The number of samples should be set to 1024, 2048, or a number consistent with the chosen
sampling rate to ensure over 15 minutes of data is collected.

Sampling Interval: The sampling interval specifies how often the instrument will collect wave data
ensembles. This should be specified so that changes in the wave climate can be properly detected.
Since wave events are relatively slowly developing events, choosing a relatively long interval make sense.
A Typical interval is every hour but may range from 0.5-3 hours depending on length of deployment time
and available resources (battery and memory).

Sampling Rate: This is the sample rate for the wave data measurements and it applies to the pressure
and velocity measurements. The sample rate represents the absolute upper limit on the resolvable
waves. The upper limit is half the sample rate; this is also known as the Nyquist Limit. 

ÜExample: Waves sampled at 1 Hz can only resolve waves up to 0.5 Hz, and waves sampled at 2 Hz
can only resolve waves as short as 1 Hz. Note that there are other mechanisms, such as deployment
depth, that can have a stronger influence on the frequency limits of resolvable waves.

Choosing the best setting is often used in conjunction with the number of samples. The Vector can
sample at 1, 2, 4, 8 Hz, etc. However, note that if one is only interested in measuring waves then it is
probably not necessary to sample any higher than 2 Hz. Therefore the upper limit for the length of the
data record is 2048 samples. This is due to the fact that the PUV approach can not detect waves much
higher than 1 second in period due to the attenuation effects associated with the deployment depth and
wave frequency.

If the sampling rate is too slow compared to the time variation of the motions, under-sampling is the
result and the data is said to be "aliased" with respect to the wave motion, and the waves cannot be well
resolved.

Velocity Range: It is also suggested to set the nominal velocity to no more than +/- 1.0 m/s; where the
associated horizontal velocity range is 2.1 m/s (the horizontal and vertical ranges are provided in the
Deployment Planning dialogue box). The orbital velocity associated with large waves can reach this
speed in shallow water. This may be adjusted downward if waves are expected to be small, or adjusted
upwards if waves are expected to be exceptionally large.

3.5.6 Near Boundary Measurements

The middle of the sampling volume is positioned approximately 5 cm (or 10 cm on the field probe) below
the transmit transducer located at the center of the probe for the Vectrino. For the Vector it is 15 cm,
and the measurement volume for the Vectrino Profiler spans from  4-7 cm from the probe (user
selectable).

The distance to the boundary shown on the computer display is the distance from the middle of the
sampling volume to the nearest boundary. The sampling volume is of finite extent and the minimum
distance to the boundary that still permits data collection is 4-6 mm for a standard set-up. Some
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experimentation is required because the exact limit depends both on the condition of the boundary as
well as the exact software configuration.

One thing to note when operating in a flume is that the bottom material can have a huge effect on the
data quality. Some tips about what to do in case the bottom material is reflecting too much of the
acoustics is described here: Interference from Highly Reflective Bottoms. 

Side-looking Vectrino probe:
· There is no minimum distance to the bed with the side-looking probe - it can physically be sitting on

the bed.
· Side-looking probes do not often have the problem of "weak spots" since they are usually further away

from a boundary, so they are a little more robust to operate, especially in high flow environments.
· They have higher instrument noise in the vertical than in the horizontal.
· They are well suited for use in wave flumes.
· They have an awful response to flow coming "from behind" the probe.
· If only the two lower beams are submerged: It will work in about 2-cm water at low flow rates and in

this case it will give you just the two horizontal velocity components. 
· When all four beams are covered with water (around 3-4 cm) you can measure all three velocity

components.

High correlations / SNR are not going to be a good indicator of the measurement quality since these will
naturally be high as a result of the reflection. An increase in SNR / correlation as the probe approach the
boundary is likely an indication that you are moving into the interference zone.

3.6 Common Configuration Scenarios

The signal-to-noise ratio (SNR) is very low.
Vector and Vectrino: SNR should be >15 dB
Vectrino Profiler: SNR should be around 30 at the center of the profile and above 20 at the ends, with a
parabolic shape peaking at the sweet spot of 0.05 m range. SNR at ranges greater than 0.06 m will drop
sharply so attention should be paid to this region of the profile if used.

· If low SNR is encountered, try adding scatterers to the water column such as the seeding material
provided with the instrument. Add a little at a time and see if SNR improves.

· If there are enough scatterers in the water, check the Power Level in the Configuration dialog and make
sure it is on high.

· If the Power Level is on High and scatterer concentration is high enough, but SNR is still low, please
contact support for further guidance.

The velocity time series look spiky and correlation is low or varies widely.
Correlation should be very high, not widely scattered. For the Vectrino Profiler: Correlation profiles should
have the same parabolic shape as SNR. Try and achieve correlations greater than 90% throughout the
profile. The highest correlations will be at the sweet spot at a range of 0.05 m, with correlations at ranges
greater than 0.06 m dropping off sharply.

To improve correlation, first make sure SNR is high (see points above). Then, check the Velocity Range
the Configuration dialog. The actual Horizontal range and Vertical range are reported in the configuration
dialog just below where the Velocity Range is set. These need to be appropriate for your flow. If your
velocity range is not what you expected, check which ping algorithm is selected. Reported velocity
ranges will depend on the algorithm. 

An appropriate Velocity Range for a flow will typically produce a Horizontal Range (m/s) and Vertical
Range (m/s) which is larger, but not significantly so, than expected velocities. Horizontal refers to
the X and Y instrument velocity components, Vertical to the instrument Z component. Most users will
want to match the Horizontal Range to flow conditions. If you expect large velocities aligned with the
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Vectrino Profiler's Z velocity component, make sure the reported Vertical Range is large enough. Highly
turbulent flows (e.g. a turbulent jet) will typically need a larger Velocity Range than mean velocities
suggest.

When adjusting the Velocity Range to improve correlation, try moving to a slightly higher value first. In
most circumstances a too large Velocity Range is better than a too small Velocity Range.

The Velocity Range is set appropriately, but there are low correlation regions in the profile.
These are due to pulse interference, also called weak spots, where a past acoustic pulse's boundary
echo is interfering with the current pulse's processing. Weak spots have fairly distinct symptoms. There
will be a region of increased amplitude (and SNR) accompanied by low correlations, while velocities will
be very spiky and noisy. 

For the Vectrino Profiler: The simplest method to deal with weak spots is to use the Adaptive ping
interval algorithm mentioned above. Adjusting the velocity range manually will move the weak spot
around. If the Adaptive ping algorithm cannot eliminate the weak spot, manually adjusting its position to
the least important part of the profile is a good option. Set the Adaptive check: interval to an appropriate
value based on measurement conditions. Over a hard boundary where the Vectrino Profiler position is
fixed Once will work well. In moving probe or boundary measurements, select an interval reflecting
expected time scales for changes in the probe or boundary position.

The Bottom Distance is reporting incorrect values or is noisy (Vectrino Profiler).
In the Bottom Check tab of the configuration dialog:
· If available, a physical measurement with a ruler can confirm the bottom distance measurement.
· If measuring over a rough boundary, be aware the return echo will be fairly complex and the bottom

distance will be subject to increased uncertainty. Alternative methods of determining bottom distance
will be needed.

· Check the Minimum depth (mm): and Maximum depth (mm): values and make sure they span the
expected distance to the bottom. 

· Check the Cell size (mm): and make sure it is also set to the desired resolution. Larger cells will
create coarser estimates in the bottom position.

· If the bottom distance flips between two different values, a second echo is being identified as the
bottom. Check the Center Beam tab in the main window display to see the amplitude profile from the
bottom check ping and look for additional echos at roughly integer multiples of the expected bottom
distance.

· Hard bottoms, in particular metal surfaces, can generate strong echos which overwhelm the receivers
and create a very broad bottom peak. This will increase uncertainty in the bottom location. Set
the Gain reduction (dB) to a value which results in the bottom peak having an amplitude of
approximately -10 dB in the Center Beam tab of the main window display. 

Probe Check data does not look right. One or more of the beams has a higher amplitude.
· All four beams should show roughly the same amplitude and profile shape.
· Check for an obstruction in the beam path. These may be fairly obvious such as a piece of vegetation

or debris. If measuring near objects, such as in the wake of a cylinder, echos from vertical boundaries
may appear in the profiles.

· Multiple echos from the bottom reflecting off the surface can also appear in the Probe Check data.
These will typically be at roughly integer multiples of the actual bottom check distance. Depending on
the acoustic path length, an echo closer than the actual boundary position may result.

· If there are no obstructions and multiple bottom echos have been ruled out, there may be damage to
the probe head. If there are any signs of damage to your instrument, such as a bent receiver arm, a
bent probe stem for rigid probes, a damaged cable for cabled probes, or damage at the bulkhead
connector on either end of the electronics case, please check the Troubleshooting Guide for further
suggestions.
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3.7 Quality Assurance of Velocimeter Data

Tilt (Vector): 
Since there are numerous possibilities for things that can go wrong during a deployment, we need to use
the tilt and heading sensors to qualify if the deployment itself went as planned.

The first step is to make sure that the instrument was oriented as intended. This is done by checking the
time series of the tilt (Roll and Pitch) and heading sensor data:
· Tilt readings between 20° and 30° affect the data accuracy in a way that is likely to make the data fail

to meet the specifications.
· Data acquired during tilts exceeding 30° are in general not reliable and should be discarded.
· If the tilt or heading measurements change greatly from measurement to measurement (buoy

mounted), it is wise to ensure the instrument was configured with a suitable Compass update rate
(check the deployment file or the header file).

Pressure (Vector):
The next step is to check that the pressure sensor is reasonable. In case of a sudden change in
pressure or pressure reading indicating shallower water depth than expected, extra attention should be
shown. These events usually occur during the deployment, retrieval, and the occasional curious mariner.
Data collected during these events should be avoided in the post processing. If the Vector sample
volume is out of the water there is no way to recover velocity data. Data during these periods should fail
most data quality checks since the SNR will fall to (near) zero. 

Velocity:
· Current measurements that show large variations vertically or vertical structures should be flagged

suspicious unless the measurements are taken in an area where this is expected. The ones that are
most doubtful are those that are physically unrealistic (e.g. 1 m/s changes over a short period of time).
The measurements in a time series that are far from the mean are best to be carefully inspected. 

· Raw wave data: The raw pressure signals give an immediate indication about the wave condition; long
waves (T>8 s) give a strong pressure signal and a variation of 1 m in the pressure signal mean that the
wave height is at least the same. On the other hand, a very weak signal in the pressure sensor
(variations of only a few cm) usually means that the waves are small. The raw wave velocities will
appear noisy even at moderate sea states. Only at times with large waves can you expect a smooth
signal. Even so, the noise should not be excessive and it should be possible to see the wave signal
when there are significant wave action on the surface. Watch out for large jumps or discontinuities.

· Vibrations: If velocity spectra show a very large spike at one or more frequencies, it is typically caused
by a vibration in the stem. Wave impact, high flow rates, loose mountings, or vibrations from nearby
equipment will generate vibrations in the probe head. Typical vibrations from instrument mountings will
have a very sharp peak and occur for a very narrow frequency band. The impact on measurements will
depend on what flow parameters are of interest.

Probe Check:
For the Vector: A probe check is made before and after each burst sequence, and also at the very
beginning of the sampling when running Continuous mode. After bin to ASCII conversion it ends up in the
.pck file as explained in the .hdr file. For the others, probe check can be enabled or disabled. The probe
check is designed to act as a measurement quality assurance tool; it lets you inspect the region where
the instrument makes it measurements by showing how the signal varies with range. 

SNR and Correlation:
SNR and correlation are reported in the data file because they are extremely useful when judging data
quality. It is therefore recommended assess overall data quality by looking at SNR and correlation time
series and histograms before attempting to interpret the data. Here are some tips:
· It is important to note that SNR and correlation is tied to a specific beam velocity measurement, not to

an orthogonal coordinate direction such as X, and any screening should take this into account.
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Therefore, we recommend looking at each beam individually when looking at correlation and SNR
rather than an average across two or more beams. Problems can occur in only one beam and
averaging the data across beams may obscure potential problems.

· Check each beam individually. It does occur that just one beam is bad, and this can be indicated by a
signal level near the noise floor, for example. The data may still usable, but if using the Vector one has
to process the data with the two other beams only; a solution that is known as a two-beam
calculation. This will result in 2D currents only (since there is only data from two beams available. Note
that the processing makes one important assumption; the vertical currents are zero. This is a
reasonable assumption in the vast majority of current flow. For the 4-beam systems, one can discard
data from one of the beams and still get 3D velocities out.

· Removing low correlation measurements is a good idea because correlation is a strong indicator of
data quality in the sense of a valid Doppler phase shift determination. 

· Lower correlation means more noise in the data.
· The SNR is calculated by subtracting the noise level in counts from the amplitude levels measured in

counts during velocity measurement, and it tells you the rate of signal over noise. The noise level is
measured at the beginning of each burst (and once at the beginning of continuous measurements). A
rule of thumb is that SNR should be >15 dB. The noise level should be around 50 counts for the
Vector.

· Correlations above ~70% is considered to be generating good quality data. The value of correlation
threshold of 70% is actually fairly stringent and are may be throwing away good data. A close
examination of the dataset is the best way to set a correlation threshold for discarding bad data points.

· Screening data: There is no point using the SNR values to screen data, use the correlation value
instead. When you discard data with a low correlation, you are screening the data with respect to SNR
as well. 

Typical processing tasks: 
1.  Assess data quality (QA/QC)
2.  Data screening
3.  Statistics to describe the flow (mean, variance)
4.  Spectral Analysis (turbulence, waves)

3.8 Common Data Analysis Scenarios

Correlation looked good during data collection, but there are several range cells with poor
correlation
Low correlation in only a few range cells is symptomatic of weak spots. Unfortunately, there is not a way
to correct for this in post processing. Please see the Configuration Guide for how to eliminate weak
spots before recording data.

SNR looked good during data collection, but there are several range cells with much different
SNR (higher or lower)
This is also symptomatic of weak spots or an obstruction (e.g. an object) within the beam. Weak spots
will generally see higher SNR because the strong boundary echo is causing problems, but may be
associated with lower SNR depending on the nature of interference.

A beam obstruction will typically produce a strong echo and high SNR. It may create an acoustic
shadow resulting in low amplitude and SNR in bins behind the object as well.

Weak spots can not be corrected in post processing. Removing biased velocities associated with an
object in the beam is possible by determining which range cells are affected and discarding them from
analysis.

Mean velocity profiles do not look good even though correlation and SNR are high
It is important to assess data quality and perform some basic quality control on a dataset before
attempting to interpret the results. At minimum, discarding very low correlation measurements (<40%,
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adjusted as needed based on data quality) and very low SNR values (<15 dB, again adjusted as needed
based on data quality). An outlier filter to remove data which is statistically different than expectations
will also help improve the quality of a dataset. Histograms can be quite helpful in determining the
effectiveness of any quality control procedures implemented. 

Velocity time series are really spiky
This can be caused by many problems, e.g. weak spots, a too small Velocity Range, low SNR. The
velocity spikes can be removed in post processing using an outlier filter. In this case, a simple hard
threshold discarding velocities, for example > 1 m/s and < 0 m/s, will work.

Velocity changes sign when it should not
This is caused by aliasing in beam velocities when the maximum measurable velocity is exceeded.
Velocities larger than the ambiguity velocity wrap around to the opposite sign.

To avoid this during data collection, the Velocity Range needs to be set larger than the expected
velocities (see Configuration Issues). To aid users in selecting an appropriate Velocity Range,
the Configuration dialog reports the horizontal and vertical velocity ranges.

Correcting phase wraps is possible. It involves identification of wrapped velocities and correcting the
measured velocity using the reported ambiguity velocity. For details on how to unwrap velocities, check
out the relevant section in the Troubleshooting Guide.

Velocity spectra show a very large spike at one or more frequencies
This is typically caused by a vibration in the stem for fixed stem probe heads or the mount a cabled
probe head is attached to. Wave impact, high flow rates, loose mountings, or vibrations from nearby
equipment will generate vibrations in the probe head.

Typical vibrations from instrument mountings will have a very sharp peak and occur for a very narrow
frequency band. Vector fixed stem probes will for example often see a peak around 20 Hz. The impact on
measurements will depend on what flow parameters are of interest.

The Vectrino Profiler software provides real time velocity spectra which can help diagnose and correct
vibrations. The real time spectra are accessed through the Display time series data. Note real time
spectra and imaging can not be used at the same time.
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4 Service Manual
This section covers

ü Tests that can be performed to ensure that the instrument works as expected
ü Verification and calibration procedures
ü Steps to follow if you need to open the instrument for corrective maintenance

It is important to note that when opening the instrument, great care should be taken to keep the sealing
surfaces clean and protected from mechanical damage. Only qualified personnel should perform
corrective maintenance activities. Please use this Service Manual as guidance and contact us for further
assistance.

For Vector users: In this manual, you may encounter a couple of unfamiliar terms: Midlife and Pre-
Midlife. The difference between the two is simply when the instrument was produced; pre-midlife are
instruments produced before 2009. If you are unsure about what version you have, you can check the
firmware version or send us an email with the serial number and we will check it out for you. If your
current firmware version number starts with 0.xx or 1.xx, your instrument is a so-called Pre-Midlife
version. If your current firmware version starts with 2.xx or above, it is a Midlife version.
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4.1 Function Testing

Always test the instrument before a deployment/measurement sequence to verify that it works as
expected. The Final Test Checklist (Appendix A) has been used at the factory for years and is a quick,
but good checklist that can be used as a template for the function testing of your system. Also, make
sure you have the most recent software and firmware installed. The most recent are always available on
our web site.

4.1.1 Initial Test Setup

4.1.1.1 Power

The first step is to make sure the instrument has a source of power. 

Internal batteries (Vector)
The internal battery pack is located inside the pressure case. Nortek alkaline battery packs use 18 AA
cell batteries at a nominal starting voltage of 13.5 VDC. 

Note that the battery pack inside the pressure case is disconnected when sent from Nortek. Refer to the
Changing a battery pack section for instructions on how to connect or change a battery pack. 

The voltage of alkaline batteries falls quickly at the beginning, slowly during most of its life, then again
quickly at the end. Thus, a 13.5 VDC battery pack will spend most of its life somewhere in a voltage
range of 10.5-12.5 VDC. Find more information about the Nortek Batteries at our web site.

The instruments are shipped with an external power supply, which we recommend you use for all but the
final testing. If you leave the instrument collecting data, it will continue to run until the batteries are dead.
Always make sure to stop data collection when testing is complete.

External power
You may supply power with the external supply that is delivered with the system, or you can use your
own external supply. If you use your own supply, be sure the voltage does not exceed the voltage
specification for your instrument. Check out the data sheet for your specific instrument for exact
requirements, which is also available on the web.

Vector power range: DC input 9-15 VDC
Vectrino power range: DC input 12-48 VDC
Vectrino Profiler power range: DC input 12-48 VDC

Vectors: If you want to use an internal battery as a backup battery: The instrument will pick the power
source with the highest V. If using an external supply of 15 VDC and an internal battery of 13.5 V, the
external supply provides a higher voltage than the battery pack, which prevents the internal pack from
discharging. Then, if external power fails, the internal battery pack takes over and sustains operation.

The power and battery lines are diode protected, so you do not have to worry about wiring the instrument
power backwards - this will not damage your instrument.

4.1.1.2 Converter

A compatible converter is included with all instruments. Currently there are two USB converters that are
guaranteed to work with the instruments:

· USB/RS232: the FTDI model US232R
· USB/RS422: Altronix AL310



Service Manual 77

© 2022 Nortek AS

Connect the serial cable to the converter, and insert it into the USB drive of the computer. For first time
use, give the converter enough time to install its driver correctly. If the driver is not installed properly, find
the link to the updated driver version on our website.

4.1.1.3 Connect cables

Plug the appropriate ends into the instrument and to the computer via the converter, and make sure the
computer connector does not easily fall out. 

Before deployment: Protect the cable connector by applying a thin layer of silicone lubricating spray to
the pins before you plug it into the instrument. We recommend the 3M Silicone Spray. Grease is not
recommended. For Vector users: Remember to protect unused connectors with dummy plugs (relevant
for Vectors). For more information about how to protect the connectors, check out the Connector Care
section.

Cable Wiring
See tables describing the pin assignments for the wires and connectors in the Cables and Wires
section. If you have a special cable, contact Support to get the correct information.

4.1.1.4 Start the appropriate software

Find the instrument specific software on the USB stick that came with the instrument, or download it
from our Software and Firmware site (www.nortekgroup.com/software), and install in on your PC. Nortek
Windows programs run on all versions since XP (SP3), including Windows 8.

Installing instrument software does not require a license key. After installation is done, start the software
and proceed with the following:

1. Select Serial Port from the Communication menu to specify the port number to use. If you are unsure
about which port number to use, check the Device Manager on your computer.

2. Baud rate: You are allowed to set two baud rates. The primary baud rate setting applies to normal
communication and data transfer. The standard baud rate is:
2.1. For the standard Vectrino program, the default baud rate is 19200. 
2.2. For Vectrino Plus, the default baud rate is 57600.
2.3. For the Vector, the default is 9600.
2.4.For the Vectrino Profiler, 937500 is recommended

and we recommend that you use this baud rate unless you have a good reason to change it. 
You can also set a separate baud rate for data download and firmware upgrades (the
"download/configuration baud rate"). A higher baud rate speeds up large file transfers and is appropriate
when you have a short serial cable and a relatively noise-free environment. To change the baud rate and
make it permanent, do the following:

2.5.Connect the instrument to your computer.
2.6.Set the baud rate in "Communication", "Serial Port" to the baud rate you prefer. Start a

deployment, and then stop it. The last step makes the new baud rate permanent. If you remove
power and reapply it, the instrument will re-awake with the new baud rate. NOTE: If data download
is interrupted, the instrument may be left with a baud rate setting other than the one used for
normal communication. When the software tries to establish communication in such cases, it
may spend a few moments searching for the current baud rate.

3. Check communication: Verify communication by clicking the “Check Communication” button. The
software will automatically find the instrument and read its current setup parameters. Alternatively,
select Communication > Terminal Emulator, and press "Send Break". The instrument should respond
with a message presenting information about the model of your instrument plus the firmware version
number and the mode the instrument is in. If you get a string of garbage characters, try another baud
rate setting. If the instrument fails to respond, the software can auto-connect to the instrument. Press
Stop Data Collection and wait until the instrument has been found.
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4.1.2 Sensor Checks

The first step when performing sensor checks is to set the instrument to collect data continuously. Find
the Deployment planning dialog by clicking Deployment > Planning or the corresponding toolbar button.

Start the test deployment by clicking On-line -> Start Data Collection or click the Start Data Collection
toolbar button.

4.1.2.1 Temperature

Test the temperature sensor by confirming that the temperature reading is realistic. The temperature
reading should be close to the room temperature, assuming the instrument has been in the room for a
while to allow for the long time constant.  

Specifications:
· Range: -4°C to 40°C
· Accuracy/Resolution: 0.1°C/0.01°C
· Time response: 10 min for the Vector, 5 min for the Vectrino and Vectrino Profiler

4.1.2.2 Tilt or IMU (Vector)

The tilt sensor is located on the electronic boards inside the housing. The tilt sensor orientation is set in
accordance with the system orientation during normal operation. 

The standard instrument is designed for vertical orientation. That means that you should make sure the
Vector canister is in an upright position. The tilt sensor detects up/down orientation - that means that
you can use the Vector pointing up or down and the instrument will know.

Figure: Vector cable probe and fixed

stem with vertical tilt sensors in upright

position.

Tilt sensors in probes designed for horizontal orientations will be mounted at right angles.

Figure: Vector cable probe and

fixed stem with horizontal tilt

sensor.

Uncertain about whether your Vector is with vertical or horizontal tilt? 
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If the tilt (pitch and/or roll) as indicated in the Sensors’ pane is unrealistically far from 0° when the
canister on a table (upright or lying down), the Vector is of the other type.

Verifying tilt sensor:

1)  Click the Sensors tab on the main screen of the software.
2)  Hold the instrument as level as possible to check that the tilt reading is close to zero.
3)  Find the X-marking on the probe (which defines beam 1) or canister (on cable probe system) and let

X point away from you.
4)  Tilt the instrument to about 10 degrees to the right, and verify that the roll reading has a positive sign,

and that the value is around 10 degrees.
5)  Tilt the instrument to about 10 degrees to the left, and verify that the roll reading has a negative sign,

and that the value is around 10 degrees.
6)  Tilt the instrument about 10 degrees forward, and verify that the pitch reading has a negative sign,

and that the value is around 10 degrees.
7)  Tilt the instrument about 10 degrees backward, and verify that the pitch reading has a positive sign,

and that the value is around 10 degrees.
8)  Turn the instrument upside down, and perform steps 2-7 again. Note that the signs will still be the

same, assuming that X is still pointing away from you.

Figure: Pitch and Roll definitions

Also confirm that the last status bit changes from 0 to 1 when the probe orientation is changed from
pointing down (as the figure above) to pointing up. For the Vector the instrument is defined to be in the
UP orientation when the communication cable end of the canister is on the top of the canister, i.e. when
the probe is pointing down (as in the figure above). Be aware that when the Vector is running in
Continuous mode, the Vector needs to be oriented in the correct orientation when starting it – up/down
orientation will not be updated while measuring. When the Vector is running in Burst mode, the
orientation is checked/updated at the beginning and end of each burst.

Specifications:
· Accuracy/Resolution: 0.2°/0.1°
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4.1.2.3 Compass (Vector)

The compass measures the earth's magnetic field. Combined with the tilt sensor on the head, the
compass enables the instrument to obtain heading information. These data makes it possible to convert
velocity measurements to Earth coordinates. Without a compass, the instrument still measures the tilt.

To test the compass: 
· Hold the instrument away from any magnetic influence (like metal objects, cell phones etc.)
· Point X towards North
· Slowly rotate it clockwise around Z, and verify that the compass reports increasing degrees (0, 90,

180, 270 and then 360/0 - corresponding to North, East, South and West respectively)
· Click Stop Data Collection, invert instrument, click Start Data Collection and repeat the procedure.

Figure: Rotate

the instrument

to verofy

compass

functionality.

Clockwise is

positive

Remember to perform a Compass Calibration before deployment, to account for magnetic interference
near the instrument.

4.1.2.4 Pressure (Vector)

To test the pressure sensor:

1)  Set the pressure sensor depth to 0.2 m in the On-line > Set Pressure Offset dialog.
2)  Place the instrument in a suitable container filled with water (approximately 0.5 m deep)
3)  Verify that the pressure reading is correct; with the instrument submerged to 0.5 m, and with an

offset of 0.2 m, the pressure sensor should read 0.7 m.

An alternative way to test whether the sensor is functioning is by forming a seal around the sensor with
your mouth and blowing to observe an increase in pressure.

Have in mind that the pressure sensor is not a depth meter. Due to atmospheric pressure variations, the
sensor signal may have an offset. Therefore, remember to set a Pressure offset before every deployment.

4.1.3 Noise floor

First, check the noise level of the instrument. See the readings in the software, under the Current tab.
Pinging in air should produce signal strengths (amplitudes) of:

· 45 - 55 counts for Vector
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· 10 - 15 counts for the Vectrino
· -65 - -60 dB for the Vectrino Profiler

When the instrument pings in air, the velocity measurements will nothing but noise. The signal
(amplitude) values above are therefore referred to as the noise floors. Data from all beams should show a
similar noise floor. Note: Background noise is very prone to interference from nearby sources, such as a
power supply. During testing make sure the instrument is far enough away from other electronics. 

Put the instrument in a bucket of water and observe the signal strength and the velocity. The signal
strength should rise noticeably (the actual level depends on the size, shape and material of the bucket),
and the velocity data should appear less noisy. If the velocity graphs remain weak even with the probe in
water, try varying the position of the probe or add some seeding to the water in the form of dirt or small
particles.

Deep Water versions (titanium housings) of the Vectors are prone to noise in human environments, so
you may see a higher noise floor than the above listed. This will not be a problem in the field/in water.

4.1.4 Beam Amplitude and Velocity Checks

The following checks should be carried out in a suitable volume of unobstructed water. We recommend
carrying out initial testing in a test tank, which is both convenient and provides a controlled environment.
If there are insufficient scatters in the water, some seeding material may be necessary.

4.1.4.1 Amplitude

1) Change the coordinate system to beam Coordinates by choosing BEAM as Coordinate system in the
Deployment Planning menu. 

2) Start the test deployment by clicking Online > Start Data Collection or click the corresponding
toolbar button. 

3) Click the Amplitude tab (bottom of display) to observe the amplitude of all the beams on the graphic
display.

4) Immerse the instrument so that all the transducers are submerged. Note the amplitude of each beam,
displayed in counts. All the beams should have similar amplitude, within 10 counts of each other. 

As an additional check, each beam can be blocked in turn, by either holding each transducer out of the
water (while keeping the others immersed) or by covering each transducer with a suitable acoustic
attenuating material such as dense plastic, or even a finger. The amplitude of the blocked beam will fall
to around the noise level, while the others will remain unaffected.

When blocking the transmitter, the receivers should report nothing other than noise.

4.1.4.2 Velocity

1) Change the coordinate system to XYZ by selecting XYZ as Coordinate system in the Advanced
Deployment Planning menu. 

2) Start the test deployment by clicking Online > Start Data Collection or click the corresponding menu
button. 

3) Click the Velocity tab to observe the X, Y and Z velocities on the graphic display.  
4) Move the instrument backwards and forwards at a constant velocity through the water, along the X-

axis. A positive and negative deflection of the X-axis velocity should be observed on the graphic
display, while the Y- and Z-axis velocities should remain around 0 m/s. Repeat the procedure for the
Y- and Z-axis. Ensure that the displayed velocities are reasonable.

Read more about coordinate systems in the Principles of Operation, where you will find Beam, XYZ, and
ENU definitions. Note that the X-axis engraved or clarified in form of a colored indicator on the head/probe
of the instrument always points in the direction of beam 1 and a positive X-axis.
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Figure: Vector definitions of X-axis. Note the red (or on some versions Black) label on the X-arm of the

Vector. 

4.1.4.3 Probe Check

Designed to act as a measurement quality assurance tool, the Probe Check function in the software lets
you inspect the region where the instrument makes its measurements by showing how the signal varies
with range. You can use it to diagnose and correct problems and to optimize data collection. To start the
Probe Check:

1)  Make sure the instrument is submerged in water. 
2)  Click Online > Start Probe Check. For the Vectrino Profiler, enable the check in the "System" tab.
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Figure: The probe check function shows how the signal varies w ith range. The three colored graphs

correspond to each of the three vector receive beams. A is the transmit pulse. B is the area around the

measurement volume. C is a bottom echo. Graphs are scaled in mm distance from the transmit transducer,

parallel to the transmit beam.

The actual sensing volume is a relatively narrow region within the broad peak indicated by B. It is for the
Vector centered at sample 100-105 and normally extends across +/- 3 counts from the center. If the
probe check outputs look very different from the figure above, check the Troubleshooting Guide before
taking further action. You can find probe checks that display and describe different problems in the Probe
Check section. 

4.1.5 Test Recorder Function (Vector)

You can test the recorder with the same set-up as above.

1)  Start data collection with "Test" followed by "Start With Recorder".
2)  Write a name to use for the file you will record internally.
3)  After a few minutes, stop the data collection.
4)  Retrieve your data by clicking "Deployment" followed by "Recorder Data Retrieval".
5)  Convert it to ASCII by clicking "Deployment" followed by "Data Conversion".
6)  Review the collected data with an ASCII text editor (i.e. Notepad).

If you leave the instrument collecting data, it will continue to run until the batteries are dead. Always
make sure to stop data collection when testing is complete. 

It is a good routine always to start a new deployment with an Empty Memory. Before you erase the
recorder, make sure that you have transferred all the data you want to retain to your computer and that
the data is in good shape. Then click Deployment > Erase Recorder.

Note: The maximum number of files that can be stored in the File Allocation Table (FAT) is 31 on all
Nortek instruments. The "Syslog" takes one spot, so the maximum number of files with measurements
is 30.
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4.1.6 Battery degaussing

All fasteners and hardware are non-magnetic and the magnetic signature of the internal electric
components is low. The exception is the alkaline battery pack. Therefore, the batteries are degaussed
before sending them, and also recommend the user to degauss the batteries before using them.

The calibration routine will compensate for magnetic masses whose field strength, and orientation relative
to the compass, do not change. So this covers the battery also. If the field produced by a magnetic
source close to the compass changes significantly over the course of the deployment, heading errors
may be the result. 

There is no need to degauss Lithium batteries.

4.2 Customer Calibration

All instruments have what we call head matrices that are unique; it describes the geometry of the sensor
probe, or the transducer orientation to be more specific. The matrices are computed during the velocity
calibration done during production. As long as the sensor probe are not physically deformed, the head
matrices will, consequently, remain the same. Further, what is measured by the sensor is the change in
frequency from the acoustic pulses sent out through the water to those being reflected back. In other
words, a slight change in center frequency will not affect the measured frequency shift, or the Doppler
shift, which is entirely depending on the velocity of particles in the water. Therefore the sensors never
need to be re-calibrated for current speed and direction, unless they are physically deformed.

4.2.1 Compass Calibration (Vector)

Each compass has been calibrated at the factory to quantify the characteristic response of the individual
components and of the system as a whole. When it leaves the factory, each system can measure its tilt
and the direction of its magnetic field vector accurately, anywhere in the world. However, users disturb
the magnetic field near the instrument when they deploy. Adding a battery pack and mounting the
instrument with deployment hardware adds magnetic materials that change the magnetic field measured
by the instrument. The compass calibration procedure quantifies this magnetic disturbance, and the
instrument's compass algorithm then corrects for it to obtain accurate heading. 

The user should perform a compass calibration just prior to deployment to correct for the introduction of
new magnetic materials. The compass calibration procedure requires a single, slow rotation around the
instrument's tilt axis. A rotation taking at least 60 seconds is sufficient. For the calibration procedure to
work, the compass and all magnetic materials must remain fixed relative to each other. As long as this
is the case, the calibration procedure can correct for magnetic field disturbances that are greater than
the earth's magnetic field. 

What we try to do with this calibration is to make a calculation matrix such that the result of the rotation
around the z-axis gives a round circle around the origin. If we are successful in this the instrument
experience the same magnetic field regardless of where it is pointing.

You should conduct this procedure outdoors, away from other possible magnetic elements that will not
be part of the mounting structure during deployment.

The procedure:
1) Assemble the frame (or similar) with the instrument, battery canister, and extra ballast, etc. and

connect the system to the computer.
2) Make sure the frame is level when calibrating the compass, and that it is possible to rotate the entire

system 360° horizontally.
3) Click On-line > Compass Calibration.
4) Click Start and rotate the entire system slowly around the Z-axis of the instrument. An example of a

successful rotation is shown below. Note that when doing this in the field, you cannot expect to end
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up with a circle as perfect as this one. However, we recommend you to do this slowly in an attempt
to come as close to the ideal circle as possible.

5) To utilize the obtained values, click Done. You will be prompted to confirm that the new values shall
be transferred to the instrument to serve as the new compass setting.

Figure: Successful rotation of a compass calibration.

Details about the offsets in the figure above:
· dX - is the offset in the x-axis which we subtract when calculating the heading
· dY - is the offset in the y-axis which we subtract when calculating the heading
· K[1,1] - Scaling factor for the x-axis to make Xmax-Xmin equal to Ymax-Ymin
· K[2,2] - Scaling factor for the y-axis to make Xmax-Xmin equal to Ymax-Ymin
· Heading - the orientation of the instruments x-axis 0 deg corresponds to north
· Pitch and roll - the instruments angles from the horizontal plane

As a side note, the compass is not used when measuring velocity in XYZ or beam coordinates, but if you
plan on using the compass heading at a later point (for instance to orient the XYZ velocities relative to the
lake axes), it is probably worth calibrating the compass in advance.

4.2.2 Set Pressure Offset (Vector)

The pressure sensor offset is not calibrated to, nor corrected by the atmospheric pressure. This means
that the pressure sensor reading will follow the atmospheric pressure, thus the sensor signal may have
an offset. Atmospheric changes can vary the depth reading as much as 0.3 m. Note that all data on the
recorder will be erased during this procedure, so this needs to be done prior to deploying the instrument.

To set the Pressure Offset:
1)  Connect the instrument to a computer and submerge the instrument to a known depth.
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2)  Click Online > Set Pressure Offset and key in the depth in m. The below figure shows the dialogue
box for setting the pressure offset. 

3)  When the pressure has a stable reading, as in the screenshot below, click Done.

Figure: Set Pressure Offset dialog

Figure: Stable pressure reading and the title indicates

success .
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4.3 Working Inside an Instrument

When opening the instrument, great care should be taken to keep the sealing surfaces clean and
protected from mechanical damage. 

4.3.1 Changing a Battery Pack (Vector)

The following procedure outlines how to connect the battery or to install a new battery. A fresh desiccant
bag should be included in the pressure case, as humid air can condense enough water do damage the
electrical circuitry. 

A. Remove the four #6-32 x ¾’’ titanium screws and washers holding the
end cap to the pressure case and remove the endbell.

B. Disconnect the 2-pin connector and pull the battery out of the pressure
case.

C: Insert the new battery into the pressure case and reattach the 2-pin
connector.

D: Reattach the endbell to the pressure case and mount with four titanium
bolts and washers. Make sure that there are no dust or particles on the O-
rings on the endbell, and that they are whole. Also, be careful so that the
internal wires are not squeezed between the endbell and the housing. See
Recommended torque when securing screws - you do not need to fasten
them too much if you have the POM housing

E: Test the instrument by collecting data without using an external power
source to ensure that the battery is properly connected. Make sure to stop
data collection so that the instrument will power down after you are through
testing it.

Because the battery pack uses standard alkaline batteries, you normally do not need to observe any
special precautions and/or procedures when you dispose old batteries. Caution! If you have lithium
batteries, keep in mind that you must be very careful and that disposal requires special precautions
and/or procedures. Rules for disposal of batteries, especially lithium batteries, vary from country to
country.

4.3.2 Accessing the Circuit Board (Vector)

The following procedure describes how to access the circuit board, necessary tools can be found in the
supplied toolkit. 

A. Remove the four #6-32 x ¾” titanium screws and washers holding the
end cap to the pressure case.

B. Disconnect the 2-pin (battery) and 9-pin (harness) connectors
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C. Pull the battery out of the pressure case.

D. Remove the #6-32 x ¾” titanium screws and washers holding the
probe head to the pressure case.

E. Carefully, slide out the probe with the circuit board attached. Do not
put a lot of pressure on the probe itself, as the connection between the
sensor head and head board represent the weakest point. Pull/push the
main board instead.

When reassembling the system, the following is important:
· Make sure that there are no dust or particles on the O-rings on the head or the endbell, and that they

are whole.
· A fresh desiccant bag should be included in the pressure case, as humid air can condense enough

water do damage the electrical circuitry. 
· Be careful when sliding the circuit board into the pressure housing; it is easy to make scratches, and

these scratches may cause instrument leakage.
· Attach the probe to the housing with the titanium bolts. Make sure the bolts have both a spring washer

and a flat washer.
· Insert and connect the battery, and attach the endbell. Make sure that also these bolts have both a

spring washer and a flat washer. 
· Read also about Recommended Torque for securing screws.

4.3.3 Installing a Memory Board (Vector)

When ordering a memory upgrade from Nortek you will receive the following:

1. Recorder / ProLog

2. Screws / Bolts

3. Standoffs

4. Nuts

5. Lock Washers

To install it, follow the procedure as described below

A. Access the circuit board.
B. Loosen the four (relatively short) screws and remove the compass
board from the main board

C. Insert the four long screws (2) through the holes in the corners of the
compass board, and then through four standoffs (3). Carefully insert the
screws through the holes on the main board, and then through four more
standoffs. Make sure the connector between the compass board and the
main board ‘Clicks’.
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D. Carefully position the Recorder board (1) (image to the right) and fit it
gently to the matching connector on the main board (image to the left). 

E. Secure the assembly with lock washers (5) and nuts (4).

G. After reassembling the instrument, erase the recorder, and check that
the system reads the correct recorder size.

4.3.3.1 Installing a Memory Board - Pre-midlife (Vector)

When ordering a memory upgrade from Nortek you will receive the following:

1. Long nylon screws

2. Mounting blocks 

3. Short nylon screws 

4. Nylon nuts

5. Threaded metal bolt 

6. Nylon standoffs

7. Recorder board

A. Start with accessing the circuit board (Section 1.3.2).

B. To remove the compass board, start removing all screws and blocks with
the exception of the right mounting block on the main board, as shown in the
image. The point is to add two new mounting blocks (2) as support for the
recorder board.  

C. Screw the metal bolt (5) through the mounting block (2) in the correct hole
(indicated in the image).

D. Screw the two blocks from (C) through the holes in the main board and
through another mounting block on the opposite side of the board (both new
blocks is to be placed on the same side of the main board). NOTE that the
block on the ‘compass’ side of the card sticks out over the edge of the board,
whereas the block on the ‘recorder’ side do not. 

Please note the positions of the various holes in the mounting blocks: Make
sure that the twin holes are positioned ‘away’ from the center of the main
board. It is essential that they are positioned correctly. 
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E. Insert the two long nylon screws (1) through two of the holes in the
compass board, then through the nylon standoffs (6). Continue with carefully
inserting the screws through the two holes (at the opposite side of the
mounting blocks) on the main board. Attach two more standoffs, and carefully
position the recorder. Make sure the connector between the main board and
the recorder board ‘clicks’. Apply a little LocTite to all plastic screws.

F. Fix the recorder and the compass boards to the mounting blocks with the
short nylon screws (3). Apply a little LocTite to all plastic screws. Cut off
excessive length on the long nylon screws.

G. Connect the compass and the main board with a connector (see image in
point E, to the upper right)

H. After reassembling the instrument, erase the recorder and check that the
system reads the correct recorder size (Section 1.5.3).

4.3.3.2 Installing a Memory Board With Cable - Really Old Paradopps

Some of the older systems will not fit the connector between the main board and the recorder, and thus
need an additional cable. The recorder board looks a little different, but it is essentially the same process
as described above. Two steps are added:

C(2).  Attach the cable to the main board before fixing the recorder to the main
board.

C(3)  Attach and bend the cable as shown, to avoid cable getting caught while
inserting the instrument into the housing.

4.3.4 Installing a DC/DC (Vector)

When installed in an instrument, a DC/DC converter is used to downconvert the supply voltage to 15 V. 

To install one; open the instrument just as you would when replacing a battery pack (Changing a Battery
Pack). The DC/DC takes the place of one 50Wh battery pack

A. Remove the endbell and remove the batteries (if relevant)

B. Connect the DC/DC harnesses to the instrument harness. There is
only one of the two Molex connectors pictured that will fit. 

C. Slide the DCDC carefully into the canister

D. Connect the second Molex connector to the endbell

E. Reattach the endbell to the pressure case and mount with four titanium
bolts and washers. Make sure that there are no dust or particles on the O-
rings on the endbell, and that they are whole. See Recommended torque
when securing screws - you do not need to fasten them too much

F. Check that it is working. Take note of the voltage
limitations/requirements of your updated system!
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4.3.5 Installing IMU sensor (Vector)

When ordering an IMU upgrade from Nortek you will receive the a small electronics board that needs to
be mounted on the main PCB. It will physically replace the existing compass board

A. Access the circuit board

B. Loosen the four screws and remove the compass board from the main board

C. Re-use the four screws and the standoffs

D. Place the IMU board on the standoffs, and secure with the nuts.

E. Check that the connection cable between the board and the IMU is properly fixed

F. Update the Headfile for the instrument

G. Update the firmware of the instrument

H. Update the software version

I. Test the instrument

4.3.6 Changing the Wiring Harness (Vector)

You will find the necessary tools in the toolkit that came with the instrument; 7/64” and 1/16” hex driver
and silicone grease. Use LocTite as described below, if accessible.

A. Access the circuit board
B. Unscrew the two screws that hold the harness in place

C. Press the little tap on the connector, and pull the harness off.

 
D. Attach the connector of the new harness.

E. Align the mounting blocks at the round disk with the holes on the main board.
Add a little LocTite and fasten.
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F. Add a thin layer of silicone grease on the harness’ O-ring.

G. Carefully insert the system back into the housing.

4.3.7 Changing the Output Power for Auxiliary Sensors (Vector)

You can change the output voltage level that is supplied to external sensors. This is typically needed if
an external analog sensor (e.g. OBS) operates in a specific voltage range and the raw battery power
does not fall within this range. The default output voltage level is RAW (battery or external adapter).

4.3.7.1 Midlife Electronics

Midlife electronics change the power levels with a simple command in the terminal emulator:

Voltage level Command Max current

RAW OPWRBA 500 mA

+5V OPWR5V 250 mA

+12V OPWR12 100 mA

4.3.7.2 Pre-midlife Electronics

You can change the output voltage level that is supplied to external sensors. This is typically needed if
an external analog sensor (e.g. OBS) operates in a specific voltage range and the raw battery power
does not fall within this range. The default output voltage level is RAW (battery or external adapter). This
can be changed to +5V or to +12V by changing the position of a 0-W resistor.  The three resistor
positions share one pad so the modification should be straightforward.

Voltage level Resistor position Max current

RAW R270 (default) 500 mA

+5V R268 200 mA

+12V R269 50 mA
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4.4 Changing a Probe

Vector:

The following procedure outlines how to change a probe. You will find the necessary tools in the toolkit
that came with the instrument; 7/64” and 1/16” hex driver and silicone grease. Note that the procedure for
changing a transducer head also includes updating the instrument’s head configuration file.

A. Start with the procedure described in Accessing the Circuit Board 

If you are working with a pre-midlife Vector; remove the two bags of Desiccant taped
around the board and gently disconnect the ground strap on the reverse side of the
board.

B. Unscrew the two screws fixing the main board to the head board, and pull the probe
away from the board.

C. Use the same screws to attach the new probe to the main board. Remember to put
on new O-rings with silicone grease (See section Connector Care for more) on the
probe head. Be careful not to squeeze the cables attached the head board between the
main and the head board when connecting them.

D. Reassemble the instrument.

E. Load a new headfile into the instrument as described in Replacing Heads/Boards

F. Set pressure offset

After changing a Vector probe, it is a good idea to run a simple function test before deploying. 

Vectrino and Vectrino Profiler:

Swapping probes on the Vectrino/Vectrino Profiler platform is pretty easy, as all probe configuration
information is located on the electronics fixed to the probe. A few things to note:

· The trickiest part is to connect the connector on the head board onto the main electronics. Aligning
them and position the probe carefully is our best advice. Twisting the probe slightly will reveal whether
the connection was successful or not.

· If the O-ring seal has fastened, a small (careful) side-to-side rocking is needed.
· The bolt patterns will make sure that there is only one way for the new probe to be attached. Once the

probe is seated, do not over-tighten the bolts.
· Run a probe check to confirm that everything works as intended. A firmware upgrade is not necessary

when replacing probes.
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· A firmware upgrade is not needed when replacing probes. The calibration information used to convert
from beam coordinates to XYZ is stored in the probe electronics. When the Vectrino/Vectrino Profiler
firmware starts up, it reads this information directly from the probe, so you do not have to worry about
changing anything from the firmware point of view after the probe head has been changed.

· Swapping from a lab probe to a field probe requires nothing extra than the simple swap.
· Swapping probes between a Vectrino and a Vectrino Profiler is not possible.

4.5 Upgrade Firmware

By the term firmware we are referring to the internal software of the instrument, as opposed to the
instrument software running on a PC. When you purchase a brand new instrument, it has a firmware
version matching the PC software, hence no firmware upgrade will be needed before you start using the
instrument. However, new functionality (and in rare cases bug fixes) is likely to be offered in the future,
requiring that the firmware is upgraded. New firmware is posted at the Nortek web. You will need to
register to get access, but access is quick and free of charge. 

Remember to transfer data that you would like to retain to your PC before you upgrade the firmware, any
data acquired in the instrument will be erased to avoid inconsistencies. 

To do the Upgrade:
· Download the firmware that applies to your instrument.
· Connect the instrument to a PC.
· In the instrument software, select Configuration > Firmware Upgrade… 
· Browse and select the new firmware file and click ‘Open’.

If you are asked for a license key, you can find it on the flash disk that accompanied your instrument. If
you cannot locate it, contact Nortek for a new key.

Upgrade to Vectrino Plus (Vectrino only):
The Vectrino Plus firmware is protected by a license key. So the first step is to contact the local Nortek
representative to get hold of a license key.

Next:
· Download the Vectrino Plus firmware from the web site.
· Connect the instrument to a PC.
· In the Vectrino Plus software, select Configuration > Firmware Upgrade… 
· Browse and select the new firmware file and click ‘Open’.
· Add the license key when prompted.
· Check that the Plus version is reported in the "Firmware" display in the software.

4.6 Erase Recorder (Vector)

· Connect the instrument to a PC.
· In the instrument software, select Deployment -> Erase Recorder. 

Recorder wear may occur when a large number of write/erase operations are issued. The exact number
may vary between instruments but is specified to 10,000 files. This means if the recorder is erased each
time then 10,000 deployments can be done before having to replace the recorder.

The flash circuit on the main PCB is closely linked to the recorder. Read more about that here.

4.7 Update Headfile (Vector)

Most of the sensors in a Nortek instrument have to be calibrated to keep the specified accuracy. This
and the fact that we offer flexibility in probe geometry, deployment orientation and external output/inputs
make it necessary to store a number of parameters to make the instrument perform as intended. All of
this is stored in the headfile. It is actually misguiding to call it a headfile; it has parameters that are
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dependent of the instruments electronics as well. We make the file when producing the instrument, and
it is saved in the respective instrument (we also keep a copy at Nortek). 

Here is a list of the calibration parameters that are stored in the headfile.
§ Serial no.
§ Pressure sensor calibration data
§ Tilt sensor calibration data
§ Beam to XYZ transformation matrix (conversion between the coordinate systems)
§ The transducer frequency
§ No. of beams
§ Tilt sensor orientation
§ Compass alignment data
§ Temperature sensor calibration data
§ Compass calibration data
The last two are dependent of the instruments electronics - not the probe head.

The head configuration file is sent from us to you upon request. When you have received the .bin file,
proceed with the following:
· Connect the instrument to a PC.
· In the instrument software, select Configuration > Sensor head.
· Browse and select the new headfile and click ‘Open’.

When the head file is configured, it is important to:
· Set the pressure offset
· Level the instrument and confirm the tilt reading

The probe configuration file must be updated whenever the probe has been replaced. 

In certain troubleshooting situations Nortek Support may ask you to download your current head file. To
do so follow these steps:

· Connect the instrument to the PC and start instrument software.
· In the Terminal Emulator click Log File and give the file a descriptive name.
· Type GH, which is short for Get Headfile, and Send.
· Stop logging the file.
· You have now captured the data necessary for a head file. 
· Remove the last two binary characters (06 06 which is acknowledge).
· Save the file as a *.bin.

4.8 Mechanical Aspects and Maintenance

Preventive maintenance is your primary tool to keep your instrument in shape and ready for action and
deployment. We recommend a regularly scheduled procedure which will act as a preventative measure to
ensure your instrument continues functioning as intended. The following sections can be used as a
maintenance guideline for the components that may be exposed to wear and tear.

Only qualified personnel are allowed to perform corrective maintenance activities. Please contact Nortek
for further assistance if any doubt.

4.8.1 Mechanical Tolerances

Watertight sealing of the instrument housing is provided by double O-rings on the head and endbell sub-
assemblies. The outer O-ring forms the primary seal and the inner forms a secondary (or backup) seal.
When opening the instrument, great care should be taken to keep the sealing surfaces clean and
protected from mechanical damage. Keep water out of the open pressure case. Both fresh and salt water
can corrode the circuitry.
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If the instrument has been subjected to environmental conditions outside the specified design limits,
mechanical tolerances may be affected. 

4.8.2 Instrument Care

The Nortek instruments are intended for use in water. Other fluids may have an adverse effect on the
plastic materials used. If using the Vectrino/Vectrino Profiler lab probes in saline water, it is
recommended to keep the deployment time short and to clean the probe with clean water after the
deployment. The material used on the probe is Stainless steal, but we have seen signs of corrosion on
probes used in saline water and would therefore emphasize that this is not a usage that the
Vectrino/Vectrino Profiler probe has been designed for. Using the field probe is the recommended
solution.

For prolonged storage at elevated temperatures close to or at the specified limit, or when temperature
control is uncertain, it is recommended that the screws securing the end caps to be loosened in order to
minimize the risk of any deformation due to temperature/stress condition over time.

Do not use the molded head or endbell as a clamping surface, always clamp to the instrument housing.

4.8.3 Recommended Torque for Securing Screws

When installing end caps and sensor heads, care should be taken when tightening the screws.
1. Just a little tension on the screw is needed. 
2. When the O-ring starts to be compressed, turn each screw a little at a time until the O-ring is fully

compressed. 
3. Tighten the screws diagonally. Tightening one screw fully before continuing on to the next may cause

improper O-ring seating and very high mechanical stress concentrated around the screw hole. This
may cause leaks and/or damage to the head or the endbell. 

4. The screws only need to be tightened sufficiently for the O-ring and spring washers to be fully
compressed.

Figure: a) "Two-fingers" tightening of screws. Indicator arrow shows position before final tightening. b) Final

tightening 30-45 degrees from "two-fingers" tightening.

Over-torquing has no positive effect and may damage the threads and/or area around the screw holes on
the head and endbell. Keep in mind that ocean pressure holds the end cap tightly – all the screws have
to do is to keep the end cap from falling out when the system is above water.

4.8.4 Connector Care

It is extremely important to keep underwater connectors clean and well lubricated. We recommend
before plugging in connectors, always blast the pins with compressed air, inspect them for cleanliness
and then lubricate with 3M Silicone Spray. Do not use the silicone grease included in the toolkit on
connectors, as this is intended for O-rings only.

Before deployment: 

· Demate the connector set.
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· Flush the connector set with fresh water or compressed air, remove dirt.
· Inspect for damage, corrosion and cuts.
· Apply a thin film of 3M Silicone Spray or equivalent.
· Mate the connector halves and check if they are properly mated. 

After deployment, before storage:

· Flush the connector set with fresh water or compressed air, remove dirt.
· Inspect for damage, corrosion and cuts.
· Mate with dummy plug if available.

4.8.5 Cable Care

· Avoid nicks and cuts around connector points, as these are the sealing surfaces.
· Elastomers can be seriously degraded if exposed to direct sunlight or high ozone levels for extended

periods.
· Do not pull on the cable to disconnect connectors, pull the connector itself.
· Avoid sharp bends at cable entry to connector.
· Ensure that the cable is fixed to the mounting fixture to avoid mechanical stress to the connection.

4.8.6 O-ring Care

Watertight sealing of the instrument housing is provided by double O-rings on the head and end cap sub-
assemblies. The outer O-ring forms the primary seal and the inner forms a secondary (or backup) seal. If
the integrity of the O-rings are degraded the instrument should not be re-deployed. In this case, please
contact us.

O-rings are the critical component that keeps water out of the housing and thus the instrument dry.
Make a routine of O-ring inspection, maintenance and replacement.
· Check the O-rings and the O-ring grooves for grit, hair, lint, sand, or anything that could potentially

breach the O-ring seal. 
· After frequent deployments or if O-rings or groves appear dirty, remove O-rings and clean the groves.

To remove O-rings, use finger pressure or the rounded edge of a plastic card to lift the O-ring out of the
grove. Caution! Never use a metal object to remove an O-ring. It may cause damage to the O-ring or
the sealing surface. 

· To check O-rings for damage, place the O-ring between the middle and index finger and thumb. Then
pull the O-ring through your fingers, feeling for any debris or wear. 

· If O-rings are dirty, it is best to replace them. Washing dirty O-rings with soap and water is not
recommended. Soap breaks down the lubricants and will compromise the integrity of the seal. 

· Properly greased O-rings will help maintain sealing integrity and minimize O-ring degradation. Use
enough grease to lubricate the O-ring thoroughly, but not so much that it will attract additional debris. 

· Clean the groove with a lint free swab or the folded edge of a paper towel. 

4.8.7 Replace Desiccant Bag

Humid air can condense enough water do damage the electrical circuitry. At least once a year, replace
the desiccant located in the pressure case or the external battery canister. Refer to the battery
installation description for the procedure of opening the pressure case.

4.8.8 Biofouling

Marine growth, or fouling, on moorings should be considered when planning long-term mooring systems.
The thickness of growth depends on location (temperature, sunlight conditions, depth, latitude, currents
etc.). Fouling can be a problem already after 2 weeks in tropical areas or it can take 6 months in cold
areas. Sunlight is also an important factor - fouling is generally much less of a problem below 100 m than
it is at 5 m depth.

When calculating forces, the marine growth is accounted for by increasing the expected weight and
diameters of the mooring line and all instrumentation attached, in addition to increasing the drag.
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Antifouling paints and other agents are often used to avoid transducers being covered with barnacles or
other evil crustaceans during long deployments. The important thing when it comes to antifouling is that
the paint is not too thick; otherwise, the signal strength may decrease. We tested the effect on the
profiling range of the 2 MHz Aquadopp and we could find no appreciable change when we applied a thin
(1 mm or so) layer on the transducers. You can probably use most anti-fouling paints as long as it is not
too (chemically) aggressive and contains no solids (metal flakes, etc.) that could interfere with acoustic
beams.

We realize barnacle has to be removed mechanically, but we strongly advice against using sharp objects
capable of harming the surface. We also recommend staying away from strong organic solvents such as
acetone.

A common, easy, and inexpensive way to keep the Delrin housing on the Vector clean is to wrap the
housing in either clear packaging tape and/or clear plastic wrap (such as the brand name "Saran Wrap").
 At the end of the deployment, simply unwrap the protective coating to find a clear instrument. Tapes
such as "Duct Tape" can leave a sticky residue that is very difficult to remove (although it does not
actually harm the Delrin housing).
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4.9 Cables and Wires

This chapter gives you the wiring for the most common cables. The wiring is the same if the connector is
circular or square. In addition there is a table below describing the harness and the 24 pin connector at
the electronics board. This might be handy if there is need to change the wiring harness without time to
receive one from Nortek.

4.9.1 Vector

RS232 with option for Analog input:

Underwater Connector Termination

Pin. No Wire Color Purpose Pins Description

3 Black RS232 Tx Twisted

Pair

2

4 White RS232 Rx 3

5 Black RS232 Gnd Twisted

Pair

5

6 White/ Purple Power Output Red wire

7 Black Analog Ch. 2 Twisted

Pair

Green wire

8 White/ Orange Analog Ch. 1 Yellow Wire

1 Black Power Gnd Twisted

Pair

Black Wire

2 White Power + Red Wire

Screen terminated at pin 1 in underwater connector, unterminated at PC side.

Ref: N2100-002A
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RS 422. Note that Tx and Rx refer to the instrument and not the PC: 

Underwater Connector Termination

Pin.

No

Wire

Color
Purpose Pins Description

3 Black RS422 Tx + Twisted

Pair

7

4 White RS422 Tx - 2

7 Black RS422 RX -
Twisted

Pair

8

8
White/Or

ange
RS422 RX+ 3

5 Black Sync. Out
Twisted

Pair

Black Wire

6
White/Pu

rple
Sync. In Green Wire

1 Black Power Gnd
Twisted

Pair

Black Wire

2 White Power + Red Wire

Screen terminated at pin 1 in underwater connector, unterminated at PC side.

Ref: N2100-108
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Wiring of RS232 with option for analogue outputs:

Underwater Connector Termination

Pin.

No

Wire

Color

Purpose Pins Description

3 Black RS232 Tx Twisted Pair 2

4 White RS232 Rx 3

5 Black Ground Twisted Pair 5

6 White/P

urple

Analog Z* Red Wire

7 Black Analog X Twisted Pair Green Wire

8 White/O

range

Analog Y Yellow Wire

1 Black Power Gnd Twisted Pair Black Wire

2 White Power + White Wire

Scr

een

Bare Ground 3 bare wires for grounds, connected internally to power

ground.

Ref: N2100-004

*Optional version outputs pressure instead of Z-Velocity
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4.9.2 Vectrino

Pin no Wire color Function Termination

1 White X

2 Black Y

3 White/Grey Z1

4 White/Purple Z2

5 White/Black Gnd (analog)  

6 White/Blue Sync+

7 White/Green Sync-

8 White/Yellow Gnd (digital) DSUB, pin 5

9 White/Orange Tx DSUB, pin 2

10 White/Red Rx DSUB, pin 3

11 White/Brown Power - Power supply connector

12 Black/red Power + (12-48V) Power supply connector

Ref: N2100-303 

Figure: Vectrino

connector and

drawing

highlighting the

pin numbering
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4.9.3 Vectrino Profiler

Wet-end termination
 

Try-end termination

Underwater
connector

Pin.
No

Wire
Color

Descripti
on

Pin Connector

(PMCIL-12-MP) 1 White Rx+ 3 DB-9 connector, pin 1 and 5 are grounded.

2 Black Rx- 8

3 White/G
rey

Tx- 2

4 White/P
urple

Tx+ 7

5 Not used

6 White/Bl
ue

Sync- Terminal block

7 White/G
reen

Sync+

8 Not used

9 Not used

10 Not used

11 White/Br
own

Power
Ground

Jacket 2-pin Jack plug

12 Black/R
ed

Power + Center

Shield Power
Ground

Connected internally to Power Ground

Ref: N2100-304: RS422 cable for Vectrino Profiler

4.9.4 Using Long Cables (Vector)

RS232 data communication at 9600 baud will normally work fine for cables up to 50 m long, depending
on the environment. If you want to run a longer cable, you can switch to RS422 by installing a different
wiring harness you can get from Nortek. 

You can also try using RS232 with longer cables by reducing the baud rate. Keep in mind that RS422 is
a more reliable means of communication than RS232 – changing environmental conditions could cause
RS232 communications to fail over a long wire without apparent reason. 

You should consider voltage drop across the cable, particularly if you use the two highest power
settings. Design your power supply and cable so that the voltage stays below 16 VDC and never falls
below 9 VDC.

4.9.5 Harness (Internal wiring)

Figure: Harness and harness
pins
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Pin Function

1 Power Ground

2 + External Power Supply

3 Power Ground

4 + Battery Supply

5 X Analog Out

6 Y Analog Out

7 Z Analog Out

8 Auxiliary Analog Out

9 CTD Power Out

10 Signal Ground

11 RS232 Tx

12 RS232 Rx

13 CTD RS232 Tx

14 CTD RS232 Rx

15 Analog In 1

16 Analog In 2

17 RS422 Tx+

18 RS422 Tx-

19 RS422 Rx+

20 RS422 Rx-

21 Sync Out

22 Sync In

23 +3.3V LP

24 RS422 3.3V Supply (grounded for RS232, shorted to pin 23 for RS422)

Relevant for Vectors only
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5 Integrators Guide - Light
This section covers:

ü Analog Inputs - relevant for the Vector. Analog in is where you take another analog sensor and digitize
the data in the Vector.

ü Analog Outputs - relevant for the Vector and the Vectrino. Analog output is where the digital to analog
converter (DAC) in the instrument outputs analog signals that can be input into your own AD converter.

ü Synchronization - relevant for all the velocimeters

This chapter cover the subject on how to use Nortek instruments together with other instruments or
sensors. 

For a more comprehensive Integrators Guide, check out the one we have available on our website. The
Integrators Guide provides the information needed to control a Nortek product with a non-PC controller. It
is aimed at system integrators and engineers with interfacing experience. There is one that includes
commands for the Vector and Vectrino (called Integrators Guide - Classic), and a separate one for the
Vectrino Profiler.

https://support.nortekgroup.com/hc/en-us/categories/360001447411-Manuals
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5.1 Analog Inputs (Vector)

There is an option to connect external sensors to the two analog inputs. The external sensors may be
powered by the Vector (enable this in the Deployment Planning dialog), and their data output may be
stored in the instrument during a deployment or downloaded in real time. With two external sensors
connected, the Vector is able to read both analog inputs at the same time. 

The reported analog value from the Nortek instrument is counts. The scaling is V = (Counts/65536)*5 due
to 16 bit AD converter. The input range is 0-5 Volt, where 0 Volt equals 0 counts, 5 Volts equals 65535
counts and 2.5 Volts equals 32768 counts.

The analog input can be scaled and re-labeled in the instrument specific software; Click View > Analog
Inputs. 

To configure the Vector for use with external sensor:

· In the instrument software click Deployment > Planning > Use existing or use Load from Instrument. 
· Check the “Use Advanced Settings” box and go to the Advanced tab.
· Define which analog input (1, 2 or both) to use. 
· There is a choice between fast and slow sampling. When choosing slow, the sampling is done once a

second (1 Hz) together with the other non-velocity sensors. If fast is chosen, the analog sensor is
sampled together with the velocities at for instance 8 Hz. Only one Slow input is permitted.

· If you want to power the external sensor from the instrument you must check the Output power box. 

Note: Power consumption of the external sensors are not included in the power consumption estimate
done by the software. The memory requirements, on the other hand, includes the analog input channel.

The output power is configured in hardware by Nortek and can be raw (i.e. battery power), +5 V, or +12 V
(see table below). The raw setting is the default setting and all instruments come with this setting unless
otherwise was specified upon ordering. 

Power out can be software selected by sending a HEX command in a terminal emulator.

Voltage Level Command Maximum Current

RAW OPWRBA 500 mA

+12 V OPWR12 100 mA

+5 V OPWR5V 250 mA

Be aware that the power out is turned off when the instrument is in sleep mode, as this contributes to
reducing the system’s power consumption significantly. Consequently, the external sensor used must be
capable of automatically resuming its duties once the power comes back and it must do this within 1
sec after power up in order to provide correct data for the first sample. Also note that:

· Power at 5 and 12 VDC comes through switching regulators. This means that power drawn from the
battery pack is 15-18% greater than the power consumed by the external device. See example below
when considering energy consumption.

· The output voltage is protected against short-circuit with a 1-amp fuse. To protect the Vector circuitry
against external sensors providing an output voltage in excess of +5.0V, there is a clamping diode on
the input with a current limiting resistor in series. The diode will conduct at voltages above
approximately 5.3V. To achieve stable conditions during testing, the +5V_SEN net can be powered up
from command mode by sending the hex command 435001C4. 
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· The output voltage turns on at least 0.8 s before the beginning of a measurement interval, and it turns
off again at the end. The first measurement of the analog inputs occurs roughly 0.9 s after power is
applied.

· The planning software does not consider power consumption of your external devices when it plans
deployments.

· The data from the external sensor will not be affected by the instrument data quality. For example, the
external sensor’s data will be totally unaffected even if the instrument is out of water and thus
measuring noise only.

· The input impedance of the analogue inputs is 468 kΩ/100 nF

ÜExample: This example explains how to calculate energy consumption. It covers the energy
consumption of an OBS3+ sensor, 15 mA, 5-15V supply, that are set up for 30 days deployment. Duty
cycle of OBS: (2048samples/4Hz)/1200sec measurement interval = 43%. 

1. Output power voltage set to battery: 11V*15mA*43% = 71mW per sensor. Energy per sensor:
30days*24hours*0.071W = 51 Wh. That is 102 Wh for two OBS sensors.

2. Output power voltage set to 12V: 1.25*12V*15mA*43% = 97 mW per sensor. Energy per sensor:
30days*24hours*0.097W = 70 Wh. That is 140 Wh for two OBS sensors.

3. Output power voltage set to 5V: 1.25*5V*15mA*43% = 40mW per sensor. Energy per sensor:
30days*24hours*0.040W = 29 Wh. That is 58 Wh for two OBS sensors.

5.2 Analog Outputs

The Vector and Vectrino have the option of outputting data represented as analog signals. They are able
to output the measured velocities on a linear scale, and the voltage output is 0-5 volt. This voltage must
manually be converted to velocities:
· 0 m/s is reported as 2.5 V
· -velocity range as 0 V
· +velocity range as 5 V

Available outputs are 3 velocities (E/X/B1 N/Y/B2 U/Z/B3) and pressure. For standard cable only 3
outputs are available, thus 3 velocities are default. 

In both the Vector and the Vectrino, the scaling output for the velocities is chosen in the deployment
planning. It is important to select an analog range that matches the velocity range. You could in principle
use an analog range of +/-7 m/s and a velocity range of +/- 1 m/s, but you would lose a lot of precision.
The best thing is to first decide what maximum velocity that you want to measure and then select the
minimum velocity range and analog output range that includes that velocity.

Note: To use this function Nortek needs to provide a head file with analog outputs enabled. The correct
harness also needs to be installed. Contact Nortek for more information.

ÜExample: The maximum expected vertical velocity is 0.8 m/s, and the maximum horizontal velocity is
expected to be 2.3 m/s. Configuration:

· Select the +/- 2 m/s velocity range
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· Select the +/- 2.5 m/s analog range
If the expected maximum horizontal velocity had been 2.9 m/s instead, you could still use the +/- 2 m/s
velocity range, since the maximum horizontal velocity would then be 3.5 m/s. But you would then need
to use the +/- 7 m/s analog output range to be able to represent the velocities from 2.5 m/s to 2.9 m/s
with the analog output voltages. Note that the velocity range is different in the vertical and horizontal
direction whereas the analog output range is the same for all components, beam, XYZ or ENU.

The velocity is given by: 

(vel
range

 / V
range

) * V
out

 - vel
min

 = velocity

Where vel
range

 = full range of velocity, V
range

 = usually 0V to 5V, V
out

 = voltage outputted, vel
min

 =

minimum velocity.

Alternatively set up two equations (2 unknowns, slope and intercept) using mx + b = y, where x is
voltage and y is velocity. Knowing voltage and velocity in two scenarios will give m and b (use max and
min velocity and voltage). This gives you the full linear fit.

At zero flow the outputted voltage should display 2.5V. If not, there may be issues with grounding. 

ÜExample: The range is specified to +/- 1 m/s. Voltage outputted is 1 V, V
range

 is 5 V. The velocity

would be: (2 / 5 V) * 1 V - 1 m/s= -0.6 m/s

5.2.1 Vector

Vectors can send out velocity signals as 0-5 VDC analog voltages. Here is what is required to enable
analog outputs:

· A special wiring harness passes the analog voltages out to the external connector. The output wires
include three signal wires and one ground wire (which is shared with the RS232 ground). The remaining
wires are allocated to RS232 and power.

· A special head configuration file where analog outputs is enabled is needed.
· Enable analog outputs in the Vector software's planning menu (Advanced Tab). The planning module

controls data collection in the Vector the same, whether or not the analog outputs are enabled.
· Once in analog output mode, you can remove and reapply power as desired. When you reapply power,

the analog outputs resume. Allow a few seconds for the instrument to start up after you apply power.

5.2.2 Vectrino

Vectrino can send out only velocity signals as 0-5 VDC analog voltages, 3 channels standard, one for
each velocity component. Here is what is required to enable analog outputs:

· Enable analog outputs in the Vectrino software's planning menu. The planning module controls data
collection in the Vectrino the same, whether or not the analog outputs are enabled.

· Once in analog output mode, you can remove and reapply power as desired. When you reapply power,
the analog outputs resume. Allow a few seconds for the instrument to start up after you apply power.

The analog output curve should be linear, so no calibration curve needs to be applied.
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5.3 Synchronizing with Other Instruments

It is possible to synchronize instruments together, or its sampling can be controlled by other sensors.
This comes in handy if there is a need to use several instruments for a single set of measurements.

5.3.1 Vector

Sync out (Vector acts as Master)

The Vector can be synchronized with other instruments via the SyncIn and SyncOut. The
synchronization option requires that the correct wiring harness is installed in your system. The SyncOut
signal consists of 1.95 ms long, 3.3V pulses that can be configured for two different schemes of output
synchronization. The selection of the type of SyncOut signal is made on the Advanced tab in deployment
planning:

· If Output Sync for other sensor is selected, the SyncOut pulse will be output in the middle of each
velocity-sampling interval. 

· If Output Sync for Vector is used, the SyncOut pulse will be output at the completion of each sampling
interval. 

· In addition, one SyncOut pulse will be output when the sampling of velocities is started.

Figure: Sampling Interval

Sync In (Vector acts as Slave)

The SyncIn signal permits external control of the sampling. There are three possible modes of operation
that can be set for Input Sync:
· No Sync. In this mode, the Vector ignores the SyncIn signal and data collection starts under software

control only.
· Start on Sync. In this mode, the Vector starts data collection on the rising edge of the SyncIn signal.

Sampling of velocities then proceeds at the set sampling rate. After data collection is started the
SyncIn is ignored. 

· Sample on Sync. In this mode, the Vector outputs a sample after every rising edge of SyncIn. To use
this mode, the Start on Sync mode must be used as well. Therefore, the first rising edge starts the
averaging process for the first sample only. The first data sample is output on the second rising edge
of SyncIn. The output data at each rising edge of SyncIn will correspond to an average since the
previous rising edge of the SyncIn. The Vector must be configured with the setup software for a
sampling rate that is equal to or higher than the sampling rate that will be used. 

ÜExample: If the signal on the SyncIn input to the Vector is generated to correspond to a sampling rate
of 25 Hz, the Vector should be configured in software for a sampling rate of 32 Hz. In most cases, it
will be sufficient to synchronize different Vectors using Start on Sync. 

Instruments shipped after November 2000 are fitted with a real time clock with an accuracy of ±1
min/year over a temperature range of 0–40 °C. Over a burst period of for example 1 hour, the maximum
clock drift between two Vectors will then be 13.7 ms. Since they will operate at the same temperature
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the clock drift is likely to be even smaller. At 8 Hz sampling rate, this will be 1/10 of a sampling interval
over one hour of measurements. 

Figure: Description of sync and sampling and data out intervals

Output of the Vector system data (compass, tilt and temperature) is not synchronized between different
Vectors through the use of the SyncIn signal. Instead, the start on the sync edge that is present in both
synchronization modes is used to start the 1 Hz output of the system data. Each Vector will then output
its system data based on its internal real time clock. This implies that the number of system data
outputs may vary slightly from one instrument to another. Note that this is not a problem for the
synchronization of the velocity measurements. The compass and tilt data are used internally in the
Vector to ensure correct transformation of the velocities to earth coordinates when ENU is selected as
coordinate system. In detail, each Vector configured for Start on Sync will output system data in a
certain order at the start of continuous measurement and at the start of each burst when configured for
burst measurements. The system data are output in the following order:

1. Output header containing noise measurements and date/clock.
2. Output one sample of system data.
3. Wait until external trigger is detected and then start to output system data at a 1 Hz rate based on

the local clock. Velocity data will be output according to the configured synchronization scheme. 

Specifications of Signal Levels

The SyncIn input voltage must be between 0 V and 5.0 V. The SyncIn is a Schmitt Trigger input with a
pulldown resistor of 100kΩ to ground. The input threshold values for the SyncIn are: 

· Vt+ input positive threshold, 2.2 V 
· Vt– input negative threshold, 0.9 V
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Figure: Inout threshold values for SyncIn

The output voltage levels for the SyncOut are:

· Voh high level output voltage, min 2.5 V
· Vol low level output voltage, max 0.45 V

Figure: Output voltage levels for SyncOut

There is spike protection on both signal ports but there is no filtering on the input port. It is important to
consider noise issues (ground loops, etc) as noise may cause an unwanted start on sync trigger. 

ÜExample 1: Running three Vectors with synchronized sampling of velocities in continuous mode.
· Connect the SyncOut line from one Vector to the SyncIn line on the two other Vectors. 
· Connect the ground cables together. 
· Choose Output Sync for Vector for the first Vector. This will be the master. 
· In the setup for the two other Vectors that will be slaves, check both boxes in the Input Sync (Start on

sync and Sample on sync). 

With the rest of the setup identical for the three instruments; start the two Vector slaves first. When the
master Vector then is started, it will trigger the start of the other two Vectors.

ÜExample 2: Running three Vectors with synchronized sampling of velocities in burst mode.
· Connect the SyncOut line from one Vector to the SyncIn line on the two other Vectors. 
· Connect the ground cables together. 
· Choose Output Sync for Vector for the first Vector. This will be the master. 
· In the setup for the two other Vectors that will be slaves, check both boxes in the Input Sync (Start on

sync and Sample on sync). 
· Use identical setup for the rest of the configuration parameters for all three instruments. 
· Synchronize the clocks in all the Vectors. 
· Start Recorder Deployment for the master Vector setting the deployment time to the time when you

want the instrument to start (for example 4.00.00 p.m. or 16.00.00 – exact time format depends on
your computer’s settings). 

· Start Recorder Deployment for the two slave Vectors setting the deployment time to the deployment
time of the master Vector minus 10 seconds (in this example 3.59.50 p.m.). The two slave Vectors will
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now wake up in each burst 10 seconds ahead of the master Vector. After outputting the burst header
and one set of system data they will then wait for the start on sync trigger from the master Vector so
that all three instruments will start the data acquisition simultaneously (in this example at 4.00.00
p.m.). The two slaves will then continue taking data at the identical rate of the master Vector as they
receive the sample on sync triggers from the master Vector.

 
The same procedure can of course be used if only synchronized startup is required. The only difference
is that the Sample on sync box in the Input Sync configuration must be left unchecked.

ÜExample 3: Starting three Vectors simultaneously from another instrument
· Connect the SyncIn signals from the three Vectors together with the sync output line from the

instrument providing the start on sync signal. 
· Ground all the four instruments together. 
· Using identical and desired setups for the three Vectors start all of them with the Start on sync option

configured. 
· Generate the start on sync trigger from the other instrumentation. 

ÜExample 4: I wish to synchronize 3 vectors, one acting as the master and the other two as slaves
(i.e. example 2) in addition to this, I will wish to use each of the analog inputs (in all three vectors)
sampling at the fast rate. So is this possible, i.e. collecting velocity and analog inputs that are
synchronized ?

The answer is yes - you can make the system do both. The analog inputs are sampled toward the
middle of the velocity averaging interval. There will be a small amount of jitter, but not much. In any case,
it may be wise to test the analog input feature after you have put together all the cabling by inputting an
oscillating signal from a signal generator into all three Vectors.

5.3.2 Vectrino

The Vectrino can serve as master for other Vectrinos, or its sampling can be controlled by other sensors.
If one connects a controller to the Vectrino, a fairly sophisticated system in which the controller can
power the Vectrino and provide it with sync pulses to control the sampling accurately can be set up. The
controller can serve as a storage device. 

Note: A Vectrino can operate as a master for a Vector, but the opposite is not possible.

The Vectrino can be synchronized with other instruments via a pair of sync lines. To avoid noise
problems and to make cabling easier, the two sync lines are RS485 which is balanced and bi-directional.
The sync lines are labeled Sync– and Sync+.  Some instruments have incorrect labels on the sync
lines, if the labels read Sync in and Sync out they should be treated as Sync- (Sync In) and Sync+
(Sync Out). The polarity is not too important as the sync scheme is quite insensitive to the polarity.

Firmware version V1.30 Plus supports synchronisation of transmit pulses to avoid both electric and
acoustic interference when operating several Vectrinos together. This feature is only available in the Plus
version.

How Synchronization Works

Output Sync (Vectrino operating as the master) transmits a pulse on RS485 with a duration of 40 µ s.
Sync+ for Vectrino transmits the pulse by the end of the sampling interval and a single pulse at the
beginning of the first sampling interval to start everything. For other sensors, Sync+ transmits a pulse at
the middle of the sampling interval. Input Sync triggers on any edge, rising or falling, on RS485. After
each trig, the input is discarded for the next 64 µ s.
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RS485 levels 

These levels define the signal the Vectrino reads for Input Sync:
· High level: Sync+ > Sync– by 200 mV
· Low level: Sync+ < Sync– by 200 mV

Synchronizing Multiple Vectrinos

· Connect all the Sync+ lines together and all the Sync– lines together. All instruments should share a
common ground.

· Select one instrument as the master and the rest as slaves (Input sync) in the software. 
· Start data collection in all slaves before starting the master. The slaves will then wait for the first sync

pulse from the master before sampling commences. 
· If you use Sample on sync, all instruments should be configured with the same sampling rate.

We have checked that there is no interference between Vectrinos once they are properly synchronized
but have not tested how close they can be during operation. An intelligent guess is that they should be
at least 5-10 cm apart to avoid acoustic interference.

ÜExample: Synchronizing From a TTL Source
TTL signal levels can be mixed with the RS485 levels of the Vectrino: 

· Connect your sync pulse to Sync+ and connect Sync– to a constant voltage, 1.5 volts for instance.
This provides a defined transition when the TTL signal changes, which is not the case if you ground
Sync–.

· When Vectrino functions as master, the Sync+ line can be connected to the TTL input and the two
systems must be connected so they share common ground.

Noise problems: If you encounter noise problems, try terminating the Sync+ line at the TTL input by
connecting a 120 ohm resistor in series with a 1nF capacitor between the Sync+ line and ground. The
best solution for external sync is using RS485 as the input/output device. 

ÜExample: Vectrino master and Vector slave
· Connect ground of the two systems together
· Connect Sync+ on the Vectrino to SyncInput on the Vector
· Configure the Vectrino with the desired velocity range, 30 Hz sampling rate and select output sync for

Vectrino and check the box for master
· Configure the Vector with the desired velocity range, continuous sampling, the next higher available

sample rate (so 32 Hz in this example) and check the boxes for start on sync and sample on sync
· Select the file name for disk recording in both software instances and make sure you also start disk

recording in both software instances at this point.
· Press Start Data Collection in the Vector software
· Press Start Data Collection in the Vectrino software
· The measured data will now be shown on the display and stored to file, properly synchronized.

5.3.3 Vectrino Profiler

The Vectrino Profiler can serve as master for other Vectrino Profiler's, or its sampling can be controlled
by other sensors. This comes in handy if there is a need to use several Vectrino Profilers for a single set
of measurements. Note that the Vectrino Profiler can operate as a master for a Vector, but the opposite
is not possible.

If you connect a controller to the Vectrino Profiler, you can set up a fairly sophisticated system in which
the controller can power the Vectrino Profiler and provide it with sync pulses to control the sampling
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accurately. The controller can serve as a storage device. The Vectrino Profiler System Integrator Manual
is a useful source for this type of applications.

The Vectrino Profiler can be synchronized with other instruments via a pair of sync lines. To avoid noise
problems and to make cabling easier, the two sync lines use an RS485 chip which is balanced and bi-
directional.

The sync lines are labeled Sync- (n) and Sync+ (p). Note that on some of the older instruments the sync
lines are labeled Sync In and Sync Out. These should be treated as Sync- (Sync In) and Sync+ (Sync
Out).

How Synchronization Works
Output Sync (operating as the master) transmits a pulse with a duration of 50 µ s. The Vectrino Profiler
transmits a pulse at the end of the sampling interval and a single pulse at the beginning of the first
sampling interval to start everything when in "Master (Vectrino)" mode. When in "Master (Other)" mode,
a pulse is transmitted in the middle of each sampling interval.

Input sync triggers on the falling edge if the Sync+/Sync- signal. After each trigger the input is discarded
for the next 100 µ s.

Specifications of Signal Levels

RS485 levels: These differential levels define the signal the Vectrino Profiler reads for input sync;

· High level: Sync- > Sync+ by 200 mV
· Low level: Sync- < Sync+ by 200 mV

ÜExample: Synchronize Multiple Vectrino Profilers
1. Connect all the Sync+ lines together and all the Sync- lines together. All instrument should share a

common ground.
2. Select one instrument as the master and the rest as slaves (Input Sync) in the softwares.
3. Start data collection in all slaves (Click the Start Collecting data icon) before starting the master. The

slaves will then wait for the first sync pulse from the master before the sampling commences.

If you use Sample on sync, all instruments should be configured with the same sampling rate.

ÜExample: Synchronizing form a TTL source
TTL signal levels can be mixed with the RS485 levels of the Vectrino Profiler.
1. Connect your sync pulse (0-V volts) to Sync- and connect Sync+ to a constant voltage V/2 (Where V

is the ON voltage of the sync pulse). This provides a defined transition when the TTL signal changes,
which is not the case if you ground Sync+. The Sync inputs are diode limited to 5V through a 4.7
ohm resistor. Input voltages above 5V are not recommended for use. 

2. When the Vectrino Profiler functions as master, the Sync- line can be connected to the TTL input and
the two systems must be connected to share common ground. 

Noise problems: If you encounter noise problems, try terminating the Sync- line at the TTL input by
connecting a 120 ohm resistor in series with a 1nF capacitor between the Sync- line and the ground. The
best solution for external sync is using RS485 as the input/output device.
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6 Troubleshooting Guide
This section covers:
ü Tests that can be performed if you encounter a problem
üWhat to do if your data does not look right
ü Instructions on how to return an instrument for repair

This section contains our yearlong experience in where to start looking if an instrument does not behave
as intended. If you encounter a problem, you should:
· Work in a systematic way and do not neglect the obvious. 
· Get a good overview of the problem; make notes during the troubleshooting process.
· Start by looking for simple causes such as incorrect baud rate, power not connected, bad connections

or incorrect serial port. If the system involves custom cables, power supply or the like, first assemble
and test the instrument using just the cables and battery that came with the system. This is the
easiest way to get the system to work, and if you have trouble, you can always return to this setup to
confirm that problems are not caused by a faulty instrument.

If you still have problems after consulting this guide, please contact our subsidiaries, sales
representatives or Nortek Support. To help us in giving good support, please
· be specific about the error – a screen shot is often helpful 
· include if possible 
o an error description

o a picture, if possible 

o firmware and software version 

o serial number (head ID, hardware ID or order number)

o a raw sample file showing the error 

o the collected data set showing the error 

o result of tests as loop-back, current drain and LED signaling 

o Vector/Vectrino: screen-shot of the performed probe check 
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6.1 Communication Problems

To test communication; send a break by clicking Communication > Terminal Emulator, and click the
Send Break button. If the instrument is powered and properly connected and if the terminal is set to use
the correct serial port, the instrument will respond with the wake-up message.

If nothing happens when sending a break, initially check if 
· You have forgotten to power the system.
· The RS232 to USB converter or the RS422 to USB converter is not working
· The DB-9 connector has fallen out of the computer
· You are using the wrong serial port.
· You have forgotten that new instruments ship with the battery disconnected (applies to Vectors only).
· Computers do not always behave as they should and not all of them have serial ports available. If one

computer is giving you a problem, try another one instead.
· Inspect the instrument communications cable for damage such as nicks, cuts, or crushed sections.

Broken wires or physical damage to the cable will cause communications problems. To purchase a
new cable contact your sales representative.

· Make sure the connector on the cable is securely inserted into the bulkhead receptacle and the
connector pins are clean.

· Check the section about Break Responses for more details.

If none of these points above solves the problem, continue with the troubleshooting tests described next.

6.1.1 Test with battery and power supply

Cables are often exposed to heavy use and the power connector might break. To ensure that this is not
the reason causing problems, be sure to test the communication with both the power supply and the
battery inside the housing connected. Also:

· Do a visual inspection of the power supply. Is a green power light on?
· Measure the power supply and make sure it is stable
· Do not exceed the maximum VDC listed in the technical specifications
· Remember that Nortek instruments ship without the batteries connected

6.1.2 Cable Test

· Inspect the instrument communication cable for damage such as nicks, cuts, or crushed sections.
Broken wires or physical damage to the cable will cause communications problems. To purchase a
new cable contact your local sales representative.

· Make sure the connector on the cable is securely inserted into the bulkhead receptacle and the
connector pins are clean.

· Perform a continuity test on the cable by "beeping" each pin to pin. If you are experiencing intermittent
connections try wiggling the cable around to see if there is a cable breakage.

· Make sure you are using correct cable relative to your harness (f.ex RS232 communication on both
harness and cable)

Check the cable for electrical short circuits or discontinuities using a multimeter (resistance tester). 

· Keep the cable connected to the instrument, and disconnect the cable from the Interface box, PC or
power source. 

· Pin 1 & 2 should show similar magnitude of Ohm. The same goes for pin 3 & 4 and 5 & 6 (see table
below for approximate values).
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Pin Value of Ohm

1 & 2 1 MOhm

3 & 4 130 Ohm

5 & 6 1 MOhm

6.1.3 Serial-to-USB converter

· The converter should blink when first connected.
· Converter shall match the cable (f.ex RS232 converter with matching RS232 cable)
· Check that the driver is up to date (Find the port in the Device Manager, click Properties > Driver >

Update Driver). Links to current driver versions can also be found in the FAQ section on the web.
· If the converter is not detected, try a different USB cable and/or a different USB port. The port number

will change when the adapter is plugged into a different USB port, but the software will automatically
detect these changes and reflect currently available ports. It is recommended to eliminate any hubs or
extension cables between the computer and the converter.

· On RS422 converters check that the pins on the USB end have not been pushed in

Note that not all RS-232 USB-serial converters support data rate above 115200 baud. Using the one
supplied with the original shipment is recommended. 

Vectrino Profiler: At high sampling rates (above 60 Hz), the driver parameters need to be tuned to provide
an adequate display rate for the application software. Without this tuning, higher sampling rates will
appear to be slow and bursty. 
· Open Windows Device Manager, expand Ports (Com and LPT), right-click on the appropriate serial

port and select Properties. 
· With the properties in view, click on the Port Settings tab. The baud rate displayed (9600 in the menu

shown) doesn’t have to be changed. The application will automatically set the baud rate of both the
USB-serial port and the instrument to the requested rate in the connection menu so this driver entry
can be left unchanged. 

· Click on the Advanced button
· Change the Latency Timer to 5 msec. Faster systems should be able to use 2 msec. 
· Remove and re-insert the USB connector to activate the parameters. 

While having a lower latency timer is better, it can result in significantly higher CPU usage on slower
machines. If the data transfer from the instrument has degraded noticeably with the new latency timer,
increase it to a larger number. Ideally, this number should not be larger than 8 ms or the data display
refresh will start becoming choppy at higher sampling rates. The software will warn the user if it detects
that the latency timer has not been correctly set. 

6.1.4 Baud rate

In the Serial port dialog box, you can specify two baud rates for the instruments, one for normal
communication and data transfer (Baud rate), and one for data download and firmware upgrades
(Upgrade baud rate). 
· For the standard Vectrino program, the default baud rate is 19200. 
· For Vectrino Plus, the default baud rate is 57600.
· For the Vector, the default is 9600
· For the Vectrino Profiler, 937500 is recommended.

A higher baud rate may reduce the download time, but note that the baud rate is limited by the operating
system used, the serial port on the computer, and the length of the USB cable. If you experience
communication errors after changing the baud rate, try changing back to the default baud rate.

To change the baud rate permanently:
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1. Set the baud rate in the Communication > Serial Port dialog box.
2. Select Connect or Online > Stop Data Collection (or the corresponding toolbar button)

Note that not all RS-232 USB-serial converters support data rates above 115200. Using the one supplied
with the original shipment is recommended. 

6.1.5 Serial COM port

· Go to Communication > Serial Port and select the correct port from the drop-down serial port menu
· When connected the COM port will appear in the Device Manager. (Go to Start: Control Panel: System

and Security: Device Manager). It will usually appear as USB Serial Port (COMx)

ÜExample: Error message: No instrument detected on port COMx

This error message is a sign of something being wrong with either the computer or the serial-USB
converter. 

1. Make sure the power supply is plugged in and the green power light is on. If it is not receiving power
try a different outlet or resetting the GFI (if equipped) on the outlet. If the power supply has failed,
purchase a new one by contacting a sales representative.

2. Make sure the correct communications port is selected and available in the Serial Port Parameters
dialog. See points above. 

3. Check the USB to Serial adaptor. Confirm that you can see a light on the converter when trying to
establish connection. If the adapter is detected but has a warning symbol next to it, try reinstalling or
updating the driver (see section about Serial-to-USB converter). 

4. Make sure a properly working adapter/port is not in use by another application. Close any application
which was previously using the port to release it and make it available for use. Vectrino Profiler
specifics: If multiple instances of the Vectrino Profiler software are open, close all but one, then in the
menu bar select Communications: Disconnect All to free any in use ports.

5. If the problem can be fixed by re-booting the computer, it seems to point to the computer more than
the converter. You could try another PC if one is available and see if that fixes things. 

ÜExample: Error message: Port failure or port in use by other application.

The "Port failure" message happens when an attempt to open the serial port fails (which means that
either the port is "broken", non-existent or it's been taken over by another application). Ensure that the
USB-converter and all cabling is firmly connected and that nothing is coming loose during operation.

6.1.6 Break Response

The break is used to interrupt the instruments regardless of what mode the instruments are in. Send a

break by clicking Communication > Terminal Emulator, and click the Send Break button. If the

instrument is powered and properly connected and if the terminal is set to use the correct serial port, you

will see the instrument’s wake-up message (AquaPro example below):

@@@@@@
VECTOR
NORTEK 2012
Version 3.43
Command mode
¶¶

Other responses:
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1. @@@@@@K1W%!Q@@@@@@K1W%!Q 

Suggestion: Check that you are using the correct cable (with correct communication - RS232 or
RS422)

2. ....

Suggestion: Check that you are using the correct baud rate. 

3. (no response)

Suggestion: Check that you are using the correct serial port. Go to the device manager; disconnect
the USB to serial converter and then connect it again to detect the correct port.

4.  MEASURING

Suggestion: The instrument is measuring. If you want to stop the instrument, send MC ("Message
Confirmed"). If you want the measurements to continue, do not do anything.

5.  If you see a response consisting of garbled text or strange characters, the instrument and the

Terminal Emulator might be using different baud rates. The solution is to try other baud rates. 

If you have reason to believe that the computer is having problems, do not hesitate to try a different one!

For users that do not use our terminal emulator, sending a break can also be done like this:

1. Send the characters: @@@@@@
2. Wait for 100 ms.
3. Send the characters: K1W%!Q

The characters are case sensitive.

6.1.7 Loop Back Test

The serial loopback test verifies that the serial port can receive the same characters as it sends. The aim
of this test is to short-circuit the Tx an Rx lines, send a character using the Tx line and loop it back to
the Rx line. 

At the serial port

· Make a loop-back connector and plug it into your serial port as shown in the figure below.
· Now, run the test with the software’s built-in Terminal Emulator, and if that does not work, try

HyperTerminal instead (a terminal program that comes with Windows).
· Type characters - whatever you type should be echoed to the screen. Once you remove the connector,

the characters should stop echoing back.
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Figure: DB9 connector

At the serial cable

· Plug the cable into the computer
· Put a loopback connector on the end of the cable; that is, short-circuit pin 3 & 4 on the 8-pin

underwater connector. This applies to RS-232 communication only. 
· The same principle applies to RS422, except RX+/TX+ and RX-/TX- must be short-circuited -

respectively pin 8/3 and 7/4. This will be the same on the DSUB as for RS232, since that is after the
signal is converted.

Figure: 8-pin connector

6.1.8 Test with both RS422 and RS232 communication (Vector)

The Vector is able to communicate at both RS232 and RS422. When not able to communicate with the
option installed it could be a good idea to try the different alternative. To do this you will need both cable
and harness wired for this communication.

6.1.9 Software

Error message: Vectrino 2: buffer read error (Relevant for Vectrino Profilers)

The "Read error" message happens when the application stops receiving data for a long period of time.  

Error message: "Could not create the Java Virtual Machine" (Relevant for Vectrino Profilers)

If your 32-bit Java virtual machine has been updated to 1.7.0_09, your Vectrino Profiler acquisition
software may now display this error. This is due to an increase in memory footprint with the new JVM. In
order to get your software running again, go to the directory in which the software was installed (the
default is "C:\Program Files\Nortek\VectrinoII") and edit the file "Vectrino-II.l4j.ini".  This file contains the
line

-Xmx1200M

Change the 1200 to 1024

-Xmx1024M

and save the file.

Note that this is only a problem if you are running a 32-bit version of the 1.7.0_09 JVM.
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6.1.10 Check Current Drain

If you have the possibility to power the instrument with a power supply that displays the current drain,
this could give good diagnostic data. Send the commands listed in the table below in the Terminal
Emulator. The instrument should not drain more than 0,5A continuously. Typical current drains are (15V):

Mode Command Current Drain

Command mode <BREAK> 8-12 mA

Power down PD 1-2mA

Measurement mode ST ~3-150mA (cycling)

When performing a current drain test here, we usually leave the power on for about 12-15 hours in
advance to make sure the internal battery is fully charged. Note that the values above is for RS232.
Using RS422 will result in different values.

6.1.11 Check fuse

If the instrument does not drain any current, disassemble the instrument and find the 3A fuse that is
protecting the power input. There should be close to 0Ω between the terminals on the fuse. In other
words if the input power source is 15V there should be 15V on both terminals of the fuse.

Figure: Fuse on circuit board

6.1.12 Check LED Indications

The midlife hardware has a dual LED consisting of one green and one red LED. The firmware uses the
LEDs to indicate the state it is in. The following combinations are used:

· A short red flash occurs when the board boots. This means that reception of a break will also cause a
red flash as well as start of a new measurement based on an alarm from the real time clock and when
power is applied to the board.

· Continuous green and red indicates that the board is in firmware upgrade mode.
· Continuous green only indicates command mode.
· In measurement mode, the green LED will flash when either of the beams pings.

6.1.13 Checksum Error

A checksum error means there was a problem with the serial communications. The checksum is at it's
simplest the sum of all of the bytes from the start of a data string to the end. This is generally encoded
at the end of the data string and used to check for communication errors. A checksum error occurs when
the computed checksum on the receiving end does not match the transmitted value. 
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Generally, this means there is some noise on the communications line and that one of the bits was mis-
transmitted or something similar, although in this case it could be due to the data buffer overflow and the
data strings getting a little out of sync. 

ÜFor example, a data string could start and then the buffer overflow error occurs, so a portion of that
data string is lost. The Vectrino software picks up the stream from the buffer but is missing a little bit
so the checksums do not match.

6.1.14 Flash corrupt

The message "Error: Flash Corrupt (I)" may appear in a couple of scenarios in the Terminal Emulator.

Vector: The flash corrupt message indicates a problem with the part of the recorder flash where internal
parameters are stored such as baud rate, instrument mode etc. The corrective action is to try to erase
the recorder and see if the problem disappears. 

The cause of this error is typically extensive "recorder wear" which can cause flash failure. We have seen
this in cases where instruments have been used with a high rate of measurement start/stop sequencing
usually only done by system integrators. If you see this error and use a controller to operate the
instrument autonomously you may have to change the way you operate the instrument. For example
using the commands that measure and output single samples from command mode or controlling the
data flow by controlling the power to the instrument.

This error can also be identified by looking at the dual LED on the main PCB blinking red once per
second.

Vectrino: Error code: "<code> Connected! Error: Flash Corrupt". This indicates a problem with the
communication between the main board and the probe. There are a few possibilities:

1. Fingercontact on the probe is not properly fitted onto the circuit board.
2. The probe is connected the wrong way
3. Circuit board error
4. Probe board error

To investigate:
· Try to connect the probe both ways to check if the probe is connected the wrong way. This can be the

issue if the endbell has been changed and the circuit board has been installed the wrong way.
· Disconnect the probe and the endbell from the housing by removing the three screws at both ends.

Pull out the main board from the end bell side. Now connect the probe to the circuit board. (Nothing
will be damaged if connected the wrong way). Try the connect button and see if the error message
disappears. 

If you manage to establish communication please assemble it together and be careful to fit the
fingercontact onto the circuit board properly.

6.1.15 "Calibration matrix not stored"

Vectrino Profiler error code: "Profiling calibration matrix not stored in probe. XYZ mode not supported"

The reason is most likely that the probe head is incorrectly mounted. Check Changing a Probe, and try
connecting it properly. Next, run a firmware upgrade. Also make sure that your software version is up to
date.
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6.2 Instrument Stopped During Data Collection

There are mainly two problems that may cause an instrument to stop during data collection; power is
discharged/problematic or the recorder is full. The latter is only relevant for the Vector.

6.2.1 Power

Vector: The software allows you to calculate the anticipated power consumption as a function of the
sampling scheme and planned deployment duration. The predicted power consumption is given in
percentage, where 100% signifies complete depletion of a chosen battery pack for the particular
instrument. Make sure the power requirements calculated in the deployment planning dialog are met
before deploying.
 
Note that this calculation is based on using new batteries only, and we recommend that you to always
use fresh batteries when deploying an instrument. It is just not worth taking any risk with possible non-
collection or loss of data or any instrument failure due to low battery level. Consider the cost of
deployment and recovery of an instrument and place that against the cost of a fresh battery pack. As
standard practice, we always install a fresh battery pack before every instrument deployment.

Vectrino and Vectrino Profiler: It is possible checking that the power supply is working by using a
multimeter/voltmeter. You should measure about 24VDC.

6.2.2 Full Recorder (Vector)

Always start a new deployment with an empty memory. To erase the instrument's recorder:

· Make sure that you have transferred all the data you want to retain to your computer (if applicable) and
that the data is in good shape.

· Click Deployment > Erase Recorder.

It is also a good routine to pay attention to the Memory required review in the right side of the
deployment planning dialog.

6.3 Suspicious Data

If your data does not look right, the first step should be to check how the instrument was
deployed/mounted. 

For the Vector: Inspect the Pitch, Roll and Heading data, in addition to pressure. This will in an efficient
way tell you how the instrument has behaved during deployment, and, most importantly, indicate whether
the data are trustworthy or not. For more about this, check out the interesting Quality Assurance
section. 

6.3.1 Signal Strength

The instrument cannot measure velocity accurately if the water has too few scatterers. The data quality
will be questionable when signal levels are down around the noise level, a rule of thumb is that the signal
should be at least 6dB higher than the noise floor. When using the instrument in high latitude areas or
really deep waters the purity of the water can affect the signal strength and thus also quality of the
measurements. The low presence of scattering particles in the water cause extremely low reflected
signal level. The Probe Check is an invaluable tool if there is doubt about signal strength.

6.3.2 Diagnostic Testing Using the Probe Check Function

The figures below shows Probe Check displays resulting from different problems. If you need a reminder
on how to interpret a probe check, take a look at this section: Probe Check. These probe checks are
from a Vectrino, but the same effects are in most cases valid for the Vectrino Profiler and the Vector as
well. If there are any exceptions, it will be mentioned. It is recommended to look at the probe checks
presented both as amplitude and SNR.
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Below is a presentation of the most common problems together with our suggestions on how to improve
the result of the check, if it is not related to a damaged probe. For the troubleshooting to be extra
effective, a "before" probe check to compare your suspicious probe check against is a good starting
point. If you have older data files with good scattering conditions this should come in handy.

Boundary interference: The sample volume should be centered around 50 mm. Suggestion: Try using
a deeper bucket.

Multiple echos from the bottom reflecting off the surface can also appear in the probe check data. These
will typically be at roughly integer multiples of the actual distance to the bottom. Depending on the
acoustic path length, an echo closer to the actual boundary position may be the result.

When a side-looking Vectrino probe is placed close to the bottom, the two receivers slanted 45 degrees
may see interference from the bottom. If you see interference in beam 3 and beam 4, try moving the
probe a bit up in the water column.

Boundary interference: If there are any obstructions in the beam path, the result may look like this.

Little scattering material / low power: The curve showing the sampling volume is "too low" in terms of
counts. If the scattering level is sufficient, increase the output power.

Too little scattering material or power level too low
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Bent receiver arm: Take a look at the location (range) of the peak in amplitude on the probe check for
each receiver. If it is significantly shifted closer or further away, then it is usually an indication of a bent
receiver arm. In the figure below, the red and blue curve (representing beam 1 and 2) are not aligned with
the other two curves, In this case, beam 2 was bent a bit out, beam 1 a bit in.  

Check to confirm: Gently place the probe on a flat surface and confirm that all beams touch the surface
at the same time. 

A bent receiver arm will change the calibration since the receiver arm geometry has changed. If it is only
minor changes, then you may not notice much difference, but it will introduce a bias to the
measurements. Contact Nortek for further guidance.

Bent receiver arms: The curve presenting data for Beam 1 and Beam 2 is not aligned with the expected curves

Saturated signal: The probe check should have a nice peak around the sampling volume and not
plateau at any point. Try lowering the power level and see if the result improves.

Saturated signal: The curve flattens at the peak. (The peak around 340 mm from the probe is the bottom).

Problem with one of the receivers: The red beam is not functioning properly, the curve for this receiver
is not aligned with the other three. Check if there is something blocking it, or contact Nortek for further
guidance.
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Problem with receiver on Beam 2.

Problem with the transmitter: Note that this probe is submerged (you will get a similar result when
running a probe check in air). The transmitter is not functioning properly. Check if there is something
blocking it, or contact Nortek for further guidance. 

Problem with transmitter: Either blocked or not functioning

Grounding: (Vectrino: loose grounding wire): The noise floor is varying around 50 counts. Tests in
laboratory tanks can sometimes lead to grounding problems that show up as elevated noise levels, but
only after the instrument is submerged in water. You will not automatically see the increased noise level
in your data if your signal from the water is above the noise, but the increased noise level could look like
signal. Suggestion: Check that the grounding wire between the probe and the electronics on the Vectrino
is connected (you will need to remove the probe to check this). Second, you may be able to reduce your
problems by coiling your cable into a tight bundle and raising the cable above the floor (i.e. placing it on a
chair). 

Vector: One way to tell the noise level in the tank is to collect with the transmitter out of the water but
the receiver arms in the water. The signal you now see is noise only. Grounding problems will disappear
when you disconnect the Vector from the computer and from the external power supply. Collecting data
to the internal recorder using batteries can be an option to remove possible grounding problems in indoor
environments.
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Grounding: Keep in mind that grounding problems occur around man-made structures, and are not normally a

problem in the field.

Sharp peak around 30 mm (relevant for the Vector): This is just electronic noise when transmitting,
and this has no influence on the current measurements. There is nothing wrong with the instrument.

Sharp peak in the beginning of the plot

Scaling: The graphs grows beyond the screen. Solution: Right-click inside the graph and select
"Scaling" to adjust the range of the Y-axis.
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The scaling of the axis can be adjusted in the software

6.3.3 Boundaries

In open waters, boundaries are not a concern, but if you want to use the instrument near the bottom or
surface, think about the boundaries when designing the experiment. If one of the beams cross a hard
boundary, whether surface, bottom or wall, velocity data from that beam will be bad. There are several
different ways to improve the situation; one example is to change the orientation of the instrument. The
Probe Check can also give valuable information about data quality if you are close to a boundary.

6.3.4 Incorrect speed of sound

The speed of sound in water influences the calculation of the velocity data. The time lag between the
transmitted and received pulse determines how far the pulse travelled before it was reflected. 

The instruments compute the speed of sound based on the measured temperature (accuracy of 0.1° C).
A nominal salinity is assumed, an assumption that works relatively well because the sound speed is
more sensitive to temperature variation than it is to salinity variation. 

Sound speed errors are typically small, but if you must correct velocity data for errors, use the following
equation:

Here, V is the velocity and C is the speed of sound.

6.3.5 Noisy Velocimeter Data

Noisy data may be caused by:
· Not enough particles in the water. Velocimeters cannot measure velocity properly if the water has too

few scatterers. Data will be questionable when signal levels are down around the noise level (less than
60 counts). 

· The Velocity Range is set too high.
· The sampling volume is located beyond the bottom (typically if the test bucket is too small).
· Reflection and reverberation conditions at the bottom creating pulse-to-pulse interference between

acoustic pulses. Try moving the probe up or down relative to the bottom.
· Probe malfunction. Run the Probe Check (Online or Data Collection > Start Probe check). If the probe

really is malfunctioning, report the probe check result to Nortek.
· Grounding problems.
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6.3.6 Grounding Problems

Tests in laboratory tanks can sometimes lead to grounding problems that show up as elevated noise
levels, but only after the instrument is submerged in water. You will not automatically see the increased
noise level in your data if your signal from the water is above the noise, but the increased noise level
could look like signal. If grounding problems cause elevated noise levels, you may be able to reduce your
problems by coiling your cable into a tight bundle and raising the cable above the floor (i.e. placing it on a
chair). Check out the Probe Check section for a figure. Also, feel free to contact us for further guidance.
Keep in mind that grounding problems occur around man-made structures, and are not normally a
problem in the field.

Vector: One way to tell the noise level in the tank is to collect with the transmitter out of the water but
the receiver arms in the water. The signal you now see is noise only. Grounding problems will disappear
when you disconnect the Vector from the computer and from the external power supply. Collecting data
to the internal recorder using batteries can be an option to remove possible grounding problems in indoor
environments.

Vectrino Profiler: If you encounter noise problems when synchronizing the sensor using a TTL source: try
terminating the Sync- line at the TTL input by connecting a 120 ohm resistor in series with a 1nF
capacitor between the Sync- line and the ground.

6.3.7 Phase Wrapping

Please check out the Principles of Operation and “A Practical Primer for Pulse Coherent
Instruments” (available on the web) for more details regarding phase wrapping. The essentials are that
the Doppler phase shift is computed using the covariance method, and this restricts solving the phase
difference within the range of [-π , π ] or as reported by the planning software. This introduces the problem
of ambiguous determination of the phase shift; if the phase difference goes outside the range of ±π , the
measurement uniqueness is lost, something known as velocity ambiguity. 

We see this phase wrapping in a velocity trace as an abrupt, unrealistic change in magnitude, usually
with a change in sign. While it is possible for phase wrapping to occur without a sign change, this would
be the result of an extremely large wrap where the phase shift exceeds 2π , in which case decorrelation
would likely occur first.

It is generally best to avoid phase wrapping issues as the time spent correcting them is often significant.
The best tip is to have some prior knowledge about the area of interest, so that you can set the Velocity
Range properly.

To identify wrapping: If you are lucky, velocities were fairly strong so the wraps go from a positive
velocity to a negative velocity and are quite obvious. A simple sign filter (i.e. positive velocity expected,
wrapped points have a negative sign) will work fairly efficiently to identify wrapped points.

For smaller velocities where it is a bit harder to identify wrapped points by sign alone. Playing with
various forms of local median filters to identify wrapped points has varying degrees of success,
dependent largely on the quality of the dataset. Histograms are actually extremely useful for this type of
work. A lot of times the ambiguity velocity causes the tail of a histogram to be cut off and shifted to the
wrong side of the histogram (so, a sign filter would probably work wonder here) meaning visually it is
fairly easy to pick out wrapped velocities. At the least, this is a good way to check the success of any
identification scheme developed

To unwrap the data: It is, in principle, possible to unwrap data when you can make assumptions about
du/dt but only if the SNR and correlation is good. There are two ways to go about dealing with your
present data.
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1. Develop an outlier filter to remove the wrapped data. If there are only a few points (some small
percentage of the total data) it's relatively simple to define a cutoff threshold outside of which you discard
the velocity data. If needed, you can interpolate these removed points back in as long as the gaps
created by removing them are not too large. The advantage of this is it is relatively simple and quick, and
the impact on statistics is going to be fairly minimal because so few points are involved.

2. If the number of wrapped points is fairly high, the above is problematic because the variance of the
signal is artificially constrained by the phase wrapping (i.e. the largest events are being eliminated from
sampling). In this case the data either needs to be corrected or retaken. For a field deployment this
generally means correction. Below are the recommended steps for going about this.

Step 1 in ambiguity correction is to get the data back into beam coordinates. Search for "Coordinate
Transformation" in our FAQ database to find an explanation on how to do this, or confer our Practical
Primer for Pulse Coherent Instruments available under Documents.

Step 2 is to find the Ambiguity Velocity. Ambiguity Velocity (the velocity corresponding to pi, denoted
V

amb
) is the maximum beam velocity which can be measured by the instrument in its deployed

configuration. This is set by the Nominal Velocity Range in the configuration window of the software.
There are two ways of finding this velocity:

A simple estimate of V
amb

 is the average of the absolute values of the maximum and minimum measured

velocities.
A more accurate expression is V

amb
 = c / ( 4 * f * timeLagInSeconds ), where c is the speed of sound, f

is the instrument frequency and timeLagInSeconds is pulled from the configuration information in the
*.hdr file (this formula is the standard Pulse Coherent maximum velocity calculation. Search for "lag" in
our FAQ database to read more about this.)

Step 3 is to remove the V
amb

. The procedure is like this: 

loop over all the data points
If large jump in velocity, then

if the jump is negative, then
newvel = oldvel + 2*Vamb

else
newvel = oldvel - 2*Vamb

end
end

end loop

Step 4 is to transform the velocities back to XYZ or ENU

A few words of caution: it is generally best to avoid phase wrapping issues as the time spent correcting
them is often fairly significant. The most difficult task is identifying the points which are wrapped and
automating this process. The correction is fairly simple once points are identified however.

6.3.8 Mooring/mounting Vibrations

Excessive mooring vibration can adversely affect the data. Vibration introduces spurious velocities and
interferes with the proper operation of the tilt sensor. You may be able to detect intervals of excessive
vibration by looking closely at the data. If you discover that mooring vibration is a problem, you should try
to find ways to reduce the vibration. Read more about this in the Mounting Guideline.

For Vectors, there is an option to add an IMU to know more about how movement of the instrument
affects the measurements.

https://support.nortekgroup.com/hc/en-us/categories/360001412211-Frequently-Asked-Questions
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6.3.9 Error and Status Codes (Vector)

The Vector output two multiple bit binary coded words describing the instrument state. The following
explains the meaning of each bit in the Error and Status words. The bits within the words count from right
to left starting with zero.

Error word:
The bit is set ("1") if there is an error condition and cleared ("0") if ok.
Bit 7 - Coordinate transformation: If the compass fails and the system is set to ENU the system will
output XYZ and this bit will be set.
Bit 6 - Sensor: Vector: The tilt sensor is not responding.
Bit 5 - Beam number: A problem has occurred with the beam order. 
Bit 4 - Flash: An error has occurred in the primary system flash memory and the system may not be
able to reboot. 
Bit 3 - Tag bit: There has been an error in the processing, an internal buffer is overflowing.
Bit 2 - Sensor data: One of the sensors is not operating correctly.
Bit 1 - Measurement data: An error has occurred with some element of the processing, the data is
probably corrupted.
Bit 0 - Compass: The compass does not respond. If the system is in ENU mode it will default to XYZ,
and a value of 90 degrees will be displayed.

Status word:
Bits 7 and 6 - Power level: These bits reflect the power level setting, i.e. how much acoustic energy the
instrument transmits into the water. This is set by the user in the deployment planning dialog when
configuring the instrument.
Bit 7  Bit 6  Power level
 0      0       High
 0      1       High -
 1      0       Low +
 1      1       Low

Bits 5 and 4 - Wakeup state: These bits indicate the wakeup state of the instrument. There are four
different ways that can cause a wakeup of the instrument and hence there are two bits in the status field
that identify the wakeup source. 
Bit 5  Bit 4  Wakeup state
 0      0       Bad power
 0      1       Power supplied
 1      0       Break
 1      1       Real Time Clock (RTC)

· Bad power status is used when the input voltage to the instrument during normal operation is so low
that the instrument may no longer operate correctly. The hardware is then held in a reset state until
the voltage reaches an acceptable level. It is typically caused by a broken cable or a faulty power
supply.

· Power supplied is the status code when power is applied to an instrument. To get this status code the
power must typically be removed for a few seconds. Removing power for just one second will typically
be indicated as bad power. 

· Break status indicates an instrument reset because a break was received on the communications
port. The break is used when the software communicates with the instrument. This will typically be
status code in the first data record in an online measurement.

· Real Time Clock status shows that the internal clock in the instrument caused the wakeup. To reduce
the power consumption the instruments enters sleep mode between measurements for most setups.
The internal RTC will ensure that the instrument wakes up at the appropriate time and this is indicated
in the status byte. 
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Bit 3 - Roll: This bit indicates if the instrument roll angle exceeds the tilt sensor operational range limits.
Bit 3  Roll
 0      Ok, valid data
 1      Out of range, invalid data

Bit 2 - Pitch: This bit indicates if the instrument pitch angle exceeds the tilt sensor operational range
limits.
Bit 2  Pitch
 0      Ok, valid data
 1      Out of range, invalid data

Bit 1 - Scaling: This bit indicates the scaling of the velocity output and depends on the velocity range
setting.  If the instrument is set to use the highest ranges the least significant bit is 1 mm/s.  For the
lowest range it is 0.1 mm/s.  The purpose of varying scale factor is make sure we utilize as much as we
can of the dynamic range that is inherent in the system. This is all transparent if you use the Vector
program to convert to ASCII because the data reported in the ASCII files is in engineering units.  If you
develop your own programs to read the binary data files, the variable scaling needs to be taken into
account.
Bit 1  Scaling
 0      1 mm/s
 1      0.1 mm/s

Bit 0 - Orientation: This bit indicates the orientation of the instrument.
Bit 0  Orientation
 0      Up
 1      Down

Note: For the Vector the instrument is defined to be in  the UP orientation when the communication
cable end of the canister is on the top of the canister, i.e. when the probe is pointing down.
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6.4 Returning Instruments for Repair

When you do need to send something back to us, it is important that it is done correctly to avoid delays
or extra costs. Here is a quick guide:

· Prior to returning any instruments to Nortek, you should get approval. Approval is given in the form of a
Return Material Authorization number (RMA-number), which identifies the system for customs and for
internal production control purposes. To get a RMA number, contact Nortek by e-mail. 

· You must complete a proforma invoice, include all the information requested and ensure that it is
correct. Make sure you include a copy of all shipping and export documents with the proforma invoice
inside the freight box. For an example, see Appendix B.

· All RMA products must be carefully and securely packed to protect against shipping damage. Return
products in their original shipping containers if at all possible.

· The return freight should be prepaid. 

· For customs purposes, we recommend that you clearly label the commercial invoice with expressions
such as "Return to the original manufacturer Nortek AS for warranty repair. Will be returned to sender".
 Using the term "warranty" simplifies customs handling and can be used even if the system is returned
after the warranty period has expired.   

· Note that freight insurance on repairs is not covered by Nortek. You must make sure your goods are
properly insured before shipping to Nortek AS. We will not be held responsible if the instrument is
damaged or lost while being shipped to Nortek for repair. Similarly, Nortek will not be held responsible
for consequential damages as a result of instruments becoming damaged or lost while being shipped
to Nortek for repair.

· Nortek will always insure instruments returned to a customer after service or repair. You will be
invoiced the cost of this insurance along with other charges relating to the repair and shipping costs.

· Clearly state where you want us to send the repaired system and what shipping method you prefer.
Nortek will pay for the return shipment if it is part of the a warranty repair. If it is not covered, we will
prepay the shipment and the transport insurance and then invoice you.

· Do not include any batteries when returning an instrument, unless specifically instructed to by Nortek.
Lithium and Lithium-Ion batteries especially are dangerous goods and are strictly prohibited to ship as
ordinary goods. If they are included you will not get them back because of rules regarding dangerous
goods shipment.

· We will confirm the receipt of the equipment and inform you of any chargeable cost associated with
repairs. Billing will be done at standard rates for repair and retest if the failure is due to warranty
violations or misuse.  

If it not done correctly, this process can quickly turn ugly. If done correctly, it is normally quite smooth.

mailto:support@nortekgroup.com
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6.5 Appendix A - Final Test Checklist
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6.6 Appendix B - Example of Proforma Invoice
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